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1
Benvenuti in SOLIDWORKS 2025

Questo capitolo comprende i seguenti argomenti:

• Principali miglioramenti
• Prestazione
• Per saperne di più...

SOLIDWORKS® 2025 contiene miglioramenti basati sugli utenti che aiutano a semplificare e
accelerare i processi di sviluppo dei prodotti dal concept alla produzione:

• Accelera il time-to-market con collaborazione e gestione dei dati migliorate
• Semplifica i flussi di lavoro di parti, assiemi, disegni, MBD, instradamento di componenti
elettrici e condotti, collaborazione ECAD-MCAD e rendering

• Lavora più velocemente con l'importazione/esportazione, l'esperienza utente e i miglioramenti
delle prestazioni

• Semplifica i flussi di lavoro di disegno con accuratezza e chiarezza grazie agli aggiornamenti
di DraftSight®

• Aumenta l'efficienza dei dati con gli aggiornamenti di SOLIDWORKS PDM
• Prestazioni e precisione garantite con gli aggiornamenti di SOLIDWORKS Simulation
• Semplifica la progettazione elettrica con gli aggiornamenti di SOLIDWORKS Electric Schematic
ed Electrical Schematic Designer
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• Continua a progettare ovunque con le ultime novità nello sviluppo di prodotti basati sul
browser su 3DEXPERIENCE® Platform

Il presente documento tratta tutti i miglioramenti che interessano le modalità di interazione
con 3DEXPERIENCE Platform. Ciò include entrambe le versioni di SOLIDWORKS collegate
alla piattaforma: SOLIDWORKS Connected e SOLIDWORKS con l'aggiunta 3DEXPERIENCE
(Design with SOLIDWORKS). Include anche altre app che possono connettersi alla piattaforma,
come DraftSight.

Principali miglioramenti
I principali miglioramenti per SOLIDWORKS® 2025 hanno potenziato i prodotti esistenti
e aggiunto funzionalità innovative.

Nozioni fondamentali • Specifica un modello Z-Su alla pagina 76

Parti e funzioni • Metodo Defeature silhouette per le parti alla pagina 101
• Ripetizione della geometria di riferimento alla pagina 102
• Riparazione delle relazioni svincolate alla pagina 95

Assiemi • Visualizzazione assieme alla pagina 135
• Istanze SpeedPak alla pagina 138
• Rilevamento delle interferenze in modalità Revisione

grandi progetti alla pagina 139

SOLIDWORKS MBD • Creazione di quote DimXpert da quote di schizzo alla pagina
249

Prestazione
SOLIDWORKS® 2025 migliora le prestazioni di strumenti e flussi di lavoro specifici.

Di seguito sono riportate alcune delle caratteristiche relative ai miglioramenti delle
prestazioni e del flusso di lavoro:

Funzioni
La qualità e le prestazioni delle funzioni di ripetizione sono state migliorate, in particolare
per la modifica e la ricostruzione. Esempi:

• Se la funzione testa di serie di una ripetizione è una ripetizione, la funzione testa di
serie non è evidenziata.

• Se la funzione testa di serie ha più di 100 facce, la funzione testa di serie non è
evidenziata.

• Per le ripetizioni appena create che utilizzano l'opzione Istanze da variare, le
prestazioni e la precisione sono migliorate.
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• La prestazione viene migliorata quando si modifica o si fa clic su OK per creare
ripetizioni con un numero elevato di istanze o facce.

Assiemi
Le prestazioni durante il calcolo delle proprietà di massa per un assieme vengono
migliorate.

SOLIDWORKS PDM
Le prestazioni di SOLIDWORKS PDM sono migliorate durante il check in del file nel database
di SOLIDWORKS PDM quando il trasferimento dei dati su Internet è lento. L'operazione
di check-in dei file è due volte più veloce rispetto a prima.

Lamiera
Quando si attiva l'opzione Filettature cosmetiche ombreggiate, è possibile migliorare
le prestazioni mentre si utilizzano parti multicorpo con numerose funzioni di filettatura
cosmetica.

Per le parti in lamiera con più funzioni di filettatura cosmetica, le prestazioni sono
migliorate per queste operazioni:

• Apertura delle parti
• Creazione di nuove funzioni
• Modifica funzioni
• Aggiornamento e ricostruzione delle parti

Le prestazioni sono migliorate quando si utilizzano disegni che contengono viste di disegno
di parti in lamiera con molti fori e strumenti di formatura. Quando si utilizzano tali disegni,
è possibile ottenere prestazioni migliori per:

• Apertura dei file di disegno
• Creazione di nuovi disegni dalla parte in lamiera
• Aggiornamento delle viste di disegno dopo aver apportato modifiche alla parte in
lamiera

Schizzo
Le prestazioni sono state migliorate durante lo zoom, la panoramica e la rotazione di
schizzi complessi, in particolare quando si tratta di schizzi di grandi dimensioni importati
da conversioni di file DWG o contenenti migliaia di spline.

Parti
Le prestazioni sono migliorate per le parti con bordi evidenziati quando si selezionano
funzioni o corpi.

Per saperne di più...
Utilizzare le risorse seguenti per approfondire SOLIDWORKS:
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Questa guida è disponibile in formato PDF e HTML. Fare clic su:Novità in formato PDF
e HTML

• > Novità > PDF

• > Novità > HTML

In SOLIDWORKS, appare accanto alle nuove voci di menu
e ai titoli dei PropertyManager nuovi o modificati in modo

Novità interattive

significativo. Fare clic su per visualizzare l'argomento della
presente guida con la descrizione del miglioramento.

Per attivare le Novità interattive, fare clic su > Novità >
Interattive.

Contiene una descrizione esaustiva dei nostri prodotti, compresi
i dettagli sull'interfaccia utente e fornisce numerosi esempi.

Guida in linea

Contiene i post della community di utenti SOLIDWORKS sulla
3DEXPERIENCE® Platform (è necessario effettuare il login).

Forum utenti
SOLIDWORKS

Fornisce informazioni sulle ultime modifiche dei prodotti,
compresi i cambiamenti del manuale Novità, della Guida in linea
e di altra documentazione.

Note di distribuzione

Le note legali di SOLIDWORKS sono disponibili online.Note legali
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2
Uso di SOLIDWORKS su 3DEXPERIENCE Platform

Questo capitolo comprende i seguenti argomenti:

• SP3_FD03
• SP2_FD02
• SP1_FD01
• SPO_GA

Questo capitolo tratta tutti i miglioramenti che influiscono sull'utilizzo di SOLIDWORKS® con
3DEXPERIENCE® Platform. Se non diversamente specificato, le voci di questo capitolo sono
disponibili sia in SOLIDWORKS Connected (ruoli 3DEXPERIENCE SOLIDWORKS) sia in
SOLIDWORKS con l'aggiunta 3DEXPERIENCE (Design with SOLIDWORKS) (ruolo Collaborative
Designer for SOLIDWORKS).

SP3_FD03

Lavoro offline quando la connessione non è disponibile (2025 FD03)

È possibile eseguire SOLIDWORKS Connected, insieme ad altre app 3DEXPERIENCE
Connected, anche se l'app non può connettersi a 3DEXPERIENCE platform.

Vantaggi: questo miglioramento garantisce un accesso ininterrotto, consentendo di
continuare a lavorare nell'app con i file locali in caso di problemi di connettività.

• Introduzione a R2025x_FD02: se l'app non riesce a connettersi a 3DEXPERIENCE
platform e si è eseguito SOLIDWORKS Connected negli ultimi 7 giorni, l'app richiede
di lavorare offline. Il prompt include una data di scadenza. È necessario eseguire una
sessione online prima di tale data, altrimenti l'applicazione non si avvierà più.

• Introduzione a R2025x_FD03: se si avvia la sessione come di consueto, ma si perde
la connessione durante l'uso, l'applicazione entra in modalità offline temporanea e
chiede di lavorare offline durante la disconnessione.

Durante l'esecuzione in modalità offline temporanea, SOLIDWORKS Connected continua
a verificare la presenza di una connessione in background. Quando la connessione viene
ripristinata, l'app chiede di riavviare per riconnettersi completamente.

SOLIDWORKS Visualize Connected, DraftSight Connected, 3DEXPERIENCE DraftSight
Professional ed Electrical Schematic Designer supportano anche la modalità offline
temporanea, che consente di continuare a lavorare con i file locali quando 3DEXPERIENCE
platform non è disponibile.
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Ripristino della pianificazione delle attività in SOLIDWORKS Connected (2025 FD03)

È possibile pianificare attività con file locali in SOLIDWORKS Connected. In precedenza,
le attività potevano essere eseguite soltanto subito dopo la loro creazione. Con questo
aggiornamento, SOLIDWORKS può eseguire attività pianificate in background, anche
quando si è lontani dal computer.

Vantaggi: questo aggiornamento ripristina la possibilità di programmare le attività per
un momento successivo o su base ricorrente. Inoltre, i campi Nome utente e Password
sono stati rimossi dall'attività Genera output derivato.

Per abilitare la pianificazione di attività:

1. Aprire Utilità di pianificazione SOLIDWORKS in SOLIDWORKS Connected facendo clic
su Strumenti > Applicazioni SOLIDWORKS > Utilità di pianificazione
SOLIDWORKS.

2. Fare clic su Accedi, quindi inserire in 3DEXPERIENCE platform il Nome utente e la
Password.

Le credenziali vengono salvate e utilizzate per autorizzare le attività pianificate.

3. Se le informazioni di accesso cambiano:

a. Fare clic su Esci.

Se l'utente ha già effettuato l'accesso, vengono visualizzate le sue iniziali.

b. Fare clic su Accedi di nuovo e inserire le credenziali aggiornate.

Il Task Scheduler di SOLIDWORKS ricorda le nuove credenziali per le attività
future.

Installazione dell'aggiunta 3DEXPERIENCE da SOLIDWORKSMarketplace (2025 FD03)

Se un utente di SOLIDWORKS non ha installato l'aggiunta 3DEXPERIENCE, può installarla
direttamente dalla scheda 3DEXPERIENCE Marketplace nel Task Pane di SOLIDWORKS.
È anche possibile installarla successivamente da 3DEXPERIENCE Marketplace.
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Vantaggi: è possibile installare l'aggiunta 3DEXPERIENCE direttamente all'interno di
SOLIDWORKS, con meno passaggi e risparmiando tempo.

Per accedere a questa funzionalità, è necessario caricare il 3DEXPERIENCE Marketplace
dalla finestra di dialogo Aggiunta SOLIDWORKS nel menu Strumenti.

Per installare l'aggiunta 3DEXPERIENCE:

1. Nel Task Pane di SOLIDWORKS, fare clic sulla scheda Risorse di SOLIDWORKS e su
3DEXPERIENCE Marketplace.

La scheda passa al 3DEXPERIENCE Marketplace e viene visualizzata la pagina
Benvenuti in 3DEXPERIENCE.

2. Fare clic su Aggiorna ora per avviare il programma di installazione, oppure fare clic
su Ignora per utilizzare Marketplace come di consueto.

Se si sceglie di aggiornare, assicurarsi di salvare e chiudere tutti i file SOLIDWORKS
aperti.

3. Fare clic su Installa ora e seguire le istruzioni per installare l'aggiunta 3DEXPERIENCE.
4. Al termine dell'installazione, riavviare SOLIDWORKS per applicare le modifiche.

Timbratura dei disegni con nomi utente o indirizzi e-mail (2025x FD03)

Gli utenti 3DEXPERIENCE possono timbrare i disegni utilizzando attributi estesi per i nomi
utente o gli indirizzi e-mail visualizzati in 3DPlay.

Vantaggi: È possibile utilizzare i trigrammi per un uso efficiente dello spazio. Disporre
di indirizzi e-mail rende utile contattare le parti interessate nel processo di rilascio dei
disegni.

Le annotazioni comprendono testo e simboli che aggiungono informazioni ai disegni.
Quando si apre un disegno SOLIDWORKS in 3DPlay e ha attributi PLM o estesi definiti,
è possibile visualizzare in anteprima tali proprietà come annotazioni. È possibile visualizzare
in 3DPlay i nomi utente o gli indirizzi e-mail degli utenti che hanno partecipato al processo
di rilascio del disegno.

Per timbrare i disegni con nomi utente o indirizzi e-mail:

1. In un disegno SOLIDWORKS, aggiungere annotazioni che facciano riferimento alle
seguenti proprietà PLM:

Utente che ha eseguito il processo di
rilascio.

ea_releasedby_name

Utente che ha creato il disegno.ea_createdby_name

Utente che ha eseguito la modifica della
maturità.

ea_changestatusby_mail

Indirizzo e-mail dell'utente che ha
eseguito il processo di rilascio.

ea_releasedby_mail
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Indirizzo e-mail dell'utente che ha creato
il disegno.

ea_createdby_mail

Indirizzo e-mail dell'utente che ha
eseguito la modifica della maturità.

ea_chansestatusby_mail

2. Salvare il disegno in 3DEXPERIENCE platform per registrare gli attributi.
3. In SOLIDWORKS, ricostruire il disegno per verificare che le annotazioni siano

visualizzate correttamente.
4. In MySession, utilizzare il comando Azione di modifica o Stato di modifica per

aggiornare lo stato del disegno, ad esempio In corso, Congelato, Rilasciato e
Obsoleto.

5. In 3DPlay o in qualsiasi visualizzatore Web supportato, aprire il disegno per vedere
le annotazioni aggiornate e verificare che le informazioni siano corrette.

Espansione dinamica dell'albero in MySession

MySession carica solo il primo livello di figli per impostazione predefinita, rendendo più
veloce e più facile la navigazione, soprattutto negli assiemi di grandi dimensioni. Mentre
si lavora, l'albero si espande dinamicamente, mostrando la struttura solo quando serve.
Ciò consente di mantenere SOLIDWORKS reattivo e di migliorare le prestazioni
complessive.

Vantaggi: il caricamento dinamico facilita la gestione di assiemi grandi e complessi senza
sovraccaricare il sistema.

La vista di primo livello influisce su assiemi, parti e disegni solo nei seguenti modi:

• Assiemi

È possibile espandere e chiudere i nodi a seconda delle necessità.

• Disegni e parti

MySession mostra solo la struttura di primo livello. Non è possibile espandere oltre il
primo livello.
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• Comportamento di aggiornamento

MySession ricorda quali nodi sono stati espansi, anche quando si passa da una finestra
all'altra o si aggiorna il contenuto.

• Miglioramenti delle prestazioni

I test dimostrano che i tempi di aggiornamento possono scendere da diversi secondi
a pochi millisecondi.

Per visualizzare un'ulteriore struttura dell'albero di MySession, è possibile:

• Fare clic sull'icona + accanto a un nodo.
• Fare clic con il pulsante destro del mouse su un nodo e selezionare Espandi tutto o

Chiudi tutto.
• Utilizzare le opzioni di Visualizzazione nella barra delle azioni:

• Espandi tutto
• Espandi in livelli
• Comprimi tutto

MySession mantiene i nodi espansi, anche se si cambia file.

Alcuni strumenti e funzioni si basano sulla visibilità dei nodi in MySession. Se un nodo
non è espanso, queste funzioni potrebbero non funzionare come previsto.

• Le Informazioni PLM vengono visualizzate solo per i nodi visibili.
• L'Evidenziazione incrociata dall'albero di disegno del FeatureManager funziona solo
se il nodo corrispondente è espanso in MySession.

• Gli avvisi Obsoleto e Non il più recente appaiono solo quando i nodi interessati
sono espansi.

• Le Operazioni del ciclo di vita, come le modifiche alla maturità o gli aggiornamenti
delle revisioni, potrebbero non apparire finché non si aggiorna MySession.

• Simulazione strutturale e Aggiorna revisione possono costringere a un'espansione
completa per verificare le condizioni.

• Esporta come pacchetto evidenzia solo i nodi visibili.
• Se si espande tutto, MySession rallenta. Per ripristinare le prestazioni, chiudere e
riaprire il file.
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Sincronizzazione delle librerie di componenti CircuitWorks tra SOLIDWORKS e
SOLIDWORKS Connected (2025 SP03)

È possibile sincronizzare le librerie di componenti CircuitWorks tra SOLIDWORKS Desktop
e SOLIDWORKS Connected per mantenere aggiornate le librerie.

Per copiare i componenti in entrambe le direzioni, procedere come segue:

1. Accedere a Strumenti > CircuitWorks > Libreria dei componenti. Nella Libreria
dei componenti di CircuitWorks, selezionare Strumenti.

2. Scegliere una delle seguenti opzioni:

• Selezionare Importa dati > Da desktop a 3DEXPERIENCE.

In questo modo si sincronizza l'intera libreria dei componenti del desktop con la
libreria dei componenti di 3DEXPERIENCE.

• Selezionare Esporta dati > Da 3DEXPERIENCE a desktop.

In questo modo si sincronizza l'intera libreria dei componenti 3DEXPERIENCE
con la libreria dei componenti del desktop.

3. Fare clic su Sì.
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SP2_FD02

Importazione di un file PDF come blocco da 3DEXPERIENCE platform (solo DraftSight
Connected) (2025 FD02)

È possibile utilizzare il comando IMPORTPDFFROM3DEXPERIENCE per importare un
file PDF come blocco da 3DEXPERIENCE platform.

Per importare un file PDF come blocco da 3DEXPERIENCE platform:

1. Scegliere una delle seguenti opzioni:

• Fare clic su Importa > Importa da 3DEXPERIENCE.
• Fare clic su File > Importa > Importa da 3DEXPERIENCE.
• Digitare IMPORTPDFFROM3DEXPERIENCE nella finestra del comando.

2. Nella finestra di dialogo Importa da 3DEXPERIENCE:

a. In Formato file, selezionare PDF (*.pdf).
b. Fare clic su Scegli file.

3. Nella finestra di dialogo Apri:

a. Selezionare un file PDF.
b. Fare clic su Apri.

Nella finestra di dialogo Importa da 3DEXPERIENCE, Nome file visualizza il file
selezionato.

4. Fare clic su Importa.
5. Nella finestra di dialogo Importazione PDF, fare clic su OK.
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Mappatura dell'innalzamento di livello alla proprietà Producibile/Reperibile (2025 FD02)

Quando si salva un assieme in 3DEXPERIENCE per la prima volta e si seleziona Innalza
di livello, 3DEXPERIENCE mappa la proprietà Producibile/Reperibile nel file
dell'assieme.

Vantaggi: La proprietà Producibile/Reperibile appare nelle proprietà del file
3DEXPERIENCE dell'assieme. È possibile filtrare gli articoli nell'app Engineering Release
sulla piattaforma in base al loro stato di producibilità e reperibilità.

Per innalzare di livello un assieme da SOLIDWORKS a 3DEXPERIENCE:

1. Aprire l'albero di disegno FeatureManager per l'assieme.
2. Selezionare ConfigurationManager.
3. Selezionare la configurazione e fare clic con il tasto destro del mouse su Prodotto

fisico > Modifica prodotto fisico > Innalza di livello.

Quando si innalza di livello un file di assieme in 3DEXPERIENCE, la proprietà
Producibile/Reperibile è impostata su Falso.

Analogamente, se si imposta la proprietà Mostra/Nascondi in SOLIDWORKS,
Producibile/Reperibile è impostato su Vero in 3DEXPERIENCE.

Questo aggiornamento si applica anche allo strumento Salva in batch in 3DEXPERIENCE.
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Sheet Set Manager su 3DEXPERIENCE platform (solo DraftSight Connected) (2025 FD02)

3DEXPERIENCE DraftSight consente di creare i file Sheet Set Data (DST) e di salvarli nei
segnalibri. È possibile aprire i file DST salvati dai segnalibri.

È inoltre possibile definire le proprietà di Sheet Set Manager. Consultare Utilizzo dei set
di fogli di disegno. È possibile creare file DST utilizzando un disegno esistente o un
modello di set di fogli di disegno. 3DEXPERIENCE DraftSight crea i file DST come oggetti
PLM.

Creazione di set di fogli di disegno utilizzando un disegno esistente

È possibile utilizzare la procedura guidata Crea set di fogli di disegno per creare set di
fogli di disegno da un disegno esistente.

Per creare set di fogli di disegno usando un disegno esistente:

1. Nella tavolozza Gestione set di fogli, fare clic su Nuovo set di fogli di disegno
.

2. Nella procedura guidata Crea set di fogli di disegno - Avvia, selezionare Disegni
esistenti e fare clic su Avanti.

3. Fare clic su Sfoglia per la Posizione del file di dati del set di fogli di disegno
(*.dst).

4. Nella finestra di dialogo Cerca cartella set di fogli di disegno, fare clic su Seleziona
da 3DEXPERIENCE.

5. Nella finestra di dialogo Seleziona un segnalibro:
a) Selezionare un segnalibro esistente o creare un segnalibro in cui salvare il file

DST.
b) Fare clic su Seleziona.

In alternativa, è possibile selezionare una cartella da Questo PC.
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6. Fare clic su Proprietà set fogli di disegno per selezionare un segnalibro per la
Vista del modello da 3DEXPERIENCE platform.
È possibile selezionare un segnalibro per il Blocco etichetta per le viste e i Blocchi
didascalia.

7. Nella procedura guidata Crea set di fogli di disegno - Dettagli di set di fogli di disegno,
fare clic su Avanti.

8. Nella procedura guidata Crea set di fogli di disegno - Scegli fogli, fare clic su Sfoglia.
a) Nella finestra di dialogo Sfoglia cartelle, selezionare una cartella dal computer o

un segnalibro che contenga disegni.
b) Fare clic su Specifica cartella.

9. Nella procedura guidata Crea set di fogli di disegno - Scegli fogli, fare clic su Avanti.
10. Nella procedura guidata Crea set di fogli di disegno - Finalizza, fare clic su Fine.

Creazione di set di fogli di disegno utilizzando un modello di set di fogli di disegno

È possibile utilizzare la procedura guidata Crea set di fogli di disegno per creare set di
fogli di disegno utilizzando un modello di set di fogli di disegno.

Per creare set di fogli di disegno utilizzando unmodello di set di fogli di disegno:

1. Nella tavolozza Gestione set di fogli, fare clic su Nuovo set di fogli di disegno
.

2. Nella procedura guidata Crea set di fogli di disegno - Avvia, selezionare Un modello
di set di fogli di disegno e fare clic su Avanti.

3. Nella procedura guidata Crea set di fogli di disegno - Modello di set di fogli di disegno:
a) Selezionare Cerca un altro foglio di disegno da utilizzare come modello.
b) Fare clic su Sfoglia.

4. Nella finestra di dialogo Cerca set di fogli di disegno, fare clic su Apri da
3DEXPERIENCE.

5. Nella finestra di dialogo Apri:
a) Selezionare un modello di set di fogli di disegno (.DST) da 3DSearch o da

Segnalibri.
b) Fare clic su Apri.
Nella procedura guidata Crea set di fogli di disegno - Modello di set di fogli di disegno,
appare il nome del modello di set di fogli di disegno (DST).

6. Nella procedura guidata Crea set di fogli di disegno - Modello di set di fogli di disegno,
fare clic su Avanti.

7. Nella procedura guidata Crea set di fogli di disegno - Dettagli di set di fogli di disegno,
fare clic su Avanti.

8. Nella procedura guidata Crea set di fogli di disegno - Finalizza, fare clic su Fine.

Apertura di set di fogli di disegno

Per aprire i set di fogli di disegno:

1. Nella tavolozza Gestione set di fogli, fare clic su Apri set fogli di disegno .
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2. Nella finestra di dialogo, effettuare una delle seguenti operazioni:

• Selezionare il set di fogli di disegno (DST) e fare clic su OK.
• Da Segnalibri o 3DSearch, fare clic su Apri da 3DEXPERIENCE, selezionare il
file di gestione del set di fogli e fare clic su Apri.

La tavolozza Gestione set di fogli visualizza i riferimenti del file DST.

Regole globali in Editor regole di integrazione 3DEXPERIENCE (2025 FD02)

In Editor regole di integrazione 3DEXPERIENCE, gli utenti 3DEXPERIENCE possono creare
regole globali che si applicano a tutte le parti e gli assiemi non divisi in sottotipi.

Vantaggi: È possibile creare facilmente una regola globale senza dover utilizzare soluzioni
alternative.

Per creare una regola globale:

1. Per aprire l'Editor, fare clic su Strumenti > Opzioni > Opzioni del sistema >
Integrazione 3DEXPERIENCE > Editor regole di integrazione 3DEXPERIENCE.

2. Nella finestra di dialogo, nella scheda Parti o Assiemi, in Regole di divisione in
sottotipi:

a. Selezionare Attiva una regola globale per tutti gli assiemi non divisi in
sottotipi.

La riga 0 (predefinita) è nascosta e viene visualizzata la riga 1. Gli strumenti

Modifica ed Elimina non sono disponibili perché non è possibile modificare
la definizione della regola di divisione in sottotipo di una regola globale.

La regola globale è sempre la riga 1.

b. Nella tabella, in ID, fare clic su 1.

La sezione inferiore della finestra di dialogo si espande per consentire all'utente
di specificare le regole di mappatura della configurazione per la regola globale.
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c. Specificare le regole di mappatura della configurazione per la regola globale e
fare clic su OK.

Il software memorizza la regola globale nel file .XML nella posizione specificata
nella finestra di dialogo Opzioni del sistema per la Cartella regole di
integrazione 3DEXPERIENCE.

Selezionando questa opzione e invocando il comando Aggiorna per la compatibilità
con 3DEXPERIENCE, il sistema applica tutte le regole di sottotipizzazione definite
dall'utente. Le parti o gli assiemi non inclusi nelle regole di divisione in sottotipi definite
utilizzano la logica di mappatura della configurazione definita nella regola globale. Se si
cancella la regola globale, tali parti o assiemi utilizzano la logica predefinita per la
mappatura della configurazione.

Avviso per il salvataggio di file associati a limitazioni di azione di modifica (2025 FD02)

Quando si tenta di salvare un file bloccato in SOLIDWORKS, viene visualizzato un avviso
se il file è bloccato da un'Azione di modifica attiva. L'avviso significa che non è possibile
salvare il file nella piattaforma finché non si risolve l'azione di modifica.

Vantaggi: questo aggiornamento garantisce la risoluzione di eventuali azioni di modifica
attive associate ai file prima di procedere.

Per continuare a lavorare:

1. Per procedere al salvataggio del file, è necessario attivare il Lavoro in corso di
modifica attraverso la relativa Azione di modifica:

a. In MySession, fare clic sull'Azione di modifica evidenziata, quindi fare
nuovamente clic su Azione di modifica.

b. Dall'elenco, selezionare l'Azione di modifica pertinente per attivare il Lavoro
in corso di modifica.

Se non si ha accesso all'Azione di modifica, questa potrebbe non comparire
nell'elenco. Per assistenza, consultare l'amministratore della piattaforma.

c. Fare clic su OK e salvare il file sulla piattaforma.
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2. In alternativa, è possibile aprire l'app Change Execution per esaminare lo stato di
un'Azione di modifica.

3. Richiedere l'approvazione o completare i passaggi richiesti prima di salvare.

Impostazione del titolo del disegno da prima vista del modello (2025 FD02)

Quando si salva un disegno, SOLIDWORKS può assegnare automaticamente il titolo del
disegno in base alla prima vista del modello di riferimento.

Vantaggi: questo aggiornamento consente di mantenere la coerenza tenendo il titolo
del disegno allineato al modello padre.

È possibile attivare questa funzionalità selezionando l'opzione Usa il titolo
della parte o dell'assieme come nuovo titolo del disegno in Strumenti >
Opzioni nella barra delle azioni.

Quando si attiva questa opzione, il titolo del disegno è determinato dalla prima vista
modello aggiunta al disegno. Questo comportamento può applicarsi:

• Quando il file viene salvato per la prima volta o a ogni salvataggio, a seconda della
configurazione.

Le regole per assegnare un titolo al disegno sono le seguenti:

• Se il modello di riferimento ha una configurazione, il titolo del disegno corrisponde al
nome del modello.

• Se il modello di riferimento ha più configurazioni, il titolo del disegno include il nome
del modello e la configurazione dalla prima vista. Ad esempio: Assembly1(Config1).

Se attivata, questa opzione si applica anche allo strumento Salva in batch in
3DEXPERIENCE, contribuendo a semplificare la denominazione durante le operazioni in
blocco.
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Metodo migliorato per l'apertura dei file 3DEXPERIENCE (2025 FD02)

SOLIDWORKS ha migliorato la modalità di apertura dei file 3DEXPERIENCE non
memorizzati nella cache locale.

Vantaggi: Questo metodo migliora le prestazioni recuperando prima i metadati della
configurazione selezionata sul client. Quindi, memorizza nella cache i metadati di
configurazione completi e scarica i file necessari, anche se non sono ancora stati caricati
nella sessione SOLIDWORKS.

Alcune azioni rimangono temporaneamente disabilitate fino a quando tutti i file non sono
completamente disponibili. Queste azioni comprendono l'apertura di altri file, il blocco e
lo sblocco, la sostituzione delle revisioni, la modifica delle proprietà, il salvataggio e
l'aggiornamento. È possibile continuare a utilizzare 3DSearch mentre si scaricano gli
altri file.

Nota:

• la commutazione delle configurazioni in un assieme è bloccata fino al download di
tutti i componenti.

• Se il processo di download viene interrotto, SOLIDWORKS chiede di ricaricare i file
o di riavviare per cancellare la cache.

Visualizzazione della prima revisione in una tabella di revisione di 3DEXPERIENCE
(2025 FD02)
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È possibile mantenere la prima revisione nella prima riga, indipendentemente dalla quantità
di righe visualizzate.

Vantaggi: È sempre possibile vedere la prima revisione, anche se vi sono diverse revisioni
nella tabella.

Per visualizzare la prima revisione in una tabella di revisione di 3DEXPERIENCE:

1. Fare clic su Strumenti > Opzioni > Proprietà del documento > Tabelle >
Revisione.

2. In Tipi, selezionare Tabella di revisione basata su 3DEXPERIENCE.
3. Selezionare Mostra sempre prima revisione e fare clic su OK.
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Notifiche per i segnalibri con restrizioni (2025 FD02)

Viene visualizzata una notifica quando si tenta di utilizzare segnalibri che richiedono
autorizzazioni di scrittura.

Vantaggi: Questo aggiornamento impedisce di accedere ai segnalibri che richiedono
l'accesso in scrittura.

Quando i segnalibri sono di sola lettura, opzioni come Seleziona, Applica, Applica a
tutto e Applica a selezione appaiono in grigio. Questo comportamento si applica alla
finestra di dialogo Seleziona un segnalibro, alla finestra di dialogo Salva in 3DEXPERIENCE,
allo strumento Salva in batch in 3DEXPERIENCE e alla selezione predefinita dei segnalibri
in Strumenti > Opzioni.

Alcune azioni richiedono l'accesso in scrittura mentre altre, come il download da un
segnalibro, richiedono solo l'accesso in lettura. I segnalibri negli stati Congelato,
Completato o Archiviato sono solitamente di sola lettura. Anche quando si esegue
un'azione che richiede solo l'accesso in lettura, la notifica appare comunque per informare
l'utente.
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Aggiunta di commenti alle iterazioni dei file (2025 FD02)

Quando si salva un file su 3DEXPERIENCE platform, è possibile aggiungere commenti a
ciascuna iterazione.

Vantaggi: Questo aggiornamento semplifica la ricerca di iterazioni specifiche.

Se per il file padre è disponibile un Commento revisione, il software compila
automaticamente il Commento iterazione con lo stesso testo. Se non è stato aggiunto
un Commento revisione, il Commento iterazione rimane vuoto in modo da poterne
aggiungere uno, se necessario.
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Verifica della selezione dell'oggetto (2025 FD02)

Quando si avvia SOLIDWORKS da 3DEXPERIENCE platform, un utente può selezionare
involontariamente un oggetto, facendo sì che SOLIDWORKS lo apra una volta che la
sessione è pronta. Dopo l'avvio di SOLIDWORKS, viene visualizzata una finestra di dialogo
che consente all'utente di continuare ad aprire l'oggetto selezionato o di interrompere il
processo.

Vantaggi: Questo aggiornamento consente di evitare aperture indesiderate all'avvio di
SOLIDWORKS.

È possibile scegliere:

• Apri: Procede al caricamento dell'oggetto selezionato in SOLIDWORKS.
• Ignora: Apre SOLIDWORKS senza caricare l'oggetto scelto.

Il comportamento non si applica quando si avvia SOLIDWORKS da un collegamento sul
desktop o da uno script.
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Modifiche all'interfaccia utente di Assistente preparazione file (2025 FD02)

Gli utenti 3DEXPERIENCE possono utilizzare Assistente preparazione file con interfaccia
utente semplificata.

Vantaggi: L'interfaccia utente semplificata consente di semplificare il flusso di lavoro.

Le modifiche all'interfaccia utente di Assistente preparazione file includono:

• Nella finestra di dialogo Aggiungi cartelle sostituisce Aggiungi cartella.
• File di log: e Backup: nella parte superiore della schermata, sostituisce Backup e

log, tra cui:

• Seleziona una cartella nella quale creare un backup
• Seleziona una cartella nella quale creare i file di log

• Non esistono Opzioni.
• Nella parte inferiore della schermata non è presente Avvio.
• Modifica include:

• Trova file duplicati e richiedi unione

• Cerca corrispondenza con il nome file
• Cerca corrispondenza con il nome file e i nomi di configurazione
• Corrispondenza con il nome file e la data/ora di creazione dell'ora

• Sostituisci gli spazi iniziali/decimali nei nomi file con "_"

• Includi file non-SOLIDWORKS

• Identifica include:

• Compatibilità 3DEXPERIENCE
• Riferimenti 3DInterconnect
• Riferimenti file mancanti
• Proprietà personalizzata non corrispondente
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Viene visualizzata un'icona X nera per indicare
che è possibile rimuovere la cartella.

Elimina cartella

Quando si passa con il mouse sull'icona X nera,
questa diventa rossa.

Elimina cartella al
passaggio del mouse

Assistente preparazione file comprende un'opzione per includere file non-SOLIDWORKS.

Per includere file non-SOLIDWORKS:

1. In SOLIDWORKS, fare clic su Strumenti > Assistente preparazione file.
2. Nella finestra di dialogo, fare clic su Aggiungi cartelle.
3. Dalla finestra Naviga alla cartella, selezionare la cartella e fare clic su OK.
4. Fare clic su File di log: e scegliere una posizione in cui il software scarica il file di

log.
5. Fare clic su Backup: e scegliere una posizione in cui il software scarica il file di backup.
6. In Modifica, selezionare due opzioni:

a. Sostituisci gli spazi iniziali/decimali nei nomi file con "_".
b. Includi file Non-SOLIDWORKS

7. Assistente preparazione file esegue automaticamente alcuni controlli aggiuntivi.

Salvataggio di prodotti fisici e configurazioni (2025 FD02)

Quando si aggiorna un file per la compatibilità con 3DEXPERIENCE, il comando Salva
prodotti fisici nel menu di scelta rapida consente di salvare direttamente i prodotti fisici.
Nel ConfigurationManager, quando si fa clic con il pulsante destro del mouse su una
configurazione e si fa clic su Salva configurazioni, nella finestra di dialogo Salva con
nome, è possibile fare clic su Salva in 3DEXPERIENCE per salvare il file sulla piattaforma.
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Vantaggi: Questa funzionalità migliora le prestazioni consentendo di salvare i prodotti
fisici direttamente da ConfigurationManager. In precedenza, questa opzione non era
disponibile.

Il comando Salva prodotti fisici è disponibile solo per i prodotti fisici. Se un prodotto
fisico contiene rappresentazioni, quando si salva il prodotto fisico, il software salva le
rappresentazioni sotto il prodotto fisico.

Supporto migliorato per i riferimenti ai componenti intelligenti (2025 FD02)

Quando si salva un componente intelligente su 3DEXPERIENCE platform, i riferimenti ad
altri componenti rimangono intatti.

Vantaggi: Questo miglioramento contribuisce a preservare le relazioni tra i componenti,
facilitando la gestione degli assiemi senza perdere le connessioni.

Ad esempio, nella finestra di dialogo Salva in 3DEXPERIENCE, fare clic con il pulsante
destro del mouse su un sottocomponente e selezionare Riferimenti esterni per
visualizzare i componenti associati.
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Sincronizzazione del titolo di singoli prodotti fisici (2025 FD02)

In un unico file di prodotto fisico senza famiglia CAD, gli utenti 3DEXPERIENCE possono
sincronizzare il titolo di SOLIDWORKS con il titolo fisico del prodotto.

Vantaggi: Questo approccio consente di evitare problemi di sincronizzazione del titolo
per singoli prodotti fisici senza famiglia CAD.

Per sincronizzare un singolo prodotto fisico:

1. Aprire una parte o un assieme che sia un singolo file di prodotto fisico. Non deve
avere una famiglia CAD nella scheda Configurazioni.

2. Fare clic su Strumenti > Opzioni > Proprietà del documento > Integrazione
3DEXPERIENCE.

3. Nella finestra di dialogo, selezionare Usa il titolo del prodotto fisico per singoli
prodotti fisici senza famiglia CAD, quindi fare clic su OK.

In modalità offline, il software utilizza gli ultimi valori noti per il titolo fisico del
prodotto.

La finestra di dialogo Rinomina titolo rimane invariata per i modelli che non sono singoli
prodotti fisici. Se si modifica un modello di prodotto fisico singolo in un modello di prodotto
fisico multiplo, ad esempio aggiungendo una famiglia CAD, il titolo torna al nome definito.
Inoltre, le modifiche successive utilizzano lo stile esistente della finestra di dialogo Rinomina
titolo.
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Gestione delle notifiche della piattaforma nel Task Pane di SOLIDWORKS (2025 SP2)

È possibile visualizzare e interagire con le notifiche delle app della piattaforma direttamente
dalla scheda 3DEXPERIENCE del Task Pane.

Vantaggi: Questa funzione consente all'utente di gestire le notifiche senza passare alla
piattaforma, mantenendo le attività e gli aggiornamenti accessibili all'interno di
SOLIDWORKS.

È possibile aprire le notifiche per app come 3DDrive, 3DSwym e PartSupply. Facendo clic
su una notifica vengono visualizzati i dettagli all'interno della stessa interfaccia. Le app
supportate includono anche:

• 3DSearch
• Collaborative Tasks
• Collaborative Lifecycle
• Bookmark Editor

Per visualizzare le notifiche, fare clic sulla scheda 3DEXPERIENCE nel Task Pane. Quindi,
in MySession, fare clic con il tasto destro del mouse sul Menu principale nella barra

superiore e fare clic su Notifiche .

Se non vengono visualizzate le notifiche per un'app, controllare le impostazioni di
abbonamento nel 3DNotification Center. Queste impostazioni sono disponibili in
Impostazioni Notifiche > Preferenze.
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Scheda Classificazioni in MySession (2025 SP2)

In MySession è possibile utilizzare la scheda Classificazioni per cercare e gestire le
classificazioni fisiche dei prodotti.

Vantaggi: Questa funzione integra i dati provenienti dalle app di classificazione di
3DEXPERIENCE, come IP Classify and Reuse.

Per accedere alla scheda Classificazioni:

1. Selezionare un componente dalla struttura ad albero in MySession.
2. Nella barra delle azioni, fare clic su Vista > Pannello di visualizzazione.
3. Nella scheda espansa, fare clic su Classificazioni.

È possibile ricercare segnalibri e librerie di classi generali e classi di sicurezza in cui il
componente è classificato.

È inoltre possibile accedere alle classificazioni da 3DSearch. Quando si ricerca un
componente, fare clic su Classificazioni per aprire la scheda espansa.
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Gestione di componenti deformabili (2025 SP2)

In MySession, è possibile utilizzare il comando Comportamentomeccanico del prodotto

per definire il comportamento di un componente in un assieme. È possibile classificarlo
come rigido, deformabile o deformato mantenendo un singolo numero di parte.

Vantaggi: Questo approccio offre agli utenti SOLIDWORKS un modo semplice per gestire
i componenti flessibili senza abbandonare il flusso di lavoro.

Nella progettazione reale, alcuni componenti come tubazioni idrauliche o molle iniziano
con una forma fissa ma si deformano quando vengono inseriti in un assieme. Gli ingegneri
hanno bisogno di un modo per tenere traccia di queste modifiche senza passare da
un'applicazione all'altra.

Per definire un componente come deformabile:

1. Aprire un assieme salvato in 3DEXPERIENCE platform.
2. In MySession, selezionare un componente nell'albero.
3. Nella barra delle azioni, fare clic su Strumenti > Comportamento meccanico del

prodotto .
4. Nella finestra di dialogo selezionare un'opzione:

Il componente non cambia forma.Rigido

Il componente può assumere forme
diverse in un assieme.

Deformabile

Una versione modificata del componente
con una forma fissa.

Deformato

Quando un componente è contrassegnato come deformabile o deformato, rimane collegato
al numero di parte originale nella distinta materiali.
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Elenco file recenti (2025 SP2)

Nelle finestre di dialogo Benvenuto e Apri, la scheda Recente visualizza solo i file del
tenant corrente.

Vantaggi: Ciò fornisce una visualizzazione più chiara ed evita la possibilità di salvare un
file in un altro tenant.

È possibile aprire un file recente anche dopo averlo cancellato dalla cache.

Questa funzionalità non è disponibile in modalità offline.

Pulizia della cache locale nella scheda File 3DEXPERIENCE su questo PC (2025 SP2)

È possibile rimuovere i file inutilizzati dalla cache locale nella scheda File 3DEXPERIENCE

su questo PC utilizzando lo strumento Pulizia .

Vantaggi: Questo strumento consente di liberare spazio su disco sul computer locale e
semplifica l'organizzazione dei file senza influire sui file memorizzati su 3DEXPERIENCE
platform.

Per usare lo strumento Pulizia:

1. Nel Task pane, fare clic sulla scheda File 3DEXPERIENCE su questo PC. Quindi, fare

clic su Pulizia nella barra degli strumenti.
2. Nella finestra di dialogo, selezionare un periodo di tempo per eliminare i file in base

alla data dell'Ultimo aggiornamento sulla piattaforma.

È inoltre possibile rimuovere i file manualmente utilizzando il comando Elimina da questo
PC:

1. Fare clic con il pulsante destro del mouse sui file e selezionare Elimina da questo
PC nella scheda File 3DEXPERIENCE su questo PC.
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2. Se i file contengono un assieme o parti multicorpo, selezionare una delle seguenti
opzioni:

• Elimina solo i file selezionati. Rimuove i file selezionati ma mantiene intatti i
file referenziati.

• Elimina i file selezionati e i relativi riferimenti. Rimuove i file selezionati e i
relativi riferimenti.

L'eliminazione dei file li rimuove dalla cache locale ma rimangono disponibili in
3DEXPERIENCE platform. La scheda File 3DEXPERIENCE su questo PC si aggiorna
automaticamente.

I file non possono essere eliminati se:

• Un assieme contiene riferimenti che non soddisfano le condizioni di eliminazione.
• I file hanno modifiche locali.
• I file sono aperti nella sessione corrente.
• I file sono bloccati dall'utente.

Se nessun file soddisfa i criteri di eliminazione, viene visualizzato un messaggio di
avviso.

Aggiornamento automatico delle posizioni dei file nei segnalibri (2025 FD02)

SOLIDWORKS aggiorna automaticamente le posizioni dei file nei segnalibri per garantire
che il contenuto locale corrisponda alle informazioni più recenti contenute nei segnalibri
di 3DEXPERIENCE platform.

Quando si avvia SOLIDWORKS o si passa dalla modalità offline a quella online,
SOLIDWORKS verifica le modifiche ai segnalibri mappati una volta per sessione. Se il
controllo trova segnalibri modificati, SOLIDWORKS aggiorna la copia locale del contenuto.
L'aggiornamento viene eseguito in background, consentendo di continuare a lavorare in
SOLIDWORKS.

L'app visualizza lo stato aggiornato e la marca temporale dei file selezionati.

Vantaggi: Il flusso di lavoro si semplifica perché le posizioni dei file inseriti nei segnalibri
si aggiornano automaticamente in background, consentendo di continuare a lavorare in
SOLIDWORKS.
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SP1_FD01

Inserimento dei valori delle proprietà personalizzate alla creazione del file (2025 FD01)

Quando si crea una parte, un assieme o un disegno, l'interfaccia offre un modo più semplice
per inserire le proprietà personalizzate per i file.

Vantaggi: Ciò consente di ottimizzare il flusso di lavoro, compilando le proprietà
personalizzate durante la creazione del file.

Per immettere i valori delle proprietà personalizzate nella creazione del file:

1. Fare clic su Nuovo (barra degli strumenti Standard) o File > Nuovo.
2. Nella finestra di dialogo Nuovo documento SOLIDWORKS fare clic su Avanzate.

In Strumenti > Opzioni > Opzioni di sistema >Modelli predefiniti, è possibile
modificare i Modelli predefiniti nel modello 3DEXPERIENCE in modo che questo
flusso di lavoro si applichi anche alla versione Principiante della finestra di dialogo.

3. Nella scheda 3DEXPERIENCE, in Crea nuovo su 3DEXPERIENCE platform,
selezionare Parte, Assieme o Disegno.

4. Fare clic su OK.
5. Nella finestra di dialogo Nuova parte/Nuovo assieme/Nuovo disegno, nelle schede

Proprietà e Classificazioni , specificare le proprietà personalizzate per il file.
6. Fare clic su Crea.

Viene creato un prodotto fisico vuoto su 3DEXPERIENCE platform.
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Salvataggio di componenti transitori nella piattaforma (2025 FD01)

Quando si aprono file non SOLIDWORKS, è possibile caricare file SLDPRT transitori sulla
piattaforma come output derivati (DO).

Vantaggi: Questo aggiornamento semplifica il modo in cui si lavora con dati non
SOLIDWORKS e migliora le prestazioni durante i flussi di lavoro di apertura dei file. Questo
miglioramento si applica a vari formati MCAD, tra cui CATIA V5, NX, CREO, INVENTOR e
SOLIDEDGE.

Un file SLDPRT transitorio è un file temporaneo generato da SOLIDWORKS quando si
importano dati CAD non nativi. Invece di reimportare il file originale ogni volta,
SOLIDWORKS salva il file SLDPRT transitorio sulla piattaforma. Per le aperture successive,
SOLIDWORKS scarica e utilizza direttamente il DO SLDPRT salvato, eliminando la necessità
di reimportare il file.

Quando si apre un file non SOLIDWORKS per la prima volta, SOLIDWORKS importa i dati
e carica il file SLDPRT transitorio come DO in background. Questo caricamento consente
ad altri utenti o sessioni di riutilizzare il file senza reimportarlo. Per le aperture successive,
SOLIDWORKS recupera il DO SLDPRT dalla piattaforma, semplificando il processo e
risparmiando tempo.

Se si utilizzano versioni diverse di SOLIDWORKS sulla stessa piattaforma, le versioni
precedenti non possono riutilizzare i DO creati dalle versioni più recenti. In questi casi
viene visualizzato un messaggio di errore.

Sebbene sia possibile modificare il file SLDPRT transitorio, queste modifiche non
aggiorneranno il file originale non SOLIDWORKS. Il processo di accesso ai file correnti
dalla cache locale rimane invariato.
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Controllo delle modifiche della maturità con attributi valutati nei disegni SOLIDWORKS
(2025 FD01)

Gli attributi valutati tracciano e visualizzano automaticamente le modifiche della maturità
per i disegni SOLIDWORKS salvati su 3DEXPERIENCE platform.

Vantaggi: Gli attributi valutati semplificano il monitoraggio delle modifiche della maturità
e la cronologia di un disegno senza aggiornamenti manuali.

Un tipico caso d'uso inizia con la creazione di un modello di percorso con attività di
approvazione per un progettista e un produttore. Ogni attività viene approvata utilizzando
il comando Azione di modifica di MySession, aggiornando la maturità del disegno. Dopo
aver approvato tutte le attività, lo stato del disegno diventa Rilasciato.

Il flusso di lavoro per questa funzione è il seguente:

1. Aprire un file di disegno in SOLIDWORKS.
2. Aggiungere annotazioni che fanno riferimento alle seguenti proprietà PLM:

• ea_changestatusaction: azione di modifica utilizzata per innalzare di livello il
disegno.

• ea_changestatusdate: data delle modifiche della maturità.
• ea_changestatusby[i]: utente che ha eseguito la modifica della maturità.
• ea_changestatustask[i]: attività utilizzata per eseguire la modifica della
maturità.

3. Salvare il disegno in 3DEXPERIENCE platform in modo da registrare gli attributi.
4. Ricostruire il disegno in SOLIDWORKS per assicurarsi che le annotazioni siano

visualizzate correttamente.
5. In MySession, utilizzare il comando Azione di modifica o Stato di modifica per

aggiornare lo stato del disegno, ad esempio In corso, Congelato, Rilasciato e
Obsoleto.

6. Aprire il disegno in 3DPlay o in qualsiasi visualizzatore Web supportato per visualizzare
le annotazioni aggiornate e verificare che le informazioni siano accurate.

L'uso di attributi valutati presenta le seguenti limitazioni:
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• Funziona solo per annotazioni autonome e non supporta le proprietà nelle tabelle o in
combinazione con altre.

• A causa dell'indicizzazione, gli attributi regolari possono mostrare ritardi, ma gli attributi
ea_ si aggiornano istantaneamente.

• Gli attributi vuoti, come i campi di attività o data, vengono visualizzati come "-" in
SOLIDWORKS.

• Supporta solo i formati UDL e PDF, non DXF/DWG.
• Le attività per le transizioni di maturità vengono valutate solo dopo che il disegno è
stato rilasciato o contrassegnato come obsoleto.

Apertura di disegni in modalità Dettagli (2025 FD01)

È possibile aprire e salvare i disegni da 3DEXPERIENCE platform in modalità Dettagli
senza caricare i riferimenti.

Vantaggi: La modalità Dettagli migliora le prestazioni di apertura e modifica di disegni
di assiemi di grandi dimensioni.

Esistono due modi per aprire i disegni in modalità Dettagli.

Per aprire i disegni in modalità Dettagli usando Apri da 3DEXPERIENCE:

1. Fare clic su File > Apri > Apri da 3DEXPERIENCE > 3DSearch.
2. Nella finestra di dialogo, selezionare un disegno.

3. In Modalità, selezionare Dettagli .
4. Fare clic su Apri.

Per aprire i disegni in modalità Dettagli utilizzando MySession:

1. In MySession, fare clic su Strumenti > Opzioni > Apri.
2. Nella finestra di dialogo, selezionare Scegli la modalità prima di aprire i file e fare

clic su OK.
3. In 3DSearch, cercare un disegno.
4. Fare clic con il pulsante destro del mouse sul disegno e fare clic su Apri.

5. In Modalità, selezionare Dettagli .
6. Fare clic su Apri.

Salvataggio di disegni in modalità Dettagli (2025 FD01)

È possibile salvare i disegni in 3DEXPERIENCE platform in modalità Dettagli.

Per salvare i disegni in modalità Dettagli:

1. Fare clic su File > Salva in 3DEXPERIENCE.
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Caricamento in batch di file non SOLIDWORKS su 3DEXPERIENCE platform (2025 FD01)

È possibile utilizzare l'opzione Salva in batch in 3DEXPERIENCE per caricare file non
SOLIDWORKS, come .xml, .xls, .db e altri, direttamente in un segnalibro selezionato
su 3DEXPERIENCE platform.

Questa opzione organizza i diversi tipi di file in una struttura di cartelle, semplificando il
processo di caricamento, soprattutto per le librerie di routing più estese. Il componente
aggiuntivo Salva in batch mantiene aggiornati i file non SOLIDWORKS, come
RoutingLib.db e Components.xml.

Per caricare i file usando l'opzione Salva in batch in 3DEXPERIENCE in Routing
Library Manager:

1. In SOLIDWORKS, fare clic su Strumenti > Componenti aggiuntivi per attivare il
componente aggiuntivo Routing.

2. Aprire Routing Library Manager dal menu Start di Windows facendo clic su
Strumenti SOLIDWORKS > SOLIDWORKS Routing Library Manager.

3. Passare alla scheda Posizioni dei file di routing e Impostazioni e fare clic su Salva in
batch in 3DEXPERIENCE.

Si apre la finestra di dialogo delle opzioni Salva in batch in 3DEXPERIENCE. L'opzione
Includi file non SOLIDWORKS è selezionata per impostazione predefinita.

4. Selezionare ulteriori opzioni nella finestra di dialogo.
5. Fare clic su Aggiungi cartella per selezionare la cartella contenente i file. Tutti i file,

compresi quelli non SOLIDWORKS come .xml, .xls e .db, sono inclusi per il
caricamento.

6. Scegliere il Segnalibro per il caricamento.
7. Fare clic su OK.

Limitazioni:

• L'opzione Salva in batch carica i file non SOLIDWORKS come documenti separati, non
collegati ai file SOLIDWORKS.

• Non rileva le modifiche dei file e funziona solo per i primi caricamenti.
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Modalità di apertura migliorata per i file salvati su 3DEXPERIENCE platform (2025 FD01)

Gli aggiornamenti delle modalità di apertura dei file quando si lavora con file salvati su
3DEXPERIENCE platform offrono maggiore controllo e coerenza.

Vantaggi: Questi aggiornamenti consentono un maggiore controllo sulle modalità di
apertura dei file 3DEXPERIENCE in SOLIDWORKS.

Gli aggiornamenti della scheda File 3DEXPERIENCE su questo PC includono:

• Scorciatoia Alt + trascinamento: premere Alt mentre si trascina un file dalla scheda
per visualizzare la finestra di dialogo Modalità apertura.

• Modalità Revisione grandi progetti bloccata: i file scaricati in modalità Revisione
grandi progetti si aprono sempre in tale modalità.

• Comportamento coerente del clic destro e del trascinamento: facendo clic con
il pulsante destro del mouse o trascinando i file si seguono le impostazioni della finestra
di dialogo Modalità apertura.

• Selezione di più file: la modalità di apertura dà priorità alle opzioni in base ai tipi di
file, come gli assiemi rispetto alle parti o ai disegni, quando si selezionano più file.

• Suggerimento per la modalità di apertura: quando si trascinano i file dalla scheda,
viene visualizzato un suggerimento con la dicitura Tieni premuto Alt per aprire la
finestra di dialogo.

Un altro miglioramento dei risultati della ricerca 3DEXPERIENCE include:

• Scorciatoia Alt + trascinamento: facendo clic su Altmentre si trascinano i file, viene
visualizzata la finestra di dialogo Modalità apertura prima di aprire il file.
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Miglioramenti allo stato e all'aggiornamento dei file 3DEXPERIENCE nella scheda Questo
PC (2025 FD01)

La scheda File 3DEXPERIENCE su questo PC si aggiorna automaticamente per mostrare
i dati più recenti.

Vantaggi: Non è più necessario aggiornare manualmente la scheda, rendendo più semplice
rimanere aggiornati.

Un indicatore di stato arancione su Aggiorna aiuta a monitorare i file. Rimane chiaro
quando la visualizzazione è in corso, ma diventa arancione quando si salvano nuovi file,
si scaricano file o i file non sono presenti in locale. Questo segnale visivo evidenzia quando
la scheda richiede attenzione.

È anche possibile filtrare gli assiemi di primo livello per mostrare solo i nodi principali
degli assiemi nella cache. Questa opzione semplifica la navigazione e facilita il monitoraggio
delle modifiche, se combinata con l'indicatore di stato.

I suggerimenti aggiornati forniscono descrizioni chiare delle opzioni di aggiornamento:

• Aggiorna vista: Aggiorna l'intera vista.
• Aggiorna tutto dal server: Aggiorna le informazioni sul ciclo di vita di tutti i file dal
server.

• Aggiorna selezionati dal server: Aggiorna le informazioni sul ciclo di vita solo per
i file selezionati.
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Generare disegni automaticamente (2025 SP1)

Gli utenti 3DEXPERIENCE possono generare automaticamente disegni di parti e assiemi.

Vantaggi: La generazione automatica dei disegni riduce gli errori e il tempo dedicato
alle attività ripetitive.

Generazione automatica dei disegni

Gli utenti 3DEXPERIENCE possono generare automaticamente disegni di parti e assiemi.

Per generare automaticamente i disegni

:

1. Scegliere una delle seguenti opzioni:

• Fare clic su File > Genera disegni automaticamente.
• Nell'albero di disegno FeatureManager o nell'area grafica, fare clic con il pulsante
destro del mouse su una parte, un sottoassieme o un assieme e fare clic su Genera
disegni automaticamente.

2. Nel PropertyManager, specificare le opzioni e fare clic su .

Scheda Attività (Genera disegni automaticamente)

La scheda Attività (Generazione automatica di disegni) elenca i disegni generati e il loro
avanzamento.

Lo strumento Generazione automatica di disegni è disponibile solo per gli utenti
3DEXPERIENCE.

Per aprire questa scheda:

In una parte o in un assieme, fare clic su Attività (Generazione automatica di disegni)
dal Task Pane.
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Visualizza il nome del disegno generato.Titolo

Visualizza lo stato della generazione del disegno.

• Completato

• Non riuscito

Stato

• Annulla. (Disponibile durante la creazione del
disegno). Annulla la generazione automatica del
disegno dell'elemento selezionato.

• Apri. (Disponibile dopo il completamento del disegno).
Apre il disegno selezionato in modalità dettagliata.

• Visualizza dettagli. (Disponibile se la creazione del
disegno non riesce). Apre un rapporto che mostra il
motivo del fallimento del disegno generato
automaticamente.

• Avanti nella coda. Sposta l'attività al posto
successivo nella coda. SOLIDWORKS non annulla
l'attività in corso. Se si fa clic su Avanti nella coda
su un'altra attività, SOLIDWORKS sposta l'attività alla
successiva nella coda.

• Fare clic con il pulsante destro del mouse su una riga
qualsiasi della scheda Attività per le seguenti opzioni:

• Cancella. Cancella la riga selezionata dall'elenco.
• Cancella tutto. Cancella tutte le righe dalla scheda
Attività, a eccezione delle righe in corso. Sono
incluse le righe in cui lo stato è Completato o Non
riuscito.

Azioni

Comportamento di MySession in modalità Revisione grandi progetti (2025 FD01)

Quando si aprono i dati in modalità Revisione grandi progetti (LDR), MySession mostra
solo un nodo per il file di assieme aperto. Questo nodo include le stesse informazioni di
quando il file viene caricato in modalità Risolto.

Se il file non è ancora stato salvato sulla piattaforma, vengono visualizzate solo le
informazioni di SOLIDWORKS. Se il file è già salvato nella piattaforma, vengono visualizzate
le informazioni di SOLIDWORKS e PLM. In modalità LDR, i nodi figli non sono visualizzati
per l'assieme radice.

I seguenti comandi MySession non sono disponibili per questo nodo. Se si tenta di
utilizzarli, viene visualizzato un messaggio di errore:

• Salva come nuovo
• Salva finestra attiva come nuova finestra
• Ricarica dal server
• Sostituisci con revisione
• Sostituisci con ultima revisione

50

Uso di SOLIDWORKS su 3DEXPERIENCE Platform



• Aggiorna revisioni

Salvataggio di file selezionati in MySession (2025 FD01)

In MySession è possibile salvare singole parti, assiemi o disegni in 3DEXPERIENCE platform
senza salvare l'intero modello.

Vantaggi: Questo comando consente di salvare solo i componenti necessari e di controllare
ciò che viene caricato sulla piattaforma.

Per utilizzare Salva selezione:

1. Aprire un assieme in SOLIDWORKS.
2. In MySession, fare clic con il pulsante destro del mouse sul componente e selezionare

Salva selezione.
3. Nella finestra di dialogo Salva, assicurarsi che il componente sia selezionato.
4. Fare clic su Salva.

Limitazioni:

• Salvataggio delle modifiche nelle parti: Le modifiche apportate alle singole parti a
livello di assieme non vengono salvate a meno che non si includano esplicitamente tali
parti.

• Assiemi di primo livello: Usare Salva con opzioni quando si salva un nuovo assieme
di primo livello per gestire correttamente le proprietà grafiche e gli assiemi flessibili.
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Condivisione di file utilizzando Esporta come pacchetto (2025 FD01)

Gli utenti 3DEXPERIENCE possono usare l'opzione Esporta come pacchetto nella finestra
di dialogo Condividi per condividere gli assiemi salvati su 3DEXPERIENCE platform. È
possibile condividere il pacchetto con team esterni che possono modificare i file in
SOLIDWORKS. È quindi possibile unire nuovamente i file restituiti alla piattaforma.

Vantaggi: L'opzione Esporta come pacchetto raccoglie tutti i file di riferimento che
l'opzione Pack and Go potrebbe non includere, ad esempio i disegni non presenti nella
cache.

Per utilizzare l'opzione Esporta come pacchetto:

1. In SOLIDWORKS, aprire un assieme salvato su 3DEXPERIENCE platform.
2. Fare clic su File > Condividi.
3. Nella finestra di dialogo:

a. Fare clic su Condividi file.
b. Inserire un Nome file e in Tipo di fileselezionare Assieme SOLIDWORKS.
c. Fare clic su Esporta come Pacchetto.
d. Fare clic su Continua.

Il comando Esporta come pacchetto si apre nella scheda 3DEXPERIENCE del Task
Pane.

Per ulteriori informazioni su questo comando, vedere Esportazione e importazione
dei dati SOLIDWORKS.

4. Specificare le opzioni e fare clic su Esporta.

Il software esporta il pacchetto con l'estensione .sldpkg.
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Gestione dei problemi dei segnalibri durante il salvataggio dei dati (2025 FD01)

È possibile salvare i dati in 3DEXPERIENCE platform anche se i segnalibri sono congelati,
completati, archiviati o eliminati. Se un segnalibro assegnato non riesce, un messaggio
indica che i dati non sono contrassegnati da un segnalibro.

Vantaggi: Le operazioni di salvataggio vengono eseguite anche quando i segnalibri sono
congelati, completati, archiviati o eliminati.

Dopo il salvataggio, è possibile utilizzare Bookmark Editor per risolvere manualmente i
problemi e assegnare i segnalibri.

Scheda Ciclo di vita e collaborazione (2025 FD01)

53

Uso di SOLIDWORKS su 3DEXPERIENCE Platform



È possibile utilizzare gli strumenti Apri Collaborative Task e Maturità nella scheda
Ciclo di vita e collaborazione.

Lo strumento Apri Collaborative Task apre Collaborative Tasks nel Task Pane di
SOLIDWORKS. Lo strumento Maturità modifica lo stato di maturità del file selezionato.

Per accedere allo strumento Apri Collaborative Task:

1. Scegliere una delle seguenti opzioni:

• Nel CommandManager, fare clic su Apri Collaborative Task .
• Nella barra degli strumenti Ciclo di vita e collaborazione, fare clic su Apri Collaborative

Task .

Per accedere allo strumento Maturità:

1. Scegliere una delle seguenti opzioni:

• Nel CommandManager, fare clic su Maturità .

• Nella barra degli strumenti Ciclo di vita e collaborazione, fare clic su Maturità .
• Fare clic su Strumenti > Ciclo di vita e collaborazione > Maturità.

Modifica dello stato di maturità

È possibile utilizzare lo strumento Maturità per modificare lo stato di maturità del file
selezionato.

Per modificare lo stato di maturità:

Nell'albero di disegno FeatureManager, selezionare un file ed effettuare una delle seguenti
operazioni:

• Nel CommandManager, fare clic su Maturità .
• Nella barra degli strumenti Ciclo di vita e collaborazione, fare clic su Maturità.

• Fare clic su Strumenti > Ciclo di vita e collaborazione > Maturità .

Gli stati di maturità dei file selezionati cambiano.

Apertura di Collaborative Tasks

È possibile usare lo strumento Apri Collaborative Tasks per aprire Collaborative Task
nel Task Pane di SOLIDWORKS.

Per aprire Collaborative Tasks:

Scegliere una delle seguenti opzioni:

• Nel CommandManager, fare clic su Apri Collaborative Task .
• Nella barra degli strumenti Ciclo di vita e collaborazione, fare clic su Apri Collaborative

Task .

Collaborative Tasks viene visualizzato nel Task Pane di SOLIDWORKS.
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Condivisione di modelli come tipo di file STEP242 (2025 FD01)

Quando si attiva l'aggiunta SOLIDWORKS MBD, gli utenti 3DEXPERIENCE possono
condividere parti o assiemi come tipo di file STEP242 in 3DDrive. Tutte le proprietà
personalizzate associate ai file vengono visualizzate nella finestra di dialogo Condividi in
Proprietà personalizzate.

Vantaggi: Il tipo di file STEP242 è un aggiornamento dello standard di file STEP neutro
CAD e include informazioni PMI (Product and Manufacturing Information) 3D oltre ai dati
CAD.

L'aggiunta SOLIDWORKS MBD non fa parte di alcun ruolo. È necessaria una licenza
standalone da aggiungere durante l'installazione nella finestra di dialogo Installa aggiunte
SOLIDWORKS.

Per condividere i modelli come tipo di file STEP242 in 3DDrive:

1. Fare clic su Strumenti > Aggiunte, selezionare SOLIDWORKS MBD e fare clic su
OK.

2. Aprire una parte o un assieme e fare clic su File > Condividi.
3. Nella scheda Condividi file in Condividi file su 3DDrive:

a. Specificare il Nome file.
b. In Tipo di file, selezionare STEP242 AP242 (*.step;*.stp).
c. Opzionale: Per selezionare le proprietà personalizzate disponibili nel modello,

nella sezione Proprietà personalizzate fare clic su Modifica.

Nel PropertyManager Pubblica in STEP242 su 3DDrive, selezionare le proprietà

personalizzate da condividere nel modello e fare clic su .

Viene visualizzata la finestra di dialogo Condividi con esterni. Passare alla quarta
fase.

d. Fare clic su Carica.
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Viene visualizzata la finestra di dialogo Condividi con esterni.

4. Specificare le opzioni di condivisione e fare clic su Condividi.

Il sistema informa l'utente che il file viene caricato in 3DDrive.

Per ulteriori informazioni, vedere Condivisione di file su 3DDrive.

Lavorare con Iterazioni (2025 FD01)

È possibile creare iterazioni di disegni, parti o assiemi SOLIDWORKS.

Vantaggi: È possibile accedere alle iterazioni precedenti dei file SOLIDWORKS per il
ripristino. Ciò è utile se si è commesso un errore e si desidera ripristinare un file.

Creazione di iterazioni

È possibile creare iterazioni di parti, assiemi o disegni SOLIDWORKS.

Per creare iterazioni:

1. In una parte, un assieme o un disegno, fare clic su File > Salva in 3DEXPERIENCE.
2. Nella finestra di dialogo, selezionare Mantieni iterazione precedente.
3. Fare clic su Salva.

Recupero delle iterazioni

È possibile recuperare le iterazioni di parti, assiemi o disegni SOLIDWORKS.

Per recuperare le iterazioni:

1. Nella scheda Ciclo di vita di MySession, fare clic su Iterazione.
2. Selezionare un'iterazione qualsiasi e fare clic su Sostituisci contenuto.
3. Fare clic su File > Salva in 3DEXPERIENCE.
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Collegamento delle colonne della tabella di revisione 3DEXPERIENCE agli attributi
personalizzati (2025 FD01)

È possibile collegare le colonne della tabella di revisione 3DEXPERIENCE agli attributi
personalizzati creati sulla piattaforma.

Vantaggi: Collegare gli attributi significa dover inserire le informazioni in un solo punto.

Nelle tabelle di revisione di 3DEXPERIENCE è possibile eseguire le seguenti operazioni:

AccessoFunzionalità

Fare doppio clic sul testo del titolo.Modifica titoli

Fare doppio clic sul testo della colonna.Modifica nomi colonne

Creazione di attributi personalizzati nelle colonne della tabella di revisione 3DEXPERIENCE (2025
FD01)

La creazione di attributi consente di inserire le informazioni in un unico luogo.

Per creare attributi personalizzati nelle colonne della tabella di revisione
3DEXPERIENCE:

1. Solo gli utenti con privilegi di amministratore possono accedere e gestire
Collaborative Spaces Control Center. SOLIDWORKS supporta attributi
personalizzati nella tabella di revisione 3DEXPERIENCE creata utilizzando
Gestione attributi in Collaborative Spaces Configuration Center.

Fare clic su Collaborative Spaces Control Center > Gestione attributi > Disegno.
2. (Facoltativo) Per aggiungere un nuovo attributo, fare clic su +.
3. Inserire un nome per l'attributo e fare clic su OK.
4. Fare clic su Distribuzione configurazione.
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5. In Utilità di configurazione e del server, fare clic su Carica modello di indice
con attributi aggiunti o rimossi e Ricarica cache server.

6. (Facoltativo) Fare clic su Collaborazione CAD > SOLIDWORKS.
7. (Facoltativo) In Disegno, fare clic su + e selezionare l'attributo creato.

Collegamento di attributi personalizzati nelle colonne della tabella di revisione 3DEXPERIENCE (2025
FD01)

Il collegamento di attributi consente di inserire le informazioni in un unico luogo.

Per collegare attributi personalizzati nelle colonne della tabella di revisione
3DEXPERIENCE:

1. In una tabella di revisione 3DEXPERIENCE, fare clic su una colonna.
2. In Proprietà colonna, fare clic su Attributi personalizzati.

3. Fare clic su e selezionare l'attributo.

Accesso al forum utenti SOLIDWORKS (2025 FD01)

È possibile accedere al Forum utenti di SOLIDWORKS dal Task Pane.

Vantaggi: È possibile connettersi facilmente con la community di esperti SOLIDWORKS
di tutto il mondo senza uscire da SOLIDWORKS.

Per accedere al Forum utenti SOLIDWORKS, procedere in uno dei modi seguenti:

• Dalla barra del titolo, fare clic su Guida > Forum utenti.

• Fare clic sulla scheda Forum utenti .

Utilizzo del ricaricamento (2025 FD01)

È possibile ricaricare i file di parti, assiemi e disegni in SOLIDWORKS Connected.

Vantaggi: È possibile annullare le modifiche dall'ultima operazione di salvataggio.
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Per ricaricare una parte, un assieme o un disegno:

1. In una parte, un assieme o un disegno, fare clic su File > Ricarica.

Finestra di dialogo Salva come nuovo (2025 FD01)

Nella finestra di dialogo Salva con nuovo è possibile rinominare i titoli dei file e la
multiselezione in un unico passaggio.

Vantaggi: La finestra di dialogo offre un modo semplificato per rinominare più file
contemporaneamente.

La finestra di dialogo Salva come nuovo supporta una parte all'interno di una parte.
Contiene Mostra riferimenti per espandere l'interfaccia. In precedenza, Salva come
nuovo non supportava la parte integrata.

È possibile modificare l'Azione da Riutilizza a Salva come nuovo per le parti di
riferimento.

DescrizioneFunzionalità di selezione/sostituzione

Cerca i titoli dei file che corrispondono al
testo immesso nel titolo originale per le
righe selezionate.

Cerca titolo originale

Sostituisce i titoli dei file con il testo
immesso per le righe selezionate.

Sostituisci testo con

Seleziona le righe con valori corrispondenti
nel nuovo titolo.

Seleziona

Sostituisce il valore nel nuovo titolo per le
righe selezionate.

Sostituisci
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Pubblicazione di elementi della distinta di taglio su 3DEXPERIENCE platform (2025 SP1)

È possibile pubblicare gli elementi della distinta di taglio di una parte di saldatura su
3DEXPERIENCE platform.

Per pubblicare gli elementi della distinta di taglio, salvare la parte SOLIDWORKS come
parte di saldatura su 3DEXPERIENCE platform. Il pannello laterale visualizza l'estensione
della parte di saldatura come SW Weldment Part.

Prerequisiti per poter salvare la parte SOLIDWORKS come una parte di saldatura:

• Non è necessario che la parte sia già stata salvata su 3DEXPERIENCE platform.
• La parte deve contenere una funzione di saldatura.
• La parte deve essere contrassegnata come un singolo prodotto fisico.

Prerequisiti per la pubblicazione di elementi della distinta di taglio su 3DEXPERIENCE
platform:

• La parte deve essere una parte di saldatura.
• La distinta di taglio deve essere aggiornata.
• La proprietà degli elementi della distinta di taglio deve avere l'ID distinta di taglio.

Per pubblicare elementi della distinta di taglio su 3DEXPERIENCE platform:

1. Con una parte di saldatura aperta, fare clic su Opzioni (barra degli strumenti
Standard), selezionare la scheda Proprietà del documento, quindi Saldature.

2. Nella finestra di dialogo Proprietà del documento - Saldature, in corrispondenza di
ID distinta di taglio, selezionare Genera ID distinta di taglio e fare clic su OK.

3. Nel Task Pane 3DEXPERIENCE, fare clic col pulsante destro sulla parte e selezionare
Salva.

4. Nella finestra di dialogo Salva in 3DEXPERIENCE, selezionare Pubblica elementi
della distinta di taglio e fare clic su Salva.

MySession visualizza gli elementi della distinta di taglio della parte di saldatura. Il pannello
laterale mostra le proprietà degli elementi della distinta di taglio.
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Gli amministratori possono definire attributi PLM personalizzati e mappare tra elementi
CAD ed elementi PLM per salvare gli attributi sulla 3DEXPERIENCE platform.

Accettazione o rifiuto delle relazioni padre-figlio nei file IDX (2025 SP1)

È possibile gestire e accettare o rifiutare le modifiche nelle associazioni padre-figlio,
indipendentemente dal fatto che gli aggiornamenti provengano da ECAD o MCAD.

CircuitWorks supporta ora associazioni padre-figlio tra componenti e altri elementi della
scheda, come aree consentite, aree non consentite, fori rivestiti e fori non rivestiti, quando
si interagisce con i file IDX3.0. È possibile accettare o rifiutare le modifiche a questi
elementi da ECAD o MCAD.

Vantaggi:

• accettare o rifiutare tutte le modifiche associate in un'unica azione, indipendentemente
dal fatto che gli aggiornamenti abbiano origine da ECAD o MCAD.

• Quando si modificano i componenti padre in MCAD, tutti gli elementi figlio correlati
vengono aggiornati automaticamente durante l'esportazione in CircuitWorks.

Per utilizzare questa funzione, procedere come segue:

1. Fare clic su Strumenti > CircuitWorks > Opzioni CircuitWorks.
2. Selezionare ProStep EDMD e selezionare Usa associazione padre-figlio nelle

comunicazioni con IDX.
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Notifiche di aggiornamento migliorate per le app connesse (2025 SP1)

Quando si avvia SOLIDWORKS Connected, Visualize Connected o DraftSight Connected
da un collegamento sul desktop, è possibile aggiornare l'app direttamente dal messaggio
se è disponibile o necessario un aggiornamento.

La piattaforma applica il nuovo comportamento a qualsiasi aggiornamento importante o
minore dopo l'installazione di 3DEXPERIENCE 2025x FD01.

In precedenza, era necessario accedere all'app in Compass utilizzando un browser come
passaggio separato.

Vantaggi: Questo miglioramento semplifica il processo di aggiornamento ed elimina la
necessità di passare da uno strumento all'altro, rendendo più veloce l'aggiornamento
delle app.
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SPO_GA

Presentazioni rapide

Gli utenti di 3DEXPERIENCE possono seguire moduli di apprendimento compatti e integrati
chiamati Presentazioni rapide. Ogni Presentazione rapida presenta una sequenza di
passaggi mostrati come finestre a comparsa interattive che puntano agli elementi
nell'interfaccia utente.

Vantaggi: È possibile apprendere in modo interattivo le app 3DEXPERIENCE per
comprendere rapidamente le funzionalità e i concetti di base. Per informazioni sulle best
practice, vedere SolidPractices.

Per accedere a Presentazioni rapide, nella finestra di dialogo Benvenuto, nella scheda
Informazioni, fare clic su Presentazioni rapide.

Per avviare una Presentazione rapida, fare clic su una presentazione, ad esempio
Panoramica dell'interfaccia utente. Per procedere con i passaggi, fare clic su Avanti
all'interno del passaggio a comparsa. Le finestre a comparsa includono i numeri di passaggi
in modo da poter misurare i progressi.

Rimozione dell'opzione per generare il formato 3D

L'opzione Elabora formato 3D per tutte le configurazioni viene rimossa.

Vantaggi: È possibile continuare a lavorare in SOLIDWORKS mentre l'output viene
generato.

L'opzione è stata aggiunta nella pagina Impostazioni di Collaborative Spaces
Configuration Center > Collaborazione CAD > SOLIDWORKS. I CGR vengono ora
generati utilizzando Conversion Service per l'ambiente cloud e Derived Format Converter
per l'ambiente locale.
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Task Pane

I miglioramenti apportati all'interfaccia utente contribuiscono a migliorare la produttività.

In Design with SOLIDWORKS® e SOLIDWORKS Connected, il Task Pane mostra come
seconda scheda File 3DEXPERIENCE su questo PC. Quando si disattiva la scheda

3DEXPERIENCE , File 3DEXPERIENCE su questo PC è la prima scheda. Nelle versioni
precedenti, File 3DEXPERIENCE su questo PC era l'ultima scheda.
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Visibilità della colonna Quantità

La colonna Quantità in MySession è visibile o nascosta in base all'opzione della vista ad
albero selezionata nella finestra di dialogo Opzioni.

Vantaggi: È possibile visualizzare o nascondere la colonna Quantità.

La colonna Quantità visualizza il numero di istanze associate a un oggetto. I valori
visualizzati si basano sul tipo di Vista ad albero selezionata nella finestra di dialogo
Opzioni. La colonna è visibile quando si seleziona l'opzione Vista di riferimento o Vista
ad albero FeatureManager.

Supporto delle licenze per SOLIDWORKSCAM, SOLIDWORKS Inspection e componenti
aggiuntivi SOLIDWORKS MBD

Se si possiedono licenze per SOLIDWORKS CAM, SOLIDWORKS Inspection e SOLIDWORKS
MBD, è possibile attivarne l'esecuzione in SOLIDWORKS Connected.

Vantaggi: Le aggiunte si installano automaticamente, rendendo questi strumenti
immediatamente disponibili in SOLIDWORKS Connected.

Quando si installa SOLIDWORKS Connected, è possibile selezionare un'aggiunta e inserirne
il numero di serie. Se si utilizza una licenza di rete, è necessario specificare l'indirizzo
(port@server) del server di SolidNetWork (SNL) License.

Dopo aver installato l'aggiunta:

• È possibile attivare o disattivare le versioni standalone tramite il menu Guida in linea
di SOLIDWORKS Connected.

• Le versioni SNL recuperano una licenza dal server di licenza quando vengono aggiunte.

In particolare per SOLIDWORKS Inspection, quando si installa SOLIDWORKS Inspection
con SOLIDWORKS Connected, l'aggiunta e l'app standalone vengono installate e
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aggiornate. L'applicazione standalone offre le stesse funzioni della versione di Gestione
installazioni di SOLIDWORKS. È possibile avviare l'applicazione standalone dal collegamento
sul desktop o dal menu Start di Windows, non da 3DEXPERIENCE Compass. L'applicazione
standalone supporta anche gli stessi metodi di attivazione e le stesse licenze SolidNetWork
(SNL).

Collegamento delle proprietà di configurazione delle rappresentazioni ai prodotti fisici

SOLIDWORKS collega le proprietà di configurazione delle rappresentazioni ai relativi
prodotti fisici.

È possibile sovrascrivere i valori delle rappresentazioni collegate dai prodotti fisici.Mostra
rappresentazioni consente di visualizzare le rappresentazioni dei prodotti fisici nel
pannello di sinistra.

Per collegare prodotti fisici e rappresentazioni di file legacy compatibili con 3DEXPERIENCE
Platform e salvati:

1. Nell'albero di disegno FeatureManager®, fare clic con il pulsante destro del mouse sul
file.

2. Selezionare Collega proprietà nelle rappresentazioni.
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3
Installazione

Questo capitolo comprende i seguenti argomenti:

• Convertire il server SolidNetWork License a 64 bit
• Installazione dell'API Web di SOLIDWORKS Manage

Convertire il server SolidNetWork License a 64 bit
SolidNetWork License Manager per SOLIDWORKS® 2025 viene installato come applicazione
a 64 bit. Questa modifica non influisce sulla funzionalità o sull'esperienza dell'utente.

Installazione dell'API Web di SOLIDWORKS Manage
È possibile installare l'API Web Manage nell'installazione guidata InstallShield di
SOLIDWORKS PDM. Durante l'installazione, è possibile utilizzare la porta predefinita o
specificare un altro valore per la porta HTTP.

Inoltre, nella Gestione installazioni di SOLIDWORKS, è possibile installare l'API Web
Manage nella pagina SOLIDWORKS Manage Server e specificare la porta HTTP.
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4
Amministrazione

Questo capitolo comprende i seguenti argomenti:

• Ereditare le posizioni predefinite dei file durante l'aggiornamento a SOLIDWORKS
2025

• SOLIDWORKS Login Manager

Ereditare le posizioni predefinite dei file durante l'aggiornamento a
SOLIDWORKS 2025

La logica per l'ereditarietà delle posizioni dei file dalle installazioni precedenti è stata
migliorata. In precedenza, era necessario modificare o ripristinare le posizioni dei file
durante l'aggiornamento a causa delle posizioni predefinite dei file delle installazioni
precedenti.

Le posizioni predefinite dei file ora seguono questa logica:

• Se si è mantenuta la posizione predefinita del file in un'installazione precedente,
SOLIDWORKS® 2025 crea e utilizza una nuova posizione predefinita del file quando si
esegue il software per la prima volta.

• Tutti i nuovi formati foglio e modelli di documento aggiunti nella precedente posizione
predefinita sono integrati nelle posizioni predefinite dei file 2025. L'integrazione include
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tutti i nuovi file a cui si fa riferimento in ProgramData\SOLIDWORKS\SOLIDWORKS
version.

Se si personalizzano le posizioni dei file in percorsi personalizzati, non vi sono modifiche.
SOLIDWORKS 2025 continua a ereditare i percorsi personalizzati dalle installazioni
precedenti. Esistono percorsi personalizzati al di fuori di ProgramData\SOLIDWORKS o
delle cartelle di installazione di SOLIDWORKS.

I dati nella directory di installazione di SOLIDWORKS vengono aggiornati solo se
SOLIDWORKS è installato nella cartella programmi di Windows. Se SOLIDWORKS è
installato all'esterno di questa cartella, le posizioni dei file ereditano i percorsi
personalizzati.

SOLIDWORKS Login Manager
SOLIDWORKS Login Manager, installato dalla Gestione installazioni di SOLIDWORKS,
consente di accedere alle app 3DEXPERIENCE Marketplace e 3DEXPERIENCE.

Quando si installa un'immagine amministrativa utilizzando la riga di comando o tramite
Microsoft Active Directory, è necessario includere il file di SOLIDWORKS Login Manager
nell'immagine. Ad esempio:
administrative_image_directory\swloginmgr\SOLIDWORKS Login Manager.msi.
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5
Fondamentali di SOLIDWORKS

Questo capitolo comprende i seguenti argomenti:

• Generazione di oggetti derivati da STEP per gli assiemi SOLIDWORKS mediante
SOLIDWORKS Task Scheduler (2025 FD02)

• Prestazioni nelle parti multicorpo (2025 SP2)
• Ridenominazione di note, DimXpert e quote di funzione nella vista Annotazioni

nell'albero di disegno FeatureManager (2025 SP2)
• La condivisione dei file è disponibile sia su 3DDrive sia su 3DSwym, a partire da

(2025 SP1)
• Modifiche alle opzioni del sistema e alle proprietà del documento
• API di SolidWorks
• Specifica un modello Z-Su
• Salvataggio dei file SOLIDWORKS Inspection utilizzando i segnalibri

Generazione di oggetti derivati da STEP per gli assiemi SOLIDWORKS
mediante SOLIDWORKS Task Scheduler (2025 FD02)

Gli utenti 3DEXPERIENCE possono utilizzare il formato STEP per gli assiemi in un'attività
Genera output derivato.

Vantaggi: È possibile condividere l'output derivato da un assieme senza dover assegnare
una licenza CAD agli utenti di altri reparti.

È possibile utilizzare l'attività Genera output derivato per includere gli oggetti derivati
STEP AP203 o AP214 allegati agli assiemi SOLIDWORKS.

Il formato STEP non è disponibile per l'app Design with SOLIDWORKS nelle installazioni
on premise.

L'attività Genera output derivato richiede l'inserimento della password di 3DEXPERIENCE
platform al momento della creazione dell'attività. Ciò consente all'attività di eseguire
SOLIDWORKS per conto dell'utente in una data e ora futura. Ad esempio, è possibile
impostare un'attività da eseguire durante la notte e generare automaticamente output
derivati per tutti gli assiemi o i disegni aggiunti ogni giorno che corrispondono alla ricerca.

In precedenza, era possibile eseguire l'attività solo una volta ed entro lo stesso giorno.

Per generare oggetti derivati STEP per assiemi SOLIDWORKS:

1. In SOLIDWORKS, fare clic su Strumenti > Applicazioni SOLIDWORKS >
SOLIDWORKS Task Scheduler.
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2. Fare clic su Genera output derivato nella barra laterale, oppure fare clic su
Operazioni > Genera output derivato.

3. In Titolo attività, inserire un nuovo titolo per l'attività o lasciare quello predefinito.
4. Selezionare uno dei seguenti formati STEP per il Formato output derivato.

• STEP AP203
• STEP AP214

5. Selezionare un'Area di collaborazione.
6. Per Maturità, selezionare Solo rilasciato o Congelato e rilasciato.
7. Per Proprietario, selezionare Tutti i contenuti o I miei contenuti nell'area di

collaborazione.
8. Immettere la password di 3DEXPERIENCE platform nel campo Password.

Prestazioni nelle parti multicorpo (2025 SP2)

È possibile disattivare la visualizzazione dei bordi delle sagome per migliorare le prestazioni
delle parti multicorpo di grandi dimensioni.

È possibile specificare una soglia per il numero di corpi da considerare grande per la parte.
Quando si apre una parte il cui numero di corpi supera questa soglia, SOLIDWORKS
disattiva automaticamente la visualizzazione dei bordi della silhouette.

Per disattivare la visualizzazione dei bordi della silhouette:

1. Fare clic su Strumenti > Opzioni > Opzioni del sistema > Prestazioni.
2. Selezionare Non visualizzare i bordi della silhouette nelle parti quando il

numero di corpi supera.
3. Specificare un valore per il numero minimo di corpi.
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4. Fare clic su OK.
5. Salvare il modello, chiuderlo e riaprirlo affinché l'opzione abbia effetto.

Ridenominazione di note, DimXpert e quote di funzione nella vista Annotazioni
nell'albero di disegno FeatureManager (2025 SP2)

È possibile rinominare note e dimensioni nelle annotazioni con titoli specifici invece di
nomi generici come note1 e note2.

Per rinominare note e quote nelle annotazioni:

1. Nell'albero di disegno FeatureManager, fare clic con il pulsante destro del mouse su
Annotazioni e selezionare Elenca annotazioni in Vista albero.

2. Scegliere una delle seguenti opzioni:

• Fare clic con il pulsante destro del mouse su una nota o quota e selezionare
Rinomina elemento dell'albero

• Selezionare una nota o una quota e premere F2.

3. Digitare il nome e fare clic sull'area grafica.

Il nome può includere lettere, numeri e caratteri speciali.
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La condivisione dei file è disponibile sia su 3DDrive sia su 3DSwym, a partire
da (2025 SP1)

È possibile utilizzare lo strumento Condividi per condividere i file SOLIDWORKS su
3DDrive e 3DSwym senza installare l'app Design with SOLIDWORKS.

Grazie a 3DDrive e 3DSwym, è possibile condividere in maniera sicura i dati con il team
direttamente da SOLIDWORKS.

Per condividere i file su 3DDrive e 3DSwym:

1. In un documento SOLIDWORKS, fare clic su File > Condividi.
2. Specificare l'app.

• Per condividere su 3DDrive, selezionare Condividi file.
• Per condividere su 3DSwym, selezionare Condividi nella community.

3. Se non è stato effettuato l'accesso, fare clic su Accedi e immettere le credenziali
3DEXPERIENCE per accedere all'app.

In caso di problemi di accesso a 3DSwym o 3DDrive, consultare la sezione
Procedura per attivare 3DEXPERIENCE platform.

4. Nell'applicazione, compilare i campi obbligatori e fare clic su Carica per 3DDrive
oppure Pubblica per 3DSwym.

Modifiche alle opzioni del sistema e alle proprietà del documento
Le seguenti opzioni sono state aggiunte, modificate o rimosse nel software.
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Opzioni del sistema

AccessoDescrizioneOpzione

FeatureManager(2025 SP3) Specifica le opzioni nella
finestra di dialogo Nome e descrizione
del componente a livello di sistema.

Quando questa opzione è selezionata, è
possibile fare clic su Nome e
descrizione del componente per
aprire la finestra di dialogo Nome e
descrizione del componente.

Sovrascrivi
visualizzazione albero a
livello documento

Esporta(2025 SP2) Le opzioni di esportazione
per i file GLTF e GLB di Extended Reality
sono state spostate dalla finestra di
dialogo Impostazioni XR Exporter in
Opzioni del sistema. In Formato file,
selezionare GLTF/GLB e specificare le
opzioni.

Scena, Animazioni e
Compressione

FeatureManager(2025 SP2) Risolve i componenti leggeri
quando si espandono i componenti
nell'albero di disegno FeatureManager.

Risolvi automaticamente
i componenti leggeri
durante l'espansione
nell'albero
FeatureManager

ColoriSpecifica i colori mostrati per le facce
della mesh quando si utilizza lo
strumento Inserisci > Mesh >
Segmenta corpo mesh importato o
Converti mesh in standard. Vedere
Colori > Impostazioni schema di
colore.

Faccia mesh riconosciuta

Faccia mesh non
riconosciuta

EsportaMappa le proprietà personalizzate ai set
di proprietà IFC™. Vedere Esporta >
Formato file: IFC > Risultato come.

Usa file di mappatura per
Set proprietà

InstallazioneLa logica per l'ereditarietà delle posizioni
dei file dalle installazioni precedenti è
stata migliorata. Vedere Ereditare le
posizioni predefinite dei file durante
l'aggiornamento a SOLIDWORKS
2025 alla pagina 68

Posizioni dei file

DisegniQuando si apre un disegno, è possibile
fare in modo che lo zoom si adatti
automaticamente all'area grafica.

c all'apertura
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Proprietà del documento

AccessoDescrizioneOpzione

LamieraSOLIDWORKS® aggiunge
automaticamente le quote di
lunghezza a tutti i profili della
flangia del bordo, dove la quota di
schizzo (non la quota della
funzione) controlla la lunghezza
della flangia.

Aggiungi automaticamente le
dimensioni per la lunghezza
della flangia ai relativi profili

Finiture di
superficie

Selezionare uno standard:
• 21920-1
• 1302 (1992)
• 1302 (2002)

Simbolo superficie standard

Tolleranza
della quota
dello smusso

Selezionare una tolleranza:
• Nessuno
• Bilaterale
• Limite
• Simmetrica
• MIN
• MAX
• Ottimizzato
• Ottimizzate con tolleranza
• Ottimizzazione (solo tolleranza)

Tipo di tolleranza

API di SolidWorks
Vedere la Guida in linea di SOLIDWORKS API: Note di distribuzione per informazioni sugli
aggiornamenti più recenti.

• Possibilità di importare annotazioni nei disegni
• Rendering fotorealistico con SOLIDWORKS Visualize tramite l'API SOLIDWORKS. Il
supporto dell'aspetto per l'aggiunta API SOLIDWORKS Visualize include:

• Accesso alle nuove proprietà IRenderMaterial
• Possibilità di aggiungere o modificare gli aspetti del piano delle scene del modello
• Mappatura della trama di superfici non lineari, incluse le proiezioni di superficie

• Prestazioni migliorate:

• Quando si ricarica un modello SOLIDWORKS dal disco
• Con oggetti del componente
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Specifica un modello Z-Su

Quando si crea una parte o un assieme, è possibile scegliere un modello per l'orientamento
Z-su.

Nelle versioni precedenti, SOLIDWORKS aveva solo un orientamento Y-su predefinito.

Le impostazioni di orientamento Y-su e Z-su sono disponibili solo per i modelli di default
creati da SOLIDWORKS.

Per specificare un modello Z-su:

1. Fare clic su Nuovo (barra degli strumenti Standard) o File > Nuovo.
2. Nella finestra di dialogo:

a. Selezionare un tipo di documento.
b. Specificare un'opzione:

• Y-su. L'asse Y è rivolto verso l'alto.
• Z-su. L'asse Z è rivolto verso l'alto.

c. Fare clic su OK.
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Salvataggio dei file SOLIDWORKS Inspection utilizzando i segnalibri

È possibile salvare i file SOLIDWORKS Inspection in 3DEXPERIENCE® Platform utilizzando
i segnalibri.

Per salvare i file SOLIDWORKS Inspection utilizzando i segnalibri:

1. Aprire un progetto o creare un nuovo progetto e daMySession fare clic con il pulsante
destro del mouse sul file, quindi fare clic su Salva.

2. Nella finestra di dialogo Salva in 3DEXPERIENCE, fare clic su Aggiungi segnalibro.
3. In Bookmark Editor, fare clic con il pulsante destro del mouse su Segnalibri e

selezionare Nuovo segnalibro.
4. Nella finestra Nuovo segnalibro, per Titolo immettere un nome per il segnalibro e

fare clic su Crea.
5. Selezionare il nuovo segnalibro.
6. Specificare un'opzione e fare clic su Applica.

a. Aggiungi esistente. Aggiunge il segnalibro appena creato ai segnalibri esistenti.
b. Carica file. Carica un file esistente.

7. Per salvare il segnalibro sulla 3DEXPERIENCE Platform, fare clic su Salva.
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6
Interfaccia utente

Questo capitolo comprende i seguenti argomenti:

• Specifica del nome del componente e delle opzioni di descrizione a livello di sistema
(2025 SP3)

• Comandi di ricerca (2025 SP2)
• Interfaccia semplificata (2025 SP1)
• Previsione comando
• Riorganizzazione componenti
• Facilità d'uso
• Creazione guidata fori
• Avanzamento salvataggio e salvataggio automatico
• Creare gruppo di documenti

Specifica del nome del componente e delle opzioni di descrizione a livello di
sistema (2025 SP3)

È possibile utilizzare Sovrascrivi visualizzazione albero a livello documento per
specificare le opzioni nella finestra di dialogo Nome e descrizione del componente a livello
di sistema.
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Quando questa opzione è attivata, le opzioni a livello di sistema sovrascrivono le opzioni
a livello di documento per i nomi dei componenti nell'albero di disegno FeatureManager.
Le opzioni a livello di sistema non sovrascrivono le opzioni a livello di documento nel
documento.

Per specificare il nome del componente e le opzioni di descrizione a livello di
sistema:

1. Aprire un modello.

Per esempio, nell'albero di disegno FeatureManager, il nome del componente mostra
il nome del componente, il nome della configurazione e il nome dello stato di
visualizzazione.

2. Fare clic su Strumenti > Opzioni > Opzioni del sistema > FeatureManager.
3. Selezionare Sovrascrivi visualizzazione albero a livello documento.

Selezionando Sovrascrivi visualizzazione albero a livello di documento
vengono disattivate le opzioni nella finestra di dialogo Nome e descrizione del
componente a livello di documento.

4. Fare clic su Nome e descrizione del componente.
5. Nella finestra di dialogo Nome e descrizione del componente, selezionare diverse

opzioni.

Per esempio, in Primario, selezionare Descrizione componente. In Secondario,
deselezionare Nome configurazione e selezionare Descrizione configurazione.
In Terziario, deselezionare Mostra nome stato.

6. Fare clic su Applica, quindi su OK per chiudere la finestra di dialogo.
7. Chiudere la finestra di dialogo Opzioni del sistema.

Nell'albero di disegno FeatureManager, il nome del componente mostra la descrizione
del componente e la descrizione della configurazione.

8. Nell'albero di disegno FeatureManager, fare clic con il pulsante destro del mouse
sull'assieme e fare clic su Visualizzazione albero > Nome e descrizione del
componente.

Le opzioni sono disabilitate a livello di documento quando è selezionata l'opzione
Sovrascrivi visualizzazione albero a livello di documento.
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Comandi di ricerca (2025 SP2)

La funzionalità Comandi di ricerca fornisce risultati migliori grazie alla mappatura della
terminologia avanzata. La terminologia di altri pacchetti CAD viene mappata sugli strumenti
SOLIDWORKS per aiutare l'utente a trovare gli strumenti di cui hai bisogno. I risultati
della ricerca includono anche tasti di scelta rapida per un accesso più rapido agli strumenti.

È possibile mappare più parole chiave sugli strumenti SOLIDWORKS. In precedenza era
supportata solo una parola chiave per strumento.
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Mappatura delle parole chiave
Il software include parole chiave aggiuntive che sono mappate sugli strumenti
SOLIDWORKS. Ciò è utile quando si ricerca uno strumento che non utilizza necessariamente
i nomi SOLIDWORKS. Ad esempio, se si ricerca un termine utilizzato in un prodotto CAD
diverso, lo strumento SOLIDWORKS corrispondente potrebbe essere visualizzato nei
risultati della ricerca.

tasti di scelta rapida
Quando si utilizzano i Comandi di ricerca, i risultati includono i tasti di scelta rapida
degli strumenti tra parentesi, se presenti. Se si utilizza il tasto S per ricercare gli strumenti,
i risultati elencano anche i tasti di scelta rapida.

Supporto di più parole chiave
È possibile specificare più parole chiave da utilizzare per la ricerca degli strumenti nella
funzionalità Comandi di ricerca.

Fare clic su Strumenti > Personalizza. Nella finestra di dialogo, nella scheda Tastiera,
nella colonna Termini di ricerca, specificare le parole chiave per gli strumenti separati
da virgole.
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Interfaccia semplificata (2025 SP1)

L'Interfaccia semplificata è un'area di lavoro che mostra la finestra di SOLIDWORKS
con un'interfaccia utente ridotta. La finestra include elementi di interfaccia utente di base
personalizzati in base al tipo di documento aperto.

Con un documento aperto, fare clic su Visualizza > Area di lavoro > Interfaccia
semplificata.

Senza un documento aperto, fare clic su Visualizza > Interfaccia semplificata.

Quando questa opzione è selezionata, la barra di stato indica l'area di lavoro Interfaccia
semplificata.

Se si utilizza l'area di lavoro Interfaccia semplificata, personalizzare l'interfaccia in
base alle proprie esigenze, quindi disattivare Interfaccia semplificata. SOLIDWORKS
salva le personalizzazioni se si riattiva l'Interfaccia semplificata.

Barra degli strumenti Vista con preavviso
Per le parti e gli assiemi, la barra degli strumenti Vista con preavviso contiene gli strumenti
per manipolare le viste. Non include impostazioni relative ad aspetti, scene o vista.

Interfaccia predefinitaInterfaccia semplificata

CommandManager
Il CommandManager visualizza una scheda per tipo di documento. Le schede sono
Strumenti di modellazione di base Strumenti di assieme di base e Strumenti di disegno
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di base e contengono gli strumenti più comunemente utilizzati per i diversi tipi di
documenti.

Interfaccia predefinitaInterfaccia semplificata

Task Pane
Il Task pane contiene le seguenti schede:

• 3DEXPERIENCE

• Libreria del progetto

• Visualizza tavolozza

• Aspetti, Scenografie e Decalcomanie

Interfaccia predefinitaInterfaccia semplificata

Albero di disegno FeatureManager
L'albero di disegno FeatureManager contiene i seguenti elementi:

• Equazioni

• Materiale

• Piani
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• Origine

Interfaccia predefinitaInterfaccia semplificata

Gli elementi nell'albero di disegno FeatureManager non includono i nomi di configurazione
o di stato di visualizzazione se ne esiste solo uno.

PropertyManager
Diversi PropertyManager contengono sezioni compresse:
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Interfaccia predefinitaInterfaccia semplificata

Modalità di schizzo
Per le parti, l'Interfaccia semplificata apre una nuova parte con uno schizzo attivo sul
piano Frontale.

Albero di disegno MotionManager
L'albero di disegno MotionManager è nascosto.
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Previsione comando

Previsione comando prevede gli strumenti più rilevanti in base a quelli utilizzati nella
sessione SOLIDWORKS corrente. In questo modo si riduce il tempo impiegato per cercare
gli strumenti che si prevede di utilizzare in futuro.

Per utilizzare Previsione comando:

1. In un documento SOLIDWORKS, fare clic sulla scheda Previsione comando (Beta)
(CommandManager).

2. Fare clic su uno strumento nella scheda.

Previsione comando è una funzionalità beta e i suggerimenti degli strumenti si basano
su un modello di apprendimento automatico.

Riorganizzazione componenti
I miglioramenti apportati all'interfaccia utente contribuiscono a migliorare la produttività.
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La finestra Riorganizza componenti è stata spostata in un PropertyManager. La finestra
di dialogo non oscura più l'area grafica.

Facilità d'uso
L'interfaccia utente è stata migliorata per migliorare la produttività.

Denominazione da raccordo a smusso

Nell'albero di disegno FeatureManager®, quando si fa clic con il pulsante destro del mouse
su Converti raccordo in smusso, l'albero di disegno FeatureManager cambia il nome
del raccordo in smusso. È possibile utilizzare anche Converti smusso in raccordo e il
software aggiorna il nome di conseguenza. Nelle versioni precedenti, il nome del raccordo
rimaneva nell'albero di disegno FeatureManager.

Riattivare automaticamente lo schizzo
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Nell'albero di disegno FeatureManager, è possibile fare clic con il pulsante destro del
mouse su uno schizzo eliminato da modificare, selezionareModifica schizzo, per riattivare
automaticamente lo schizzo. Nelle versioni precedenti, si riceveva questa notifica:

Finestra di dialogo Materiale - scheda Preferenze

Nella finestra di dialogo Materiale, dopo aver aggiunto un nuovo materiale ai Preferiti,
è possibile fare clic su Chiudi o su x nell'angolo superiore destro per salvare le modifiche
e chiudere la finestra di dialogo. Nelle versioni precedenti, quando si fa clic su x, le
modifiche non venivano salvate.

Finestra di dialogo Materiale - scheda Personalizza

Nella finestra di dialogo Materiale, dopo aver aggiunto un nuovo materiale da Materiali
personalizzati a Personalizzati e aver fatto clic su x, si riceve la seguente notifica:
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Nelle versioni precedenti, la notifica veniva ricevuta solo quando si faceva clic su Chiudi.

Menu a comparsa nella finestra di dialogo Personalizza

Nella finestra di dialogo Personalizza, lo strumento Seleziona è disponibile nelle barre
degli strumenti mobili.

Creazione guidata fori

I miglioramenti apportati all'interfaccia utente contribuiscono a migliorare la produttività.

Quando si fa clic su Creazione guidata fori (barra degli strumenti Funzioni), le icone
Tipo di foro sono più chiare da distinguere.
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Avanzamento salvataggio e salvataggio automatico

I miglioramenti apportati all'interfaccia utente contribuiscono a migliorare la produttività.

Quando i file su 3DEXPERIENCE Platform vengono salvati, il software visualizza messaggi
per indicare che il software sta salvando i file.

Durante il salvataggio di un file su 3DEXPERIENCE Platform, il software mostra una barra
di avanzamento e visualizza "Salvataggio in corso..." nella barra di stato.

Durante il salvataggio automatico di un file su 3DEXPERIENCE Platform, il software mostra
una barra di avanzamento e visualizza "Salvataggio automatico in corso..." nella barra
di stato.

Creare gruppo di documenti
È possibile salvare tutti i file aperti in SOLIDWORKS come un unico gruppo di documenti.
In questo modo è possibile aprire tutti i file salvati in quel gruppo contemporaneamente.
Nelle versioni precedenti era necessario aprire ogni file singolarmente.
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Creazione di più file come gruppo di documenti

Per creare un gruppo di documenti:

1. In un documento SOLIDWORKS, fare clic su Finestra > Crea gruppo di documenti.

La finestra di dialogo Crea gruppo di documenti contiene un elenco di file aperti in
SOLIDWORKS.

2. Nella finestra di dialogo:

a. Selezionare i file richiesti.
b. Fare clic su Crea.

Il software mostra una notifica di operazione riuscita. Un messaggio informa
che SOLIDWORKS ha creato il Gruppo di documenti ed è possibile accedervi
dalla scheda Recenti nella finestra di dialogo Benvenuto.

Aggiornamento di un gruppo di documenti

Quando si creano nuove parti, è possibile salvare le parti come parte di un gruppo di
documenti creato in precedenza.

Per aggiornare un gruppo di documenti:

1. Aprire le parti da includere in un gruppo di documenti.
2. Fare clic su Finestra > Crea gruppo di documenti.
3. Nella finestra di dialogo:

a) In Nome del gruppo di documenti, selezionare un gruppo di documenti.
Il software compila l'elenco con i file aperti e i file salvati nel gruppo di documenti
selezionato.

b) Fare clic su Crea.
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7
Tecniche di schizzo

Questo capitolo comprende i seguenti argomenti:

• Creazione di quadrati con strumenti del rettangolo (2025 SP2)
• Inverti punto finale tangente (2025 SP1)
• Riparazione delle relazioni svincolate
• Ripetizioni di schizzo lineari e circolari

Creazione di quadrati con strumenti del rettangolo (2025 SP2)

Quando si utilizzano gli strumenti del rettangolo, è possibile creare quadrati premendo il
tasto Maiusc durante la tracciatura.

Per creare quadrati utilizzando gli strumenti del rettangolo:

1. Aprire una parte o un assieme.
2. Nell'albero di disegno FeatureManager, selezionare un piano.

3. Fare clic su Schizzo (barra degli strumenti Schizzo).
4. Creare un rettangolo angolare:
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Nella scheda Schizzo del CommandManager, fare clic su Rettangolo angolare

.

a.

b. Nello schizzo, fare clic per posizionare il primo angolo.
c. Premere Maiusc, quindi trascinare e fare clic per creare un quadrato.

I lati adiacenti del quadrato hanno relazioni uguali.

5. Creare un parallelogramma:

a. Fare clic su Parallelogramma .
b. Fare clic per posizionare il primo angolo
c. PremereMaiusc, quindi trascinare, ruotare e fare clic per specificare la lunghezza

e l'angolo del primo bordo.
d. Continuare a premere Maiusc, e trascinare e fare clic per specificare l'angolo

degli altri tre bordi.

6. Creare un rettangolo spigolo a 3 punti e immettere un valore:

a. Fare clic su Opzioni > Opzioni del sistema > Schizzo e selezionare Attiva
input numerico su schermo in creazione entità.

b. Nello schizzo, fare clic su Rettangolo spigolo a 3 punti .
c. Fare clic per posizionare il primo angolo e trascinare il cursore.
d. Inserire un valore per la dimensione del quadrato e premere il tasto Invio.
e. Premere Maiusc, trascinare il cursore e fare clic per creare il quadrato.

Inverti punto finale tangente (2025 SP1)

È possibile invertire il punto finale di un arco tangente collegato a una linea. Il raggio
dell'arco non cambia.

La funzionalità non è disponibile per gli schizzi 3D.
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Per invertire il punto finale di un arco tangente:

1. Aprire un nuovo schizzo e tracciare lo schizzo di una linea.

2. Fare clic su Arco tangente e creare un arco partendo dal punto finale della linea.

3. Fare clic con il pulsante destro del mouse sul punto in cui si incontrano l'arco e la

linea, quindi fare clic su Inverti punto finale tangente .

L'arco tangente inverte la sua posizione:
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Riparazione delle relazioni svincolate

Nel PropertyManager Mostra/elimina relazioni, è possibile usare Trova sostituto per
correggere le relazioni svincolate in uno schizzo. Utilizzare Ripristina tutti gli elementi
svincolati per correggere automaticamente tutte le relazioni svincolate.

È possibile utilizzare Ripara automaticamente quota o relazione dello schizzo
per riparare la relazione svincolata selezionata dalla barra degli strumenti contestuale.

Queste opzioni sono disponibili solo per gli schizzi 2D. Le relazioni svincolate che hanno
riferimenti esterni non possono essere riparate usando Ripara tutti gli elementi
svincolati e Trova sostituto. È necessario riparare manualmente queste relazioni
svincolate.

Per riparare le relazioni svincolate:

1. Aprire un modello che contiene una relazione svincolata.

2. Fare clic su Mostra/elimina relazioni (barra degli strumenti Quote/Relazioni),
oppure su Strumenti > Relazioni > Mostra/elimina.

3. Nel PropertyManager, in Relazioni, selezionare una relazione svincolata.
4. In Entità, fare clic su Trova sostituto.

SOLIDWORKS® cerca un sostituto. Se non viene trovato un sostituto, viene visualizzato
un messaggio.

Ripara tutti gli elementi svincolati e Trova sostituto sono disponibili quando
uno schizzo ha relazioni svincolate.
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5. Quando viene trovato un sostituto, rivedere il sostituto elencato in Entità con cui
sostituire quella selezionata sopra quindi fare clic su Sostituisci.

Ripetizioni di schizzo lineari e circolari
Per le ripetizioni lineari e circolari, è possibile generare una ripetizione di schizzo
completamente definita.

Per una ripetizione di schizzo lineare di un'entità completamente definita, selezionare
queste opzioni nel PropertyManager Ripetizione lineare per generare una ripetizione
completamente definita:

• Spaziatura quota X
• Fissa asse X
• Spaziatura Y della quota
• Angolo di quota tra gli assi

Per una ripetizione di schizzo circolare viene applicata automaticamente una relazione
coincidente tra un punto selezionato e il centro della ripetizione quando il punto di origine
non è il punto selezionato.
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8
Parti e funzioni

Questo capitolo comprende i seguenti argomenti:

• Mantenimento delle opzioni di schizzo della Creazione guidata fori (2025 SP3)
• Fissare il PropertyManager del raccordo o dello smusso (2025 SP2)
• Uscita dai processi delle parti con il tasto Esc (2025 SP2)
• Metodo Defeature silhouette per le parti
• Ripetizione della geometria di riferimento
• Conversione BREP mesh in BREP standard
• Miglioramenti a Segmenta mesh
• Funzioni Sposta/Copia corpo
• Raccordi a dimensione variabile
• Curva attraverso punti XYZ

Mantenimento delle opzioni di schizzo della Creazione guidata fori (2025
SP3)

Per le funzioni di Creazione guidata fori, il software mantiene le impostazioni delle Opzioni
di schizzo per i nuovi fori, le nuove parti o le nuove sessioni di SOLIDWORKS.

97



Nella scheda Posizioni della Creazione guidata fori, questa funzionalità si applica alle
opzioni Crea istanze su geometria di schizzo e Crea istanze su geometria di
costruzione.

Per impostazione predefinita, queste impostazioni di Opzioni di schizzo sono
deselezionate.

Fissare il PropertyManager del raccordo o dello smusso (2025 SP2)

È possibile fissare il PropertyManager del Raccordo o dello Smusso.

Vantaggi: È possibile applicare in sequenza raccordi o smussi multipli con parametri
uguali o diversi a corpi diversi senza dover riaprire ogni volta il PropertyManager. Le
funzioni di raccordo o smusso possono anche essere di tipo diverso.

Disponibilità puntina
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InformazioniFunzione

• Disponibile solo per la modalità
Manuale.

• Disponibile per questi raccordi:

• Dimensione costante

• Faccia

• Arrotondamento completo

Durante una sessione, il software mantiene
le impostazioni in Elementi da raccordare,
Parametri di raccordo e Opzioni di
raccordo.

La puntina non è disponibile quando si
modifica un raccordo esistente.

Puntina raccordo

• Disponibile per tutti e cinque i tipi di
smusso.

• Durante una sessione, il software
mantiene le impostazioni in Elementi da
smussare, Parametri di smusso e
Opzioni di smusso.

Puntina smusso
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Uscita dai processi delle parti con il tasto Esc (2025 SP2)

Per uscire immediatamente da lunghi processi delle parti, premere il tasto Esc per
annullare il comando in corso e riportare il modello allo stato precedente. Ciò si applica
ai comandi di parte Associa, Interseca e Shell.

Vantaggi: Consente di uscire dai processi che possono richiedere molto tempo per il
completamento o che sono stati avviati per errore.

I messaggi della barra di stato durante un'anteprima o un'operazione principale avvisano
che questa funzionalità è disponibile: Premere <ESC> per annullare l'anteprima,
oppure Premere <ESC> per annullare il comando
<Combina/Interseca/Svuotamento>.

Premere il tasto Esc durante questi comandi per uscire dai processi descritti.

Azioni del PropertyManager da cui è
possibile uscire

Comando

• Fare clic su Mostra Anteprima con
l'operazione Aggiungi, Sottrai o
Associa.

• Fare clic su per avviare l'esecuzione
del comando.

Associa

• Fare clic su Intersecare.

• Fare clic su per avviare l'esecuzione
del comando.

Interseca
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Azioni del PropertyManager da cui è
possibile uscire

Comando

• Fare clic su Mostra anteprima quando
si seleziona una faccia o un corpo solido.

• Fare clic su per avviare l'esecuzione
del comando.

• Fare clic su Mostra anteprima, quindi
effettuare una delle seguenti operazioni:

• In Parametri, effettuare una delle
seguenti operazioni:

• Modificare lo Spessore della shell

.
• Selezionare una faccia.
• Selezionare un corpo solido.
• Selezionare Svuota verso

l'esterno.

• In Impostazioni con
multispessore, modificare il valore

Multispessore o selezionare una
faccia.

Shell

Il software torna allo stato del PropertyManager prima di fare clic su OK e ricorda tutte
le impostazioni.

Metodo Defeature silhouette per le parti
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Per le parti a corpo singolo e multicorpo, è possibile utilizzare il metodo Defeature
silhouette per creare una parte altamente semplificata e renderla associativa alla parte
padre.

Nelle versioni precedenti, il metodo Defeature silhouette era disponibile solo per gli assiemi.
È possibile definire gruppi di corpi e definire un metodo di semplificazione per questi
gruppi.

I metodi di semplificazione comprendono:

• Rettangolo di selezione
• Cilindro
• Contorno poligono
• Contorno misura automatica
• Nessuno (copia geometria)

È possibile mantenere un collegamento al modello originale in modo che, se si aggiorna
l'originale, il modello sottoposto a defeature venga aggiornato. Nella scheda del
PropertyManager Risultati, quando si seleziona Crea una nuova configurazione, nel
ConfigurationManager, è possibile fare clic con il pulsante destro del mouse sulla
configurazione di defeature e selezionare Modifica defeature o Aggiorna defeature.

Per accedere al metodo Defeature silhouette, in una parte, fare clic su Strumenti >

Defeature e in Metodo defeature, fare clic su Silhouette .

Fare clic su o per esplorare le modalità e finalizzare il processo di defeature.

Ripetizione della geometria di riferimento

È possibile creare ripetizioni lineari o circolari di piani e assi.
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Per ripetere la geometria di riferimento:

1. Aprire una parte, fare clic su Inserisci > Ripetizione/Specchiatura, e selezionare
Ripetizione lineare o Ripetizione circolare.

2. Nel PropertyManager, selezionare Geometria di riferimento.

3. Per Piano di riferimento o asse di riferimento per creare la ripetizione ,
selezionare il piano o l'asse da ripetere.

4. Specificare i parametri, quindi fare clic su .

È possibile modificare i parametri di spaziatura e istanza per Direzione 1 e Direzione
2. È possibile saltare, variare ed eliminare le istanze.

Limitazioni:

• Se un piano contiene uno schizzo, la ripetizione del piano non esegue la ripetizione
dello schizzo.

• Una ripetizione può contenere una sola entità di geometria di riferimento, un piano
o un asse.

Conversione BREP mesh in BREP standard

Il comando Converti mesh in standard può essere utilizzato per convertire le facce
BREP mesh con geometria riconosciuta in facce BREP standard.

Questa funzionalità funziona per i corpi mesh BREP o ibridi con geometria riconosciuta.
La funzionalità opera meglio in mesh con geometria planare, cilindrica, conica e sferica
ben definita che non presentano rumore significativo.

Vantaggi: La geometria BREP standard è più completa dal punto di vista funzionale
rispetto alla mesh o alla geometria ibrida.
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Per convertire il BREP mesh con facce riconosciute in BREP standard:

1. Aprire un modello con corpi mesh BREP o mesh ibridi con facce segmentate e
riconosciute.

Questo modello con mesh è stato segmentato in facce cilindriche, sferiche e planari.

2. Scegliere una delle seguenti opzioni:

• Fare clic con il pulsante destro del mouse su un corpo e selezionare Converti

mesh in standard .

• Fare clic su Inserisci > Mesh > Converti mesh in standard .

• Fare clic su Converti mesh in Standard (CommandManager Modellazione
mesh).

3. Nel PropertyManager, in Seleziona corpo, selezionare i corpi per convertire le facce
BREP della mesh segmentate e riconosciute in facce BREP standard.

I colori indicano le facce riconosciute o non riconosciute. È possibile specificare i colori
di Faccia mesh riconosciuta e Faccia mesh non riconosciuta in Strumenti >
Opzioni > Opzioni del sistema > Colori > Impostazioni schema di colore.

Questo intero modello è riconosciuto come una funzione Converti mesh in standard,
mostrata come una Faccia mesh riconosciuta verde, come indicato nella legenda
nell'angolo inferiore destro dell'area grafica.
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4. Fare clic su per convertire le facce BREP della mesh segmentate riconosciute in
facce BREP standard.

Le facce BREP standard convertite vengono visualizzate nell'albero di disegno

FeatureManager® con il nome e l'icona Converti in BREP standard .
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Miglioramenti a Segmenta mesh

Lo strumento Segmenta mesh riconosce altri tipi di facce e ha un'interfaccia utente
migliorata.

Tipi di facce aggiuntive riconosciute

Quando si segmentano le mesh, il software è in grado di riconoscere le facce coniche o
sferiche, oltre ai piani e ai cilindri. Queste facce riconosciute possono essere convertite
in facce BREP standard con la stessa condizione geometrica.

Interfaccia utente migliorata

Nel PropertyManager Segmenta mesh, in Segmentazione, è disponibile lo strumento

Forma sfaccettature . Questo strumento crea segmenti raggruppando le facce
adiacenti in base alla differenza di forma, che in genere indica un contorno tra due regioni
nel modello utilizzato per creare il file di mesh.

In Opzioni, selezionare Mostra anteprima per visualizzare in anteprima i bordi delle
facce segmentate, mostrate in giallo. In Perimetro, trascinare per regolare il valore e
rifinire la segmentazione delle facce.
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Quando si esegue lo strumento Segmenta corpo mesh importato, le informazioni
grafiche migliorate consentono di capire quali facce sono state riconosciute.

Se il modello non è stato precedentemente segmentato, la visualizzazione dei corpi BREP
della mesh e dei corpi mesh ibridi non cambia.

• BREP standard e i corpi grafici sono opzionalmente nascosti.
• Le facce selezionate vengono evidenziate utilizzando il colore dell'elemento

selezionato 1 specificato in Strumenti > Opzioni > Opzioni del sistema > Colori
> Impostazioni schema di colore.

Dopo il primo ciclo di segmentazione del modello, vengono applicate le seguenti modifiche
di visualizzazione:

• Viene visualizzata una legenda che spiega i colori utilizzati per le facce riconosciute e
non riconosciute.

• Il software utilizza i colori di Faccia mesh riconosciuta e Faccia mesh non
riconosciuta specificati in Strumenti > Opzioni > Opzioni del sistema > Colori
> Imposizioni schema di colore.

Funzioni Sposta/Copia corpo

La funzione Sposta/copia corpo offre un supporto avanzato per le equazioni e le
configurazioni.

Nel PropertyManager Sposta/Copia corpo, è possibile usare le equazioni per specificare i

valori per la quota Distanza in Trasla e per la quota Angolo in Ruota. Nel
PropertyManager, immettere = e l'equazione. Ad esempio, immettere =20+50. Per accedere
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a questa equazione nella finestra Equazioni, variabili globali e quote, nell'albero di disegno
FeatureManager, fare clic con il pulsante destro del mouse su Equazioni e selezionare
Gestisci equazioni.

Le icone delle quote Distanza e Angolo sono sostituite da queste icone e .

Per invertire le quote lungo l'entità selezionata, in Trasla, fare clic su Distanza o in

Ruota, fare clic su Angolo .

È possibile utilizzare le configurazioni per specificare i valori di tutte le quote, inclusi questi

valori basati su equazioni. Questa configurazione , Tutte le configurazioni e

Specifica configurazioni .

Raccordi a dimensione variabile

Per i raccordi a dimensione variabile, è possibile creare raccordi continuamente miscelati
con l'opzione Blend continuo dei bordi.

Per accedere a questa opzione, nel PropertyManager Raccordo, per Tipo di raccordo,

selezionare Raccordo a dimensione variabile e in Opzioni raccordo, selezionare
Blend continuo dei bordi.
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Questa opzione utilizza un algoritmo migliorato per creare bordi con fusione continua
estremamente uniformi.

Curva attraverso punti XYZ

La funzionalità Inserisci > Curva > Curva attraverso punti XYZ utilizza un
PropertyManager in cui è possibile selezionare un sistema di coordinate diverso. I punti
della curva si trasformano nello spazio del sistema di coordinate.

Nelle versioni precedenti, questa funzionalità utilizzava una finestra di dialogo e utilizzava
solo l'origine della parte per la curva.

Nel PropertyManager, è possibile:

• Immettere manualmente i dati delle coordinate XYZ.
• Fare clic su Sfoglia per selezionare un file .sldcrv o .txt.
• Fare clic su Ricarica per aggiornare la curva in base alle modifiche apportate al file

.sldcrv o .txt utilizzato per crearla.

Quando si aprono i file creati prima di SOLIDWORKS 2025 e si modificano le curve create
dai punti XYZ, nel PropertyManager, in Sistema di coordinate di riferimento, il software

utilizza l'origine per il Sistema di coordinate (origine) .
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9
Lamiera

Questo capitolo comprende i seguenti argomenti:

• Intagli piegatura
• Linguetta e asola
• Flange del bordo con più lunghezze e quote automatiche della lunghezza della

flangia
• Miglioramenti delle prestazioni nelle funzioni di filettatura cosmetica
• Miglioramenti delle prestazioni nella ricostruzione disegni

Intagli piegatura

È possibile creare intagli tra le piegature nelle parti in lamiera appiattite. In fase di
produzione, gli intagli di piegatura aiutano i produttori a determinare dove posizionare
la pressa piegatrice. È possibile utilizzare le funzioni di intaglio su tutte le piegature in
modo che l'operatore di piegatura possa utilizzarle per allineare la piegatura con l'utensile.

Creazione intagli di piegatura

È possibile creare intagli di piegatura sulle parti in lamiera nello stato appiattito.
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Per creare intagli di piegatura:

1. In una parte in lamiera appiattita, fare clic su Intaglio piegatura (barra degli
strumenti Lamiera) o su Inserisci > Lamiera > Intaglio piegatura.

2. Nell'area grafica, selezionare le piegature su cui si desidera aggiungere gli intagli.

3. Nel PropertyManager, specificare le opzioni e fare clic su .

Gli intagli appaiono nella parte di lamiera appiattita. Gli intagli possono essere
modificati solo quando la parte è appiattita.

PiegatoAppiattito

PropertyManager Intaglio piegatura

Per aprire questo PropertyManager:

1. In una parte in lamiera appiattita, fare clic su Intaglio piegatura (barra degli
strumenti Lamiera) o su Inserisci > Lamiera > Intaglio piegatura.
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Intaglio piegatura

Elenca le piegature a cui applicare gli intagli.Piegature

Seleziona tutte le piegature nella parte a cui applicare gli intagli.Raccogli tutte le
piegature

Specifica la forma dell'intaglio:

• Triangolare. Specificare la Larghezza e la Profondità

.

• Circolare. Specificare il Raggio .

• Rettangolare. Specificare la Larghezza e la Profondità

.

Tipo di intaglio
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Linguetta e asola

Il flusso di lavoro per la creazione delle funzioni linguetta e asola è semplificato e offre
una maggiore flessibilità. Le opzioni aggiuntive consentono di creare linguette allineate
al centro, linguette di offset con incrementi uguali, direzioni delle linguette e istanze delle
funzioni linguetta e asola da saltare.

Dopo aver selezionato il bordo della linguetta in una parte in lamiera, SOLIDWORKS®

seleziona automaticamente una faccia dell'asola normale al bordo per semplificare il
processo. Per le parti non in lamiera, è necessario selezionare la faccia dell'asola.

Se si hanno regioni non intersecanti di due corpi, la funzione Linguetta e asola si applica
solo alle regioni intersecanti.

PropertyManager Linguetta e asola

Spaziatura

Posiziona le linguette dal centro del bordo intersecante.

Specificare il Numero di istanze e la Spaziatura
per definire il numero di istanze in base alla distanza.

Allinea al
centro

Offset

Specifica il punto, il vertice o il bordo in cui inizia l'offset.Riferimento
iniziale linguetta
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Specifica il punto, il vertice o il bordo in cui termina l'offset.Riferimento finale
linguetta

Crea un offset in cui la distanza iniziale e finale è la stessa
dai punti di riferimento.

Offset equo

Schede

(solo per parti non di lamiera.) Crea la linguetta in una
direzione diversa da quella normale alla faccia della
linguetta in base alla selezione effettuata nell'area grafica.
È possibile selezionare punti, piani, bordi, assi, vertici,
entità di schizzo lineari o facce planari.

Direzione
linguetta

Istanze da saltare

Salta le istanze di linguetta e asola selezionate nell'area
grafica.
Nell'area grafica, le sfere di selezione rosa vengono
visualizzate nelle istanze di linguetta e asola. Il cursore

assume l'aspetto quando si passa il mouse su ogni
istanza e vengono visualizzate le coordinate dell'istanza.
Fare clic su una sfera di selezione.

Per ripristinare un'istanza saltata, fare nuovamente clic
sulla sfera di selezione.

Istanze da
saltare
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Flange del bordo con più lunghezze e quote automatiche della lunghezza
della flangia

Quando si creano flange del bordo nelle parti in lamiera, è possibile creare flange con
lunghezze diverse.

Nel PropertyManager, è possibile selezionare Flangia con più lunghezze e specificare

la lunghezza di ciascuna flangia nella funzione. È possibile specificare la Lunghezza
nel PropertyManager o nell'area grafica.

In Strumenti > Opzioni > Proprietà del documento > Lamiera, in Opzioni flangia
del bordo, è possibile selezionare Aggiungi automaticamente le dimensioni per la
lunghezza della flangia ai relativi profili.
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Quando l'opzione è selezionata:

• SOLIDWORKS aggiunge automaticamente le quote della lunghezza a tutti i profili di
flangia del bordo

• La quota di schizzo (non la quota della funzione) controlla la lunghezza della flangia

Miglioramenti delle prestazioni nelle funzioni di filettatura cosmetica
Quando si attiva l'opzione Filettature cosmetiche ombreggiate, è possibile migliorare
le prestazioni mentre si utilizzano parti multicorpo con numerose funzioni di filettatura
cosmetica.

Per le parti in lamiera con più funzioni di filettatura cosmetica, le prestazioni sono
migliorate per queste operazioni:

• Apertura delle parti
• Creazione di nuove funzioni
• Modifica funzioni
• Aggiornamento e ricostruzione delle parti

Miglioramenti delle prestazioni nella ricostruzione disegni
Le prestazioni sono migliorate quando si utilizzano disegni che contengono viste di disegno
di parti in lamiera con molti fori e strumenti di formatura.

Quando si utilizzano tali disegni, è possibile ottenere prestazioni migliori per:

• Apertura dei file di disegno
• Creazione di nuovi disegni dalla parte in lamiera
• Aggiornamento delle viste di disegno dopo aver apportato modifiche alla parte in
lamiera
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10
Sistema struttura e saldature

Questo capitolo comprende i seguenti argomenti:

• Raggruppamento di profili e quantità di saldatura (2025 SP3)
• Applicazione delle unità del documento agli ID della distinta di taglio (2025 SP2)
• Selezione di una dimensione del profilo dalle tabelle dati e dalle tabelle di

configurazione (2025 SP2)
• Pubblicazione di elementi della distinta di taglio su 3DEXPERIENCE platform (2025

SP1)
• Accesso e utilizzo dei profili preferiti
• PropertyManager Angolo complesso e sistema di struttura
• Accorciatura elemento strutturale collegato
• Cordoni con raccordo

Raggruppamento di profili e quantità di saldatura (2025 SP3)

Nel PropertyManager della Distinta materiali (BOM) è possibile raggruppare i profili e le
quantità di saldatura in una distinta di taglio dettagliata in modo più efficiente.

Per raggruppare i profili e le quantità di saldatura:
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1. In un disegno di un sistema di saldatura o di una struttura, fare clic su Distinta

materiali (barra degli strumenti Tabella) o su Inserisci > Tabelle > Distinta
dei materiali.

2. Nel PropertyManager della Distinta materiali, alla voce Tipo di distinta materiali:

a. Selezionare Con rientro.
b. Selezionare Distinta di taglio dettagliata.
c. Fare clic su Raggruppamento di saldature.

3. Nella finestra di dialogo Raggruppamento saldature, selezionare gli elementi da
raggruppare:

• Profilo. Definisce i membri strutturali di un modello di saldatura. È la forma della
sezione trasversale di un elemento strutturale, come una trave o un tubo.

• Unità di misura. Specifica le unità di misura delle parti nella distinta materiali.
• Materiale. Riconosce i materiali quando determina se i corpi sono identici,
raggruppando corpi geometricamente identici con materiali diversi in cartelle
separate all'interno della distinta di taglio.

• Angolo1. Specifica la faccia finale più vicina al profilo di schizzo.
• Angolo2. Specifica la faccia terminale opposta all'Angolo1.
• Descrizione. Fornisce dettagli su ciascun articolo della distinta di taglio, come il
tipo di materiale e la finitura.

4. Fare clic su OK.

5. Fare clic su .

Applicazione delle unità del documento agli ID della distinta di taglio (2025
SP2)

È possibile selezionare Applica impostazioni unità del documento agli ID della
distinta di taglio per applicare le unità del documento agli ID della distinta di taglio.
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Quando si seleziona questa opzione, le unità degli ID della distinta di taglio sono le stesse
delle unità del documento. In precedenza, gli ID della distinta di taglio erano in unità MKS
indipendentemente dalle unità del documento.

Fare clic su Strumenti > Opzioni > Proprietà del documento > Saldature e
selezionare Applica impostazioni unità del documento agli ID della distinta di
taglio.

Questa opzione è disponibile solo se si seleziona Genera ID distinta di taglio.

È possibile selezionare questa opzione anche per i file legacy. Le unità degli ID della
distinta di taglio cambiano con le modifiche nelle unità del documento.

Selezione di una dimensione del profilo dalle tabelle dati e dalle tabelle di
configurazione (2025 SP2)

Per le saldature e i sistemi struttura, è possibile selezionare la dimensione del profilo dalle
tabelle dati e dalle tabelle di configurazione.

Per i profili configurati, la tabella dati e la tabella di configurazione mostrano la colonna
Dimensione profilo, in cui è possibile selezionare una dimensione.

Per controllare le dimensioni del profilo nelle tabelle dati, l'intestazione della colonna
utilizza la seguente sintassi:

• Saldature: $PROFILE_SIZE@feature_name
• Sistemi struttura: $PROFILE_SIZE@member_name

Per inserire una tabella dati:

1. Aprire una parte con configurazioni multiple.

2. Fare clic su Tabella dati Excel (barra degli strumenti Strumenti) o su Inserisci
> Tabelle > Tabella dati Excel.

È anche possibile selezionare la dimensione del profilo modificando una tabella dati.
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Per accedere a una tabella di configurazione:

1. In una parte con configurazioni multiple, fare clic sulla scheda ConfigurationManager
.

2. Espandere Tabelle .

3. Fare clic con il pulsante destro del mouse su Tabella di configurazione e fare
clic su Mostra tabella.

Pubblicazione di elementi della distinta di taglio su 3DEXPERIENCE platform
(2025 SP1)

È possibile pubblicare gli elementi della distinta di taglio di una parte di saldatura su
3DEXPERIENCE platform.

Per pubblicare gli elementi della distinta di taglio, salvare la parte SOLIDWORKS come
parte di saldatura su 3DEXPERIENCE platform. Il pannello laterale visualizza l'estensione
della parte di saldatura come SW Weldment Part.

Prerequisiti per poter salvare la parte SOLIDWORKS come una parte di saldatura:

• Non è necessario che la parte sia già stata salvata su 3DEXPERIENCE platform.
• La parte deve contenere una funzione di saldatura.
• La parte deve essere contrassegnata come un singolo prodotto fisico.

Prerequisiti per la pubblicazione di elementi della distinta di taglio su 3DEXPERIENCE
platform:

• La parte deve essere una parte di saldatura.
• La distinta di taglio deve essere aggiornata.
• La proprietà degli elementi della distinta di taglio deve avere l'ID distinta di taglio.
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Per pubblicare elementi della distinta di taglio su 3DEXPERIENCE platform:

1. Con una parte di saldatura aperta, fare clic su Opzioni (barra degli strumenti
Standard), selezionare la scheda Proprietà del documento, quindi Saldature.

2. Nella finestra di dialogo Proprietà del documento - Saldature, in corrispondenza di
ID distinta di taglio, selezionare Genera ID distinta di taglio e fare clic su OK.

3. Nel Task Pane 3DEXPERIENCE, fare clic col pulsante destro sulla parte e selezionare
Salva.

4. Nella finestra di dialogo Salva in 3DEXPERIENCE, selezionare Pubblica elementi
della distinta di taglio e fare clic su Salva.

MySession visualizza gli elementi della distinta di taglio della parte di saldatura. Il pannello
laterale mostra le proprietà degli elementi della distinta di taglio.

Gli amministratori possono definire attributi PLM personalizzati e mappare tra elementi
CAD ed elementi PLM per salvare gli attributi sulla 3DEXPERIENCE platform.

Accesso e utilizzo dei profili preferiti

È possibile aggiungere profili preferiti nei PropertyManager Membro strutturale principale
e Membro strutturale secondario per un accesso rapido.

Per accedere e utilizzare i profili preferiti:

1. Aprire una parte del sistema di struttura e fare clic sulla scheda Sistema di struttura.
2. Nel CommandManager, fare clic su Crea sistema struttura.
3. Nel PropertyManager Membro strutturale principale, nella scheda Profilo, selezionare

lo Standard, il Tipo e la Dimensione del profilo.

4. Fare clic su Aggiungi ai preferiti per aggiungere il profilo come profilo preferito.

come suffisso della dimensione indica un profilo preferito.

5. Nella scheda Membro, in Profilo, selezionare il profilo in Profili preferiti.
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6. Fare clic su per modificare l'elenco dei profili preferiti.
7. Nella finestra di dialogo Elenco profili preferiti, selezionare un profilo e fare clic su

quanto segue:

• OK. Accetta le eventuali modifiche.
• Elimina. Elimina il profilo selezionato.
• Sposta in alto o Sposta in basso. Modifica la sequenza dei profili nell'elenco.

PropertyManager Angolo complesso e sistema di struttura
Il PropertyManager Angolo complesso fornisce opzioni avanzate di trattamento dello
spigolo. Inoltre, è possibile creare e modificare più facilmente il sistema di strutture.

PropertyManager degli angoli complessi

Per aprire questo PropertyManager:

1. Aprire un modello che include tre o più membri intersecanti.

2. Nell'albero di disegno FeatureManager®, espandere Gestione spigoli .
3. Fare clic con il pulsante destro del mouse su Gruppo spigoli complessi e selezionare

Modifica feature.

I miglioramenti comprendono:

• In Trattamento dello spigolo, la casella dei membri visualizza gli elementi di
accorciatura corpo e gli elementi di accorciatura planari. È possibile selezionare un
membro e fare clic su Accorciamento corpo o Accorciamento planare per
modificarne il tipo di accorciamento.

• I dettagli del membro selezionato, come accorciamento del corpo, accorciamento
planare e ordine di accorciamento, vengono visualizzati come didascalie nell'area
grafica.
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• Le icone rappresentano le opzioni di accorciamento planare.

Accesso al sistema struttura
I miglioramenti comprendono:

• Quando si apre un modello di sistema di struttura, SOLIDWORKS visualizza un
messaggio per attivare la scheda Sistema struttura.

• Per i nuovi file, il CommandManager visualizza Crea sistema struttura. Quando si
fa clic su Crea sistema di struttura, SOLIDWORKS visualizza il PropertyManager
Membro principale.

• Per i file che includono un sistema di struttura, il CommandManager visualizzaModifica
sistema struttura.

• Per i file che includono più sistemi di struttura, è necessario selezionare il sistema di
struttura da modificare dall'albero di disegno FeatureManager.

Accorciatura elemento strutturale collegato

È possibile accorciare un elemento strutturale collegato quando si inserisce un elemento
di connessione.

Nel PropertyManager Inserisci elemento di connessione, Accorcia elemento strutturale
collegato accorcia l'elemento del corpo dal suo punto di intersezione con l'elemento di
connessione.

Per accorciare un elemento strutturale collegato:

1. Aprire un modello del sistema di struttura e fare clic sulla scheda Sistema di struttura.
2. Fare clic sulla scheda Inserisci elemento di connessione nel CommandManager

o Inserisci > Sistema struttura > Inserisci elemento di connessione.
3. Seleziona l'elemento di connessione da inserire.
4. Nel PropertyManager, fare clic sulla scheda Posizionamento.
5. Selezionare le entità di riferimento nell'area grafica.
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6. Selezionare l'allineamento.
7. In Ambito di taglio, selezionare Accorcia elemento strutturale collegato.
8. Fare clic su .

Accorcia elemento strutturale collegato
cancellato

Accorcia elemento strutturale collegato
selezionato

Cordoni con raccordo

È possibile creare un cordone con raccordo per unire con una saldatura solida due superfici
selezionate. SOLIDWORKS® crea un corpo solido nel gioco in base alle superfici.
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Creazione di cordoni con raccordo

È possibile creare cordoni con raccordo tra le due superfici.

Per creare cordoni con raccordo:

1. Aprire una parte con corpi solidi da unire.
2. Fare clic su Inserisci > Saldature > Cordone con raccordo.
3. Nell'area grafica, selezionare le facce da unire.
4. Specificare le opzioni nel PropertyManager e fare clic su .

PropertyManager Cordone con raccordo

Il PropertyManager Cordone con raccordo consente di creare una saldatura solida tra due
corpi solidi.

Per aprire questo PropertyManager:

1. Aprire una parte multicorpo e fare clic su Inserisci > Saldature > Cordone con
raccordo.

Selezioni faccia
Gruppo facce 1 e Gruppo facce 2. Specifica le facce dei corpi solidi da connettere
dall'area grafica.

Saldatura intera faccia
Crea una saldatura sull'intera superficie. In caso contrario, crea una saldatura sulla
superficie in cui una superficie si proietta su un'altra.

Saldatura intera faccia cancellataSaldatura intera faccia selezionata

Riempimento radiale
Crea una saldatura sulla superficie, compresa la distanza di riempimento radiale.
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Riempimento radiale cancellatoRiempimento radiale selezionato

Definisci simbolo di saldatura
Apre la finestra Simbolo di saldatura in modo da definire le impostazioni del simbolo di
saldatura. Il simbolo di saldatura è allegato al cordone di saldatura attivo.

Vedere Proprietà del simbolo di saldatura.
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11
Assiemi

Questo capitolo comprende i seguenti argomenti:

• SmartMates con riconoscimento AI degli elementi di fissaggio (2025 SP3)
• Avviso durante l'aggiornamento dei riferimenti esterni nelle funzioni congelate

(2025 SP3)
• Opzione per la risoluzione automatica di componenti leggeri (2025 SP2)
• Mantenimento dei riferimenti esterni agli schizzi derivati (2025 SP1)
• Avviso durante lo spostamento dei componenti (2025 SP1)
• Annullamento dei calcoli di rilevamento delle interferenze (2025 SP1)
• Visualizzazione assieme
• Istanze SpeedPak
• Rilevamento delle interferenze in modalità Revisione grandi progetti
• Valutazione prestazioni
• Collegamento dello stato di visualizzazione al componente di serie ripetuto
• Inserimento di assiemi con funzioni con ripristino
• Copia con accoppiamenti
• Prestazioni durante il calcolo delle proprietà di massa
• Controllo della visibilità degli schizzi della parte negli assiemi
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SmartMates con riconoscimento AI degli elementi di fissaggio (2025 SP3)

Quando si inseriscono i componenti negli assiemi, SOLIDWORKS riconosce i componenti
che appaiono come dadi, bulloni o rondelle per aggiungere automaticamente gli
accoppiamenti ai componenti.

SOLIDWORKS utilizza l'intelligenza artificiale per riconoscere gli elementi di fissaggio. Il
riconoscimento automatico è limitato a:

• Elementi di fissaggio con immagini di anteprima
• Elementi di fissaggio a corpo singolo che sono parti SOLIDWORKS
• Componenti da accoppiare che non superano del 20% il diametro della geometria
• Elementi di fissaggio che non hanno riferimenti di accoppiamento e non sono parti di
Toolbox

Se non si desidera utilizzare il riconoscimento automatico, premere ALTmentre si trascina
un componente nell'assieme.

Per utilizzare SmartMates con il riconoscimento AI degli elementi di fissaggio:

1. Da una delle seguenti fonti, trascinare un elemento di fissaggio (dado, bullone o
rondella) su un componente dell'assemblaggio da accoppiare:

• Albero di disegno FeatureManager® (CTRL+trascinamento se il componente si
trova nello stesso assieme)

• Inserisci componenti (barra degli strumenti Assieme)

• Task Pane (come la Libreria di progettazione o Esplora file )

Il puntatore assumerà questo aspetto .
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2. Rilasciare l'elemento di fissaggio sul componente da accoppiare quando il puntatore

diventa .

Avviso durante l'aggiornamento dei riferimenti esterni nelle funzioni congelate
(2025 SP3)

Quando si aggiorna un modello con funzioni congelate con riferimenti esterni e i riferimenti
esterni non sono aggiornati, SOLIDWORKS visualizza un messaggio di avviso.

I riferimenti esterni nelle funzioni congelate non possono essere aggiornati durante una
ricostruzione. Di conseguenza, il modello potrebbe essere contrassegnato come non
aggiornato quando i riferimenti esterni non vengono aggiornati.

Nel messaggio, è possibile bloccare i riferimenti esterni o bloccare temporaneamente i
riferimenti esterni per la sessione corrente. SOLIDWORKS non aggiorna i riferimenti
esterni bloccati e il modello non viene contrassegnato come non aggiornato.

Opzione per la risoluzione automatica di componenti leggeri (2025 SP2)

È possibile selezionare Risolvi automaticamente i componenti leggeri durante
l'espansione nell'albero FeatureManager per risolvere i componenti leggeri espansi
nell'albero di disegno FeatureManager.
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Quando si deseleziona questa opzione, i componenti espansi rimangono in modalità peso
leggero.

È possibile applicare questa opzione quando è selezionato Gestisci manualmente le
modalità Risolto e Peso leggero.

Per risolvere automaticamente i componenti a peso leggero:

1. Fare clic su Opzioni > Opzioni del sistema > FeatureManager.
2. Selezionare Risolvi automaticamente i componenti leggeri durante l'espansione

nell'albero FeatureManager.
3. Aprire un modello in modalità peso leggero.

Se la modalità peso leggero non è disponibile, fare clic su Opzioni > Opzioni del
sistema > Prestazioni e selezionare Gestisci manualmente le modalità Risolto
e Peso leggero.

4. Espandere un componente.

Il componente espanso si risolve nell'albero di disegno FeatureManager.

Mantenimento dei riferimenti esterni agli schizzi derivati (2025 SP1)

Quando si utilizza Salva come copia e continua per copiare una parte, vengono
mantenuti i riferimenti esterni a uno schizzo derivato nella parte copiata.

I riferimenti esterni vengono mantenuti quando si utilizza Esplora file di Microsoft® per
copiare una parte con uno schizzo derivato.

Per mantenere i riferimenti esterni agli schizzi derivati:

1. Aprire un modello contenente due parti.

In questo esempio, la Parte 1 viene visualizzata nell'area grafica.
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2. Creare uno schizzo derivato.

a. Fare clic con il pulsante destro del mouse su Parte 2 e fare clic su Modifica parte

.
b. Premere il tasto Ctrl e selezionare uno schizzo dalla Parte 1 e un piano dalla Parte

2.

c. Fare clic su Inserisci > Schizzo derivato.
d. Uscire dalla modalità di modifica nel contesto facendo clic sull'angolo di conferma.
e. Fare clic su File > Salva tutto.

La Parte 2 ha uno schizzo derivato dalla Parte 1.

3. Creare una copia della parte con lo schizzo derivato.

a. Fare clic con il pulsante destro del mouse su Parte 2 e fare clic su Modifica parte

.
b. Fare clic su File > Salva con nome > Salva come copia e continua.
c. Salvare la nuova parte come Parte 3.
d. Uscire dalla modalità di modifica nel contesto.
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4. Inserire la nuova parte nel modello.

a. Fare clic su Inserisci > Componente > Parte/Assieme esistente.
b. Nella finestra di dialogo, selezionare Parte 3 e aggiungere la parte.

La Parte 2 e la Parte 3 hanno lo schizzo derivato.

5. Aggiornare la prima parte.

a. Per la Parte 1, fare clic con il pulsante destro del mouse sullo schizzo e fare clic

su Modifica schizzo .
b. Modificare una quota.

Una quota nella Parte 1 è stata modificata da 200 mm a 170 mm.

c. Uscire dalla modalità di modifica nel contesto.

La Parte 3 utilizza la quota aggiornata e lo schizzo derivato rimane definito.
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Avviso durante lo spostamento dei componenti (2025 SP1)

Quando un componente si sposta notevolmente da un assieme, SOLIDWORKS visualizza
un messaggio di avviso.

In alcuni casi, un trascinamento di lieve entità di un componente o la modifica delle
impostazioni di accoppiamento può causare uno spostamento notevole di un componente
rispetto all'assieme.

La distanza elevata tra il componente e l'assieme può causare problemi di rotazione della

vista e Zoom ottimizzato .

Per riportare il componente alla posizione precedente, fare clic su Annulla nella finestra

di dialogo di notifica o fare clic su Modifica > Annulla Sposta componente .
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Annullamento dei calcoli di rilevamento delle interferenze (2025 SP1)

È possibile annullare i calcoli di rilevamento delle interferenze.

Per annullare i calcoli di rilevamento delle interferenze:

1. Aprire un modello di grandi dimensioni.

2. Fare clic su Rilevamento interferenze (barra degli strumenti Assieme) o su
Strumenti > Valuta > Rilevamento interferenze.

3. Nel PropertyManager, fare clic su Calcola.
4. Fare clic su Annulla nella finestra di dialogo o premere Esc.
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Visualizzazione assieme

È possibile assegnare un colore a un valore di proprietà, selezionare nuove proprietà e
sollevare o abbassare i componenti.

Nella finestra di dialogo Personalizza colonna, è possibile selezionare Collega il colore
al valore appropriato per specificare un colore per una proprietà del componente.
Quando si seleziona questa opzione, non è possibile modificare i colori utilizzando il cursore
del colore.

Nella barra degli strumenti contestuale di un componente, è possibile utilizzare Solleva
il componente e Abbassa il componente per nascondere i componenti.

Nella finestra di dialogo Personalizza colonna sono disponibili queste proprietà:

Le proprietà di 3DEXPERIENCE sono disponibili su 3DEXPERIENCE Platform. Per queste
proprietà, Collega il colore al valore appropriato è sempre selezionato.

DescrizioneProprietà

Indica se il componente ha un componente
inviluppo.

Componente inviluppo

Indica se il componente ha sovrascritto le
proprietà di massa.

Proprietà massa sovrascritta
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DescrizioneProprietà

Riporta il formato CAD del componente.
Esempi di formati CAD:

• 3DEXPERIENCE®

• CATIAV5
• X-CAD
• SOLIDWORKS®

3DEXPERIENCE - Formato CAD

Riporta le aree di collaborazione in cui il
componente viene salvato.

3DEXPERIENCE - Area di collaborazione

Riporta se si tratta dell'ultima revisione del
componente.

3DEXPERIENCE - Ultima revisione

Riporta lo stato di blocco del componente:
• Bloccato da me
• Bloccato da un altro utente
• Non bloccato

3DEXPERIENCE - Stato di blocco

Riporta il livello di maturità della
componente:
• Congelato
• In corso
• Obsoleto
• Private
• Rilasciato

3DEXPERIENCE - Maturità

Indica se il componente è stato aggiornato
per garantire la compatibilità con
3DEXPERIENCE Platform.

3DEXPERIENCE - Aggiornato per la
compatibilità

Per collegare il colore al valore appropriato:

1. Aprire un modello che contiene componenti con proprietà di massa sovrascritte.

2. Fare clic su Visualizzazione assieme (barra degli strumenti Strumenti o scheda
Valutazione del CommandManager) o su Strumenti > Valutazione >
Visualizzazione assieme.

3. Nella scheda Visualizzazione assieme, fare clic sulla freccia a destra delle intestazioni
di colonna.
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4. Fare clic su Altro.
5. Nella finestra di dialogo Personalizza colonna, in Proprietà, selezionare una proprietà

come Proprietà di massa sovrascritte.
6. Selezionare Collega il colore al valore appropriato.
7. Fare doppio clic su Digita un nuovo valore e immettere un valore.
8. Fare clic su Modifica colore e selezionare un colore per il valore.

9. Dopo aver chiuso le finestre di dialogo, nella scheda Visualizzazione assieme, fare
clic sull'intestazione di colonna Proprietà di massa sovrascritte per ordinare la
colonna in base ai valori.
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Istanze SpeedPak

È possibile creare un'istanza SpeedPak da un sottoassieme senza modificare il sottoassieme
di riferimento. L'istanza SpeedPak viene salvata nell'assieme di livello superiore.

È possibile modificare un'istanza SpeedPak facendo clic con il pulsante destro del mouse
sull'istanza e facendo clic su Opzioni SpeedPak > Modifica SpeedPak.

Inserimento di un'istanza SpeedPak

È possibile creare un'istanza SpeedPak aggiungendo un assieme al modello.

Per inserire un'istanza SpeedPak:

1. Aprire un modello e fare clic su Inserisci > Componente > Inserisci istanza

SpeedPak .

Inserisci istanza SpeedPak non è disponibile in modalità Revisione grandi progetti.

2. Nel PropertyManager, selezionare un assieme da inserire e specificare le opzioni.

3. Fare clic su Avanti per aprire il PropertyManager SpeedPak e specificare le opzioni
SpeedPak.

L'istanza SpeedPak viene visualizzata nell'albero di disegno FeatureManager®.

Creazione di un'istanza SpeedPak

È possibile creare un'istanza SpeedPak da un sottoassieme che si trova nel modello.

Per creare un'istanza SpeedPak:

1. Aprire un modello con un sottoassieme.
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2. Fare clic con il pulsante destro del mouse su un sottoassieme e fare clic su Opzioni
SpeedPak.

3. Selezionare un'opzione: Crea SpeedPak accoppiato o Crea SpeedPak grafico.
4. Quando richiesto, selezionare Crea un'istanza SpeedPak nell'assieme di livello

superiore.

L'istanza SpeedPak viene visualizzata nell'albero di disegno FeatureManager.

Passaggio da un'istanza SpeedPak a un sottoassieme padre

Per passare da un'istanza SpeedPak a un sottoassieme padre:

1. Nell'albero di disegno FeatureManager, fare clic con il pulsante destro del mouse

sull'istanza SpeedPak e fare clic su Opzioni SpeedPak > Impostare SpeedPak
su padre.

2. Richiesto: Per tornare all'istanza SpeedPak, fare clic con il pulsante destro del mouse
sul sottoassieme e fare clic su Opzioni SpeedPak > Usa SpeedPak.

Rilevamento delle interferenze in modalità Revisione grandi progetti

È possibile utilizzare il rilevamento delle interferenze sugli assiemi aperti in modalità
Revisione grandi progetti.

In modalità Revisione grandi progetti, il volume delle interferenze non è disponibile e
i calcoli per il rilevamento delle interferenze sono approssimativi. Per risultati accurati,
risolvere i componenti e ricalcolare le interferenze.

Per utilizzare il rilevamento delle interferenze in modalità Revisione grandi
progetti:

1. Aprire un assieme in modalità Revisione grandi progetti.
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2. Fare clic su Rilevamento interferenze (scheda Revisione grandi progetti) o su
Strumenti > Valuta > Rilevamento interferenze.

3. Selezionare le opzioni nel PropertyManager, quindi fare clic su Calcola.

Le opzioni seguenti non sono disponibili nel PropertyManager:

• Crea cartella fissaggi
• Crea cartella filettature cosmetiche corrispondente
• Componenti esclusi
• Nascondi componenti esclusi dalla vista
• Ignora tutti gli elementi minori di
• Ignora corpi/componenti nascosti
• Includi corpi di superficie
• Ricorda componenti esclusi
• Ordina dal più grande al più piccolo
• Ordina dal più piccolo al più grande
• Tratta coincidenze come interferenze

Valutazione prestazioni

Nella finestra di dialogo Valutazione delle prestazioni, è possibile visualizzare il numero
di documenti obsoleti, il tempo necessario per aprire l'assieme e il numero totale di
triangoli grafici.

Nuove opzioni e informazioni:
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SezioneDescrizioneOpzioni e
informazioni

Prestazioni di
apertura

In Apri sintesi, viene visualizzato il tempo
necessario per aprire l'assieme.

Tempo di apertura

Prestazioni di
apertura

Elenca il numero di documenti trovati nelle
cartelle Documenti referenziati e il tempo
impiegato per eseguire la ricerca.

Ricerca dei
documenti
referenziati

Prestazioni di
visualizzazione

In Dettagli triangoli grafici, viene visualizzato
il numero totale di triangoli grafici nell'assieme
di livello superiore.

Nel numero, SOLIDWORKS utilizza il separatore
specificato dal sistema operativo per separare
gruppi di migliaia.

Numero totale di
triangoli
nell'assieme

Prestazioni di
visualizzazione

In Qualità immagine ombreggiata, la qualità
dell'immagine ombreggiata viene ridotta al 50%
per le parti con una qualità dell'immagine
superiore.

Questa opzione non è applicabile ai sottoassiemi.

Non disponibile per gli assiemi aperti in
modalità peso leggero, tranne quando
l'assieme ha un sottoassieme flessibile.

Facendo clic su Riduci qualità immagine, il
cursore Bassa (più rapida) - Alta (più lenta)
si avvicina al lato Bassa (più rapida).

Per visualizzare il cursore, fare clic su Strumenti
> Opzioni > Proprietà del documento >
Qualità dell'immagine. Il cursore si trova in
Risoluzione ombreggiata e di qualità bozza
RLN/LNV.

Riduci qualità
immagine

Prestazioni di
ricostruzione

In Accoppiamento, viene visualizzato il tempo
necessario per risolvere gli accoppiamenti
quando si ricostruisce l'assieme.

Tempo per risolvere
gli accoppiamenti

Prestazioni di
ricostruzione

È possibile utilizzare Apri e Isola componenti
nella finestra di dialogo Accoppiamenti.

In Accoppiamenti, fare clic su Mostra questi

file per aprire la finestra di dialogo.

Apri e Isola
componenti

Prestazioni di
ricostruzione

Elenca il numero di accoppiamenti nei
sottoassiemi flessibili.

Sottoassiemi
flessibili
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SezioneDescrizioneOpzioni e
informazioni

Prestazioni di
ricostruzione

Elenca le parti che hanno più di 20 configurazioni
con il contrassegno Ricostruzione al

salvataggio .

Configurazioni con
ricostruzione al
salvataggio

StatisticheIn Assiemi, le statistiche non includono gli
accoppiamenti sospesi.

Statistiche

Per eseguire la valutazione delle prestazioni:

1. Aprire l'assieme.

2. Fare clic su Valutazione prestazioni (barra Valutazione) o Strumenti > Valuta
> Valutazione prestazioni.

Per ridurre la qualità dell'immagine:

1. Aprire un modello e fare clic su Strumenti > Opzioni > Proprietà del documento
> Qualità dell'immagine.

2. Rivedere la posizione del cursore in Risoluzione ombreggiata e di qualità bozza
RLN/LNV.

3. Fare clic su Strumenti > Valuta > Valutazione prestazioni.
4. In qualità dell'immagine ombreggiata nella sezione Prestazioni di

visualizzazione, fare clic su Riduci qualità dell'immagine .

5. Dopo l'aggiornamento dei risultati della Valutazione delle prestazioni, controllare la
posizione del dispositivo di scorrimento in Risoluzione ombreggiata e di qualità
bozza RLN/LNV.
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Collegamento dello stato di visualizzazione al componente di serie ripetuto

È possibile collegare lo stato di visualizzazione dei componenti ripetuti al componente di
serie ripetuto.

Usare le opzioni seguenti nella finestra di dialogo Proprietà del componente per selezionare
lo stato di visualizzazione:

Collega lo stato di visualizzazione dei componenti
ripetuti al componente di serie ripetuto.
Disattiva l'elenco degli stati di visualizzazione.

Usa stesso stato di visualizzazione
del componente di serie della
ripetizione

Mostra l'elenco degli stati di visualizzazione.
Questa opzione è disponibile quando il
componente ripetuto fa riferimento a una
configurazione diversa per il componente di serie
ripetuto e il tipo di visualizzazione è uno stato di
visualizzazione collegato.

Usa stato di visualizzazione con
nome

Lo stato di visualizzazione può essere collegato in qualsiasi PropertyManager Ripetizione
del componente. Nel PropertyManager, in corrispondenza di Sincronizza la
configurazione dei componenti della ripetizione a testa di serie, selezionare
Sincronizza stati di visualizzazione.

Per collegare lo stato di visualizzazione al componente della ripetizione testa di
serie:

1. Aprire un modello che contiene componenti ripetuti.
2. Nell'albero di disegno FeatureManager espandere un componente ripetuto.
3. Nel componente ripetuto espanso, fare clic con il pulsante destro del mouse su un

componente e fare clic su Proprietà del componente .
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4. Nella finestra di dialogo, selezionare Usa stesso stato di visualizzazione del
componente di serie della ripetizione.

Quando Sincronizza stati di visualizzazione è selezionato in un PropertyManager
Ripetizione del componente, Usa stesso stato di visualizzazione come
componente di serie della ripetizione è selezionato e non può essere cancellato.

Inserimento di assiemi con funzioni con ripristino

In un modello, è possibile inserire un assieme con un riferimento di parte che ha funzioni
di ripristino.

Per inserire un assieme con le funzioni di ripristino:

1. Aprire un modello e fare clic su Inserisci componenti (barra degli strumenti
Assieme) o su Inserisci > Componente > Parte/assieme esistente.

2. Selezionare un assieme che contiene una parte con funzioni di ripristino.

L'assieme viene aggiunto al modello.
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Copia con accoppiamenti

È possibile usare Copia con accoppiamenti per copiare i componenti che hanno un
accoppiamento di blocco, un accoppiamento di percorso, un accoppiamento di
accoppiamento lineare o un accoppiamento meccanico.

Per gli accoppiamenti cardine, è possibile copiare al massimo sei accoppiamenti cardine
contemporaneamente.

Per copiare con gli accoppiamenti:

1. Aprire un modello e fare clic su Copia con accoppiamenti (barra degli strumenti
Assieme) o su Inserisci > Componente > Copia con accoppiamenti.

2. Nel PropertyManager, selezionare un componente con accoppiamenti meccanici.

3. Fare clic su Avanti .

In Accoppiamenti, vengono elencati gli accoppiamenti meccanici.

Prestazioni durante il calcolo delle proprietà di massa
Le prestazioni durante il calcolo delle proprietà di massa per un assieme vengono
migliorate.
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Controllo della visibilità degli schizzi della parte negli assiemi

È possibile controllare la visibilità della parte negli assiemi.

SOLIDWORKS mantiene la visibilità degli stati di visualizzazione dello schizzo quando si
inserisce una parte in un assieme. Nelle versioni precedenti, la parte ha avuto la
precedenza sullo schizzo.

È possibile controllare la visibilità degli schizzi della parte negli assiemi:

1. Creare una parte con due schizzi.
2. Creare due stati di visualizzazione nella parte.
3. Rendere visibile lo schizzo in modo che uno schizzo sia visibile in uno stato di

visualizzazione, e l'altro sia visibile nell'altro stato di visualizzazione.
4. Inserire due istanze della parte in un assieme.
5. Rendere visibile lo schizzo in modo che ogni stato di visualizzazione della parte sia

visibile.

Ogni componente mostra la visibilità dello schizzo in base allo stato di visualizzazione
di riferimento.
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12
Disegni e dettagli

Questo capitolo comprende i seguenti argomenti:

• Occultamento o visualizzazione delle espressioni del testo di annotazione (2025
SP2)

• Inserimento delle tabelle di famiglia nei disegni (2025 SP1)
• Creazione di simboli di finitura della superficie in conformità allo standard ISO

21920 (2025 SP1)
• Collegamento delle distinte materiali agli stati di visualizzazione (2025 SP1)
• Creazione di distinte materiali appiattite (2025 SP1)
• Generare disegni automaticamente (2025 SP1)
• Tipi di tolleranza aggiuntivi per le quote di smusso
• Sovrascrivere la quantità della distinta materiali per distinte di taglio dettagliate
• Ricaricare i disegni
• Esportazione delle viste di disegno come blocchi in file DXF/DWG
• Inserimento e visualizzazione delle filettature cosmetiche nei disegni di assiemi
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Occultamento o visualizzazione delle espressioni del testo di annotazione
(2025 SP2)

È possibile nascondere o mostrare le espressioni di testo delle annotazioni sui fogli di
disegno.

Le espressioni di testo delle annotazioni sono testi segnaposto collegati a una proprietà
personalizzata. Questa opzione è un modo rapido per vedere le proprietà collegate a una
nota.

Per nascondere o mostrare le espressioni di testo dell'annotazione:

1. Fare clic su Visualizza > Nascondi/Mostra > Espressione di testo
dell'annotazione.
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Inserimento delle tabelle di famiglia nei disegni (2025 SP1)

È possibile utilizzare il comando Tabella famiglia per inserire i dati di configurazione nei
disegni.

È possibile specificare i parametri della tabella in Strumenti > Opzioni > Proprietà del
documento > Tabelle > Famiglia. È possibile specificare la posizione del modello di
tabella di famiglia in Strumenti > Opzioni > Opzioni di sistema > Posizioni dei file
> Mostra cartelle per > Modelli di tabella famiglia.

Se si fa doppio clic su una cella della tabella di famiglia per modificarla, il software chiede
di mantenere il collegamento e far sì che il modello esterno erediti le modifiche, oppure
di interrompere il collegamento per sovrascrivere il valore. È possibile ripristinare il
collegamento interrotto deselezionando la cella.

Vantaggi: È possibile inserire rapidamente i dati di configurazione nei disegni senza
dover ricorrere a soluzioni alternative. Le tabelle famiglia mostrano le variazioni nelle
configurazioni di parti e assiemi o le proprietà personalizzate in una tabella nei disegni
SOLIDWORKS.

Per inserire le tabelle famiglia nei disegni:

1. In un disegno SOLIDWORKS, fare clic su Inserisci > Tabelle > Tabella famiglia

.
2. Nel PropertyManager:

a. Selezionare il file da cui creare la tabella famiglia e fare clic su Avanti .
b. Specificare le opzioni per definire la tabella famiglia.

c. Fare clic su .

3. Fare clic nel file di disegno per posizionare la tabella.

Nel menu o nella finestra di dialogo delle colonne di dimensione per le tabelle di
famiglia, specificare Nome dimensione per il nome della colonna. Il nome è specifico
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per il disegno. Le modifiche al nome della colonna si applicano a tutte le tabelle di
famiglia del disegno che fanno riferimento alla stessa quota di guida.

4. Opzionale: Se si fa clic su Inserisci > Elementi del modello e si inseriscono gli
elementi nel disegno, viene visualizzata la notifica Nome quota tabella famiglia.
Fare clic su Imposta visualizzazione quota per visualizzare gli elementi inseriti
utilizzando il nome della quota dalla tabella di famiglia.

Per cambiare la visualizzazione degli elementi inseriti nel disegno, è possibile anche
selezionare gli elementi per aprire il PropertyManager Quota. Nella scheda Valore, in
Nome quota tabella famiglia, selezionare Visualizza come nome nella tabella
famiglia per visualizzare gli elementi utilizzando i nomi della tabella. Deselezionare
l'opzione per visualizzare gli elementi utilizzando i relativi valori.

Creazione di simboli di finitura della superficie in conformità allo standard ISO
21920 (2025 SP1)

È possibile inserire simboli di finitura della superficie conformi agli standard ISO più
recenti, tra cui ISO 21920-1, ISO 1302:202 e ISO 1302:1992.

È possibile usare i simboli seguenti.
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21920-1

1302 (2002)

1302 (1992)

Per creare simboli di finitura della superficie in conformità allo standard ISO
21920:

1. In un disegno, fare clic su Strumenti > Opzioni > Proprietà del documento >
Annotazioni > Finiture di superficie.

2. Nella finestra di dialogo Simbolo superficie standard, selezionare uno standard e fare
clic su OK.

Collegamento delle distinte materiali agli stati di visualizzazione (2025 SP1)
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Nel PropertyManager Distinta materiali (BOM), è possibile collegare una distinta materiali
agli stati di visualizzazione.

Vantaggi: Gli elementi nella distinta materiali possono essere visualizzati solo per i
componenti visibili nella vista.

Per collegare le distinte materiali agli stati di visualizzazione:

1. Nel PropertyManager Distinta materiali, in Configurazioni, selezionare Collega allo
stato di visualizzazione.

2. Fare clic su e selezionare uno stato di visualizzazione.

3. Fare clic su .

Creazione di distinte materiali appiattite (2025 SP1)

Nel PropertyManager Distinta materiali, è possibile appiattire una distinta materiali per
visualizzare le quantità totali per tutti i componenti.

Vantaggi: Le distinte materiali appiattite fanno risparmiare tempo nel calcolo del numero
totale di quantità dei componenti.

La distinta materiali di tipo Appiattito mostra:

• Il modello come elenco di componenti senza rientranza.
• Il componente solo una volta se esiste a più livelli del modello.
• La quantità totale del componente aggiungendo le quantità di ciascun componente.

Per creare distinte materiali appiattite:

1. In un disegno, fare clic su Distinta materiali (barra degli strumenti Tabella),
oppure selezionare Inserisci > Tabelle > Distinta materiali.

2. Nel PropertyManager, per Tipo di distinta materiali, selezionare Appiattito.

3. Fare clic su .
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Generare disegni automaticamente (2025 SP1)

Gli utenti 3DEXPERIENCE possono generare automaticamente disegni di parti e assiemi.

Vantaggi: La generazione automatica dei disegni riduce gli errori e il tempo dedicato
alle attività ripetitive.

Generazione automatica dei disegni

È possibile generare automaticamente disegni di parti e assiemi.

Per generare automaticamente i disegni:

1. Scegliere una delle seguenti opzioni:

• Fare clic su File > Genera disegni automaticamente.
• Nell'albero di disegno FeatureManager o nell'area grafica, fare clic con il pulsante
destro del mouse su una parte, un sottoassieme o un assieme e fare clic su Genera
disegni automaticamente.

2. Richiesto: Per selezionare più componenti di parte o assieme, effettuare una delle
seguenti operazioni:

• Nell'albero di disegno FeatureManager o nell'area grafica, premere Ctrl +
selezionare i componenti e fare clic su File > Genera disegni automaticamente.

• Nel Task Pane Genera disegni automaticamente, fare clic su Modifica.

3. Nel PropertyManager, specificare le opzioni e fare clic su .

PropertyManager di Genera disegni automaticamente

Nel PropertyManager di Genera disegni automaticamente, è possibile selezionare parti o
assiemi per generare automaticamente un disegno.
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Per aprire questo PropertyManager:

In una parte o assieme, fare clic su File > Genera disegni automaticamente.

Specifica i componenti da includere nel disegno
generato automaticamente.

Componenti selezionati

Specifica il titolo del disegno generato
automaticamente.

Titolo

Reimposta il titolo del disegno al nome del file
di parte o assieme.

Reimposta a nome file

Specifica una cartella per salvare il disegno
generato automaticamente.

Salva nella posizione

Salva il disegno generato automaticamente nella
stessa cartella del componente selezionato per
la generazione del disegno.

Uguale a parte/assieme
padre

Scheda Attività (Genera disegni automaticamente)

La scheda Attività (Generazione automatica di disegni) elenca i disegni generati e il loro
avanzamento.

Lo strumento Generazione automatica di disegni è disponibile solo per gli utenti
3DEXPERIENCE.

Per aprire questa scheda:

In una parte o in un assieme, fare clic su Attività (Generazione automatica di disegni)
dal Task Pane.

Visualizza il nome del disegno generato.Titolo

Visualizza lo stato della generazione del disegno.

• Completato

• Non riuscito

Stato
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• Annulla. (Disponibile durante la creazione del
disegno). Annulla la generazione automatica del
disegno dell'elemento selezionato.

• Apri. (Disponibile dopo il completamento del disegno).
Apre il disegno selezionato in modalità dettagliata.

• Visualizza dettagli. (Disponibile se la creazione del
disegno non riesce). Apre un rapporto che mostra il
motivo del fallimento del disegno generato
automaticamente.

• Avanti nella coda. Sposta l'attività al posto
successivo nella coda. SOLIDWORKS non annulla
l'attività in corso. Se si fa clic su Avanti nella coda
su un'altra attività, SOLIDWORKS sposta l'attività alla
successiva nella coda.

• Fare clic con il pulsante destro del mouse su una riga
qualsiasi della scheda Attività per le seguenti opzioni:

• Cancella. Cancella la riga selezionata dall'elenco.
• Cancella tutto. Cancella tutte le righe dalla scheda
Attività, a eccezione delle righe in corso. Sono
incluse le righe in cui lo stato è Completato o Non
riuscito.

Azioni

Tipi di tolleranza aggiuntivi per le quote di smusso

È possibile specificare i tipi di tolleranza MIN, MAX, Limite, Ottimizzato, Ottimizzato
con tolleranza per le quote di smusso nei disegni.

Per accedere ai tipi di tolleranza aggiuntivi per le quote di smusso:
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1. Fare clic su Strumenti > Opzioni > Proprietà del documento > Quote > Smusso.
2. Nella finestra di dialogo Proprietà del documento - Smusso, fare clic su Tolleranza.
3. Nella finestra di dialogo Tolleranza della quota di smusso, in Tipo di tolleranza,

selezionare una tolleranza e fare clic su OK.

Sovrascrivere la quantità della distinta materiali per distinte di taglio dettagliate

Nel PropertyManager Distinta dei materiali, è possibile scegliere un'opzione per la Distinta
di taglio dettagliata per usare la quantità della distinta dei materiali nelle saldature.

Quando si seleziona l'opzione Calcola la quantità utilizzando la quantità nella distinta
materiali, il software prende la proprietà selezionata nell'elenco Quantità distinta
materiali e utilizza il valore come moltiplicatore. Se si deseleziona l'opzione, la tabella
della distinta dei materiali visualizza la quantità come numero di istanze.

Per utilizzare la sovrascrittura della quantità della distinta materiali per distinte
di taglio dettagliate:

1. Fare clic su Distinta materiali (barra degli strumenti Tabella), oppure selezionare
Inserisci > Tabelle > Distinta materiali.

2. Nel PropertyManager, selezionare Distinta di taglio dettagliata e Calcola la
quantità utilizzando la quantità nella distinta materiali.

3. Fare clic su .
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Ricaricare i disegni

È possibile ricaricare i disegni SOLIDWORKS. Ciò è utile negli ambienti multiutente se si
dispone dell'accesso in sola lettura e si desidera la versione più recente con modifiche
apportate da un altro utente.

Questo miglioramento è stato incluso per la prima volta in SOLIDWORKS 2024 SP2,
ma non è stato ancora completamente documentato. Lo includiamo qui per promuovere
la piena consapevolezza del miglioramento nel cliente.

Vantaggi: È possibile utilizzare Ricarica per annullare le modifiche apportate dall'ultima
operazione di salvataggio. È possibile ricaricare l'ultima versione di un documento,
soprattutto se si ha accesso in sola lettura e un altro utente ha apportato delle modifiche.

Per ricaricare i disegni:

1. In un disegno, fare clic su File > Ricarica.

Esportazione delle viste di disegno come blocchi in file DXF/DWG
Le viste di disegno possono essere esportate come blocchi in file .dxf o .dwg.

Questo miglioramento è stato incluso in SOLIDWORKS 2024 SP2, ma non è stato ancora
completamente documentato. Lo includiamo qui per promuovere la piena consapevolezza
del miglioramento.

Vantaggi: Raggruppando la geometria correlata in blocchi, è possibile organizzare i
disegni e semplificare la navigazione e la gestione di progetti complessi.

Per esportare le viste di disegno come blocchi in file DXF/DWG:

1. In un disegno, fare clic su Strumenti > Opzioni > Opzioni del sistema > Esporta.
2. In Formato file, selezionare DXF/DWG.
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3. Fare clic su OK.

Inserimento e visualizzazione delle filettature cosmetiche nei disegni di assiemi

È possibile inserire e visualizzare filettature cosmetiche nei disegni di assiemi.

Questo miglioramento è stato incluso per la prima volta in SOLIDWORKS 2024 SP2,
ma non è stato ancora completamente documentato. Lo includiamo qui per promuovere
la piena consapevolezza del miglioramento nel cliente.

Vantaggi: Maggiore controllo sull'inserimento e sulla visualizzazione delle filettature
cosmetiche nei disegni di assiemi.

In precedenza, quando si inserivano filettature cosmetiche in un assieme, non si vedevano
automaticamente le filettature cosmetiche nei disegni. Era necessario fare clic su Inserisci
> Elementi del modello > Filettatura cosmetica per vedere le filettature cosmetiche.

Per inserire le filettature cosmetiche nei disegni di assiemi:

1. Fare clic su Strumenti > Opzioni > Proprietà del documento > Dettagli.
2. In Inserimento automatico in creazione vista, selezionare Filettature

cosmetiche - assieme (può influire sulle prestazioni) e fare clic su OK.

Per importare le filettature cosmetiche nei disegni di assiemi:

1. Nel PropertyManager Vista del disegno, sotto Opzioni di importazione, selezionare
Importa annotazioni e Filettature cosmetiche.

2. Fare clic su .
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13
Configurazioni

Questo capitolo comprende i seguenti argomenti:

• Traduzione delle intestazioni delle colonne della tabella dati (2025 SP2)
• Tabelle degli stati di visualizzazione

Traduzione delle intestazioni delle colonne della tabella dati (2025 SP2)

È possibile tradurre automaticamente le intestazioni delle colonne di una tabella dati nella
lingua corrente di SOLIDWORKS. Questa funzionalità è supportata da tutte le lingue di
SOLIDWORKS.

Vantaggi: È possibile visualizzare le intestazioni delle colonne della tabella dati nella
lingua locale di SOLIDWORKS senza dover ricorrere a soluzioni alternative.

Ad esempio, è possibile creare una tabella dati in lingua tedesca con un'intestazione
colonna $BESCHREIBUNG. Se si apre la tabella dati in una versione inglese di
SOLIDWORKS, è possibile tradurre automaticamente l'intestazione della colonna come
$DESCRIPTION. Se si apre la stessa tabella dati in una versione italiana di SOLIDWORKS,
è possibile tradurre automaticamente l'intestazione della colonna come $DESCRIZIONE.
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Il processo di traduzione è solo temporaneo durante il processo di modifica della tabella.
La tabella dati nel modello rimane nella lingua originale.

Per tradurre le intestazioni di colonna della tabella dati:

1. Aprire un modello con una tabella dati creata in un'altra lingua. In questo esempio,
la tabella dati originale è in francese.

2. Nel ConfigurationManager , in Tabelle, fare clic con il pulsante destro del mouse
sulla tabella dati Excel in lingua straniera e fare clic su Modifica tabella.

La finestra di dialogo La lingua dell'intestazione della colonna della tabella dati è
<lingua straniera> avvisa che la lingua della tabella dati è diversa dalla lingua corrente.

3. Fare clic su Traduci intestazioni di colonna.

La tabella dati si apre con le intestazioni della colonna in francese tradotte in inglese.
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Tabelle degli stati di visualizzazione

Negli assiemi con più stati di visualizzazione, è possibile utilizzare la Tabella degli stati
di visualizzazione per controllare gli stati di visualizzazione.

La Tabella degli stati di visualizzazione consente di:

• Controllare lo stato Nascondi/Mostra di un componente
• Aggiungere un nuovo stato di visualizzazione facendo clic nella colonna Crea un nuovo

stato di visualizzazione
• Aggiungere un nuovo componente alla tabella facendo doppio clic sul componente nel
PropertyManager o nell'area grafica

• Fare doppio clic sulla cella del nome di uno stato di visualizzazione per passare a tale
stato di visualizzazione

• Fare clic con il pulsante destro del mouse sulla cella del nome di uno stato di
visualizzazione per rinominare lo stato di visualizzazione o passare a esso

Per accedere alla tabella dello stato di visualizzazione, nel ConfigurationManager , in
Stati di visualizzazione > Tabelle , fare clic con il tasto destro su Tabella degli

stati di visualizzazione e fare clic su Mostra tabella.
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Informazioni generali

• La tabella viene visualizzata se l'assieme di primo livello contiene più di uno stato di
visualizzazione.

• La tabella è disponibile per gli stati di visualizzazione non collegati e collegati. Per gli
stati di visualizzazione collegati, la tabella mostra gli stati di visualizzazione disponibili
per la configurazione attiva.

• Nella tabella, è possibile fare clic su Nascondi/Mostra stato di visualizzazione

referenziato per nascondere o mostrare la riga Stato di visualizzazione
referenziato per ciascun componente in tutti gli stati di visualizzazione di primo livello.
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14
Importa/Esporta

Questo capitolo comprende i seguenti argomenti:

• Opzioni di esportazione di Extended Reality (2025 SP2)
• Importazione di file IFC e STEP (2025 SP2)
• Applicazione di filtri ai componenti durante l'importazione dei file IFC (2025 SP1)
• Esportazione di proprietà personalizzate in file IFC
• Importazione di file Extended Reality

Opzioni di esportazione di Extended Reality (2025 SP2)

Le opzioni di esportazione per salvare i file come file Extended Reality sono state spostate
dalla finestra di dialogo Impostazioni di esportazione XR alla finestra di dialogo Strumenti
> Opzioni > Opzioni del sistema > Esporta.

Vantaggi: Questa architettura rivista consente di migliorare le prestazioni in futuro.

Per aprire la finestra di dialogo Esporta:

1. In un modello, fare clic su File > Salva con nome.
2. Nella finestra di dialogo, per Salva come tipo, selezionare Extended Reality (*.glb)

o Extended Reality (.gltf).
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3. Fare clic su Opzioni per aprire la finestra di dialogo Esporta opzioni del sistema per
file GLTF/GLB.

Le opzioni di esportazione non sono modificate.

Importazione di file IFC e STEP (2025 SP2)

Quando si filtrano i componenti durante l'importazione di file IFC o STEP, tutte le opzioni
di selezione del componente sono disponibili quando si fa clic su Genera anteprima 3D

e si fa clic con il pulsante destro del mouse sui componenti nell'area grafica. In
precedenza, le opzioni erano disponibili solo dall'albero di disegno FeatureManager.

Vantaggi: La selezione dei componenti da filtrare è più efficiente e uniforme.

Queste opzioni sono disponibili quando si fa clic con il pulsante destro del mouse sui
componenti nell'area grafica:

• Mantieni componenti
• Escludi componenti
• Escludi altri componenti
• Seleziona componenti identici
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Applicazione di filtri ai componenti durante l'importazione dei file IFC (2025
SP1)

Quando si importano file IFC, è possibile applicare filtri ai componenti da importare.

Vantaggi: Il filtraggio dei componenti nell'importazione di file IFC consente di specificare
esattamente i componenti necessari, facendo risparmiare tempo e semplificando il lavoro,
soprattutto per file IFC di grandi dimensioni.

Per applicare filtri durante l'importazione di file IFC:

1. Nella finestra di dialogo Apri, selezionare un file IFC, selezionare Attiva filtro e fare
clic su Apri.

Il software genera la struttura del prodotto nell'albero di disegno FeatureManager,
che visualizza i componenti che è possibile selezionare per l'importazione. L'area
grafica è vuota. Il CommandManager di Importa filtro visualizza gli strumenti
disponibili.

Se sono state specificate opzioni di filtro in Strumenti > Opzioni > Opzioni del
sistema > Importa > Formato file: IFC, in Entità da importare, SOLIDWORKS
applica automaticamente le relative opzioni di filtro. Specificando queste impostazioni
a livello di sistema prima di filtrare i componenti si risparmia tempo, soprattutto
per i file IFC di grandi dimensioni, perché è possibile selezionare esattamente le
entità e i componenti da aprire.

2. Nell'albero di disegno FeatureManager, selezionare i componenti da importare. È
possibile selezionare singoli componenti di controllo o selezionare più componenti.

Per generare un'anteprima, nel CommandManager fare clic su Genera anteprima

3D .
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I sottoassiemi che contengono una combinazione di componenti selezionati e
deselezionati visualizzano una casella di controllo parzialmente selezionata . Per
facilitare la gestione di più selezioni, è possibile fare clic con il pulsante destro del
mouse sui componenti selezionati e selezionare Mantieni componenti o Escludi
componenti. Per invertire le selezioni, selezionare Escludi altri componenti. Se i
componenti sono identici, viene visualizzata anche l'opzione Seleziona componenti
identici.

3. Per importare il file IFC con i componenti selezionati, nel CommandManager fare clic

su Importa modello .
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Esportazione di proprietà personalizzate in file IFC

Quando si esportano i modelli SOLIDWORKS® come file IFC™, è possibile mappare le
proprietà personalizzate di SOLIDWORKS in set di proprietà IFC.

Per esportare le proprietà personalizzate in file IFC:

1. In Strumenti > Opzioni > Opzioni del sistema > Esporta, in Formato del file,
selezionare IFC.

2. In Risultato come, selezionare Usa file di mappatura per Set proprietà.
3. Quindi specificare lo schema XML o il file di mappatura .xsd utilizzato dal software

per convalidare le proprietà esportate.

Vantaggi: I clienti BIM possono esportare i dati delle proprietà personalizzate, un aspetto
importante per la costruzione e il funzionamento dell'edificio. Questa funzionalità è
flessibile. Consente di mappare le proprietà di SOLIDWORKS alle proprietà IFC,
potenzialmente con un nome diverso, e di definire i propri set di proprietà di destinazione
nel file IFC. Nelle versioni precedenti, è possibile esportare le proprietà quando sono state
salvate come file IFC, ma solo in un singolo set di proprietà con codice hardware nel file
IFC.

Per esportare le proprietà personalizzate in set di proprietà IFC:

1. In un file SOLIDWORKS, fare clic su File > Proprietà.
2. Nella scheda Personalizza, aggiungere le proprietà che si desidera esportare nel file

IFC e salvare il file.
3. Creare un file di mappatura XML che metta le proprietà personalizzate di SOLIDWORKS

ai valori del set di proprietà IFC.

SOLIDWORKS offre file di mappatura dei campioni in SOLIDWORKS install
folder\lang\language\IFC.
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File di mappatura dei campioni:

<CustomPropertiesPSETMapping>
<Schema Version="1.0"/>
<PropertySet Name="Pset_DoorCommon">

<AppliesTo ElementType="IFCDOOR"/>
<PropertyMapping SOLIDWORKS="Reference" IFC="Reference"

Type="IfcIdentifier"/>
<PropertyMapping SOLIDWORKS="FireRating" IFC="FireRating"

Type="IfcLabel"/>
<PropertyMapping SOLIDWORKS="NoiseRating" IFC="AcousticRating"

Type="IfcLabel"/>
<PropertyMapping SOLIDWORKS="Security" IFC="SecurityRating"

Type="IfcLabel"/>
<PropertyMapping SOLIDWORKS="External" IFC="IsExternal"

Type="IfcBoolean"/>
<PropertyMapping SOLIDWORKS="Infiltration" IFC="Infiltration"

Type="IfcVolumetricFlowRateMeasure"/>
<PropertyMapping SOLIDWORKS="ThermalTransmit"

IFC="ThermalTransmittance" Type="IfcThermalTransmittanceMeasure"/>
<PropertyMapping SOLIDWORKS="Glazing"

IFC="GlazingAreaFraction" Type="IfcPositiveRatioMeasure"/>
<PropertyMapping SOLIDWORKS="Accessible"

IFC="HandicapAccessible" Type="IfcBoolean"/>
<PropertyMapping SOLIDWORKS="FireDoor" IFC="FireExit"

Type="IfcBoolean"/>
<PropertyMapping SOLIDWORKS="StarTrekDoor" IFC="SelfClosing"

Type="IfcBoolean"/>
<PropertyMapping SOLIDWORKS="SmokeStop" IFC="SmokeStop"

Type="IfcBoolean"/>
</PropertySet>
<PropertySet Name="ACME_CageCodes">

<AppliesTo ElementType="IFCDOOR"/>
<AppliesTo ElementType="IFCWINDOW"/>
<PropertyMapping SOLIDWORKS="RefCode" IFC="CageCode"

Type="IfcLabel"/>
</PropertySet>

</CustomPropertiesPSETMapping>

4. Nel file SOLIDWORKS, fare clic su Salva con nome (barra degli strumenti
Standard) o su File > Salva con nome.

5. Nella finestra di dialogo, per Salva con nome, selezionare il tipo di file IFC, quindi
fare clic su Opzioni.

È possibile selezionare qualsiasi tipo di file IFC.

6. Nella finestra di dialogo Opzioni del sistema, in Risultato come, selezionare Usa
file di mappatura per Set proprietà, quindi selezionare il file di mappatura
dall'elenco o navigare per selezionarlo.

Per includere tutte le proprietà personalizzate dal file SOLIDWORKS nel file IFC
esportato, in Risultato come, selezionare anche Proprietà personalizzate. Per
includerli nel set di proprietà IFC, mappare tutte le proprietà personalizzate nel file
Schema XML.

SOLIDWORKS controlla la validità del set di proprietà IFC XML per questi elementi:

• Tag, attributi dei tag e struttura di tag.
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• La versione dello schema è uguale o inferiore alla versione supportata dalla versione
corrente di SOLIDWORKS.

• Le proprietà personalizzate di SOLIDWORKS mappano proprietà IFC una a una o
una a molte. Non è possibile mappare più proprietà personalizzate di SOLIDWORKS
sulla stessa proprietà IFC.

Il software memorizza fino a 10 set di proprietà nel registro.

7. Fare clic su OK, quindi su Salva per esportare il file come file IFC.

Il file IFC contiene le proprietà personalizzate di SOLIDWORKS nel set di proprietà
IFC, in base al file di mappatura dello schema XML.

Importazione di file Extended Reality

È possibile importare i tipi di file Extended Reality .glTF e .GLB.

Per importare file di realtà estesa:

1. Fare clic su Apri (barra degli strumenti Standard) oppure su File > Apri.
2. Nella finestra di dialogo, per File del tipo, selezionare Extended Reality (.*GLTF

e .GLB).
3. Selezionare un file e fare clic su Apri.

L'importazione di file glTF™ e GLB include:

• Gerarchia della geometria del file glTF o GLB importato.
• Compressione Draco™.

Si tratta di un'opzione di compressione per i file di grandi dimensioni. Non si specifica
alcuna opzione all'importazione. Il proprietario del file specifica la compressione
Draco all'esportazione dei file glTF o GLB dal software di origine.
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• Trame non modificabili. Il software importa le trame ma non gli aspetti SOLIDWORKS
corretti.
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15
SOLIDWORKS PDM

Questo capitolo comprende i seguenti argomenti:

• Visualizzazione dell'avviso per autenticazione multipla (2025 SP2)
• Distinta materiali per assieme elettrico (2025 SP2)
• Opzioni di visualizzazione - Mostra anteprima immagine (2025 SP1)
• Opzioni dei controlli della scheda (2025 SP1)
• Configurazione dell'attività di conversione (2025 SP1)
• Preferiti di ricerca (2025 SP1)
• Distinta materiali di assieme elettrico (2025 SP1)
• Impostazioni predefinite per la distinta materiali calcolata
• Estrazione dei file durante l'operazione di acquisizione
• Informazioni di accesso per l'autenticazione utente
• Apertura dei dati file in Microsoft Excel con miniature
• Visualizzazione dell'ordine dell'albero di disegno FeatureManager della struttura

dell'assieme nelle distinte dei materiali calcolate
• Recupero delle informazioni sul tempo impiegato nell'apertura dei file
• Recupero di informazioni sulla revisione più recente
• Separare i permessi di aggiunta o ridenominazione per file e cartelle
• Connettore da SOLIDWORKS PDM a Electrical
• Prestazione del check-in dei file
• Disponibilità della barra degli strumenti di SOLIDWORKS PDM e della scheda

CommandManager
• Opzioni aggiuntive nel menu di scelta rapida del Task Pane e nella barra degli

strumenti
• Supporto per l'autenticazione SSL o TLS nelle notifiche e-mail SMTP

SOLIDWORKS® PDM è disponibile in due versioni. SOLIDWORKS PDM Standard è incluso in
SOLIDWORKS Professional, SOLIDWORKS Premium e SOLIDWORKS Ultimate, ed è disponibile
come licenza acquistabile separatamente per gli utenti non SOLIDWORKS. Offre capacità di
gestione dei dati standard per un numero ridotto di utenti.

SOLIDWORKS PDM Professional è una soluzione di gestione dati dotata di funzionalità complete,
per gruppi di utenti di grandi e piccole dimensioni ed è disponibile come licenza acquistabile
separatamente.
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Visualizzazione dell'avviso per autenticazione multipla (2025 SP2)

Per SOLIDWORKS PDM Professional, quando si tenta di accedere allo strumento di
amministrazione di SOLIDWORKS PDM più di una volta da più computer con lo stesso
account, si riceve un messaggio di avviso che ricorda all'utente le precedenti operazioni
di accesso.

Il messaggio di avviso visualizza i nomi dei computer su cui si è già effettuato l'accesso
e chiede se si desidera continuare o annullare l'accesso. In questo modo si evita di
sovrascrivere accidentalmente gli aggiornamenti precedenti effettuati da altri computer.

Viene visualizzato un messaggio di avviso solo se si seleziona l'opzione
Proprietà del vault dei file > Operazione di accesso > Log-in e log-out.

Distinta materiali per assieme elettrico (2025 SP2)
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In File Explorer di SOLIDWORKS PDM, nella vista Distinta materiali della scheda Distinta
materiali, è possibile visualizzare tutte le distinte materiali dei pezzi costruttore per gli
assiemi elettrici selezionati in SOLIDWORKS Electrical.

Ad esempio:

• Distinta materiali per produttore
• Distinta materiali per produttore e per libro

Opzioni di visualizzazione - Mostra anteprima immagine (2025 SP1)

In File Explorer di SOLIDWORKS PDM, è possibile visualizzare una miniatura o un'anteprima
completa nella scheda Anteprima in base ai seguenti tipi di file utilizzando Visualizza >
Opzioni > Mostra anteprima immagine:

• File SOLIDWORKS
• File eDrawings
• File DWG/DXF
• File CAD di formato neutro
• File CAD di terze parti
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Opzioni dei controlli della scheda (2025 SP1)

Nello strumento di amministrazione di SOLIDWORKS PDM, è possibile selezionare una
delle seguenti opzioni come Tipo di corrispondenza di ricerca durante la modifica o
l'aggiunta dei controlli della scheda Casella di riepilogo e Casella combinata a discesa
alla scheda di ricerca e alla scheda file:

• Esatto: è possibile ricercare file, cartelle e variabili nella finestra File Explorer di
SOLIDWORKS PDM, la quale restituisce i risultati di ricerca che corrispondono
esattamente all'input della ricerca.

Per esempio, se si cerca weldments in Nome, i risultati della ricerca includono solo
quei file, cartelle o variabili con il nome esatto weldments. Se si desidera cercare tutti
i file che includono weldments nel nome, inserire un asterisco (*) come carattere
jolly, ad esempio weldments* o *weldments*.

• Carattere jolly implicito: è possibile ricercare file, cartelle e variabili nella finestra
File Explorer di SOLIDWORKS PDM, la quale restituisce i risultati di ricerca che includono
l'input della ricerca.

Ad esempio, se si cerca weldments in Nome, i risultati della ricerca includono tutti i
file, le cartelle o le variabili i cui nomi includono weldments (ad esempio, weldments,
weldments_box e weldmentspro).
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Configurazione dell'attività di conversione (2025 SP1)

Nello strumento Amministrazione di SOLIDWORKS, durante la configurazione di un'attività
di conversione, è possibile utilizzare le seguenti opzioni di conversione avanzate per i
formati dei file di output .stl e .igs.

Opzioni di conversione avanzateFormato dei file di output

Superficie unita (tipo 143): Selezionare per
convertire le facce della parte, dell'assieme o delle
superfici selezionate e i relativi limiti definiti da altre
entità IGES, ad esempio curve e bordi.

IGES (*.igs)

Opzione personalizzata in Risoluzione con le
seguenti opzioni secondarie:

• Tolleranza di deviazione: Controlla la
tassellatura dell'intera parte. Valori più bassi
generano file con una precisione maggiore a
livello della parte.

• Tolleranza angolare: Controlla la tessellatura
dei dettagli più piccoli. Un valore inferiore
assicura una maggiore precisione dei dettagli più
piccoli, ma richiede più tempo per generarli.

STL (*.stl)
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È possibile accedere a queste opzioni in Attività > Converti > Apri > Impostazioni di
conversione > Opzioni di conversione.

Queste opzioni sono simili alle opzioni del sistema di Esportazione di SOLIDWORKS per
i formati di file .stl e .igs. Per ulteriori informazioni, vedere la Guida in linea di
SOLIDWORKS: Opzioni di esportazione IGES e Guida in linea di SOLIDWORKS: Opzioni
di esportazione dei file STL, 3D Manufacturing Format e Additive Manufacturing File.

Preferiti di ricerca (2025 SP1)

In File Explorer di SOLIDWORKS, è possibile utilizzare la funzionalità Esegui preferiti
di ricerca al caricamento per visualizzare i risultati dei Preferiti di ricerca per file e
cartelle selezionando Preferiti di ricerca. La funzionalità è disponibile con la ricerca integrata
e lo Strumento di ricerca.
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Quando questa opzione non è selezionata, è possibile visualizzare i risultati della Ricerca

preferiti selezionando Ricerca preferiti e facendo clic su Avvia ricerca

Distinta materiali di assieme elettrico (2025 SP1)

In File Explorer di SOLIDWORKS PDM, nella scheda Distinta materiali è possibile
visualizzare i dettagli della distinta materiali degli assiemi elettrici.

Per gli assiemi elettrici, è possibile visualizzare:

• La struttura gerarchica e con rientranza padre-figlio nella distinta materiali calcolata
per i file CVD.

• La vista Distinta materiali pezzi costruttore.
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Impostazioni predefinite per la distinta materiali calcolata

Gli amministratori possono specificare le impostazioni predefinite della vista e delle opzioni
per la distinta materiali calcolata durante la creazione della distinta materiali (BOM) nello
strumento di amministrazione di SOLIDWORKS PDM.

Le impostazioni predefinite specificate dagli amministratori vengono applicate nelle sezioni
Vista e Opzioni della distinta dei materiali nella scheda Distinta dei materiali in File
Explorer di SOLIDWORKS PDM. Le impostazioni predefinite sono applicabili sia al client
Desktop sia al client Web2.

Nello strumento di amministrazione, fare clic con il pulsante destro del mouse su Distinta
dei materiali > Nuova distinta dei materiali. Nella finestra di dialogo Distinta dei
materiali - Nuova distinta dei materiali, in Impostazioni predefinite, specificare le
impostazioni predefinite per la distinta dei materiali calcolata.
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Estrazione dei file durante l'operazione di acquisizione

In File Explorer di SOLIDWORKS PDM, è possibile eseguire il check-out dei file durante
l'esecuzione di un'operazione Leggi, ad esempio Leggi l'ultima versione, a condizione
che l'utente abbia concesso l'autorizzazione al check-out.

Nella finestra di dialogo Leggi, quando si seleziona Check-out per file singoli o multipli,
l'opzione Leggi per questi file è selezionata per impostazione predefinita per eseguire
entrambe le operazioni contemporaneamente. L'operazione combinata Leggi e Check-out
semplifica il flusso di lavoro.

È possibile aggiungere la colonna Check-out nella finestra di dialogo Leggi di File Explorer
di SOLIDWORKS PDM. La personalizzazione viene eseguita utilizzando la vista Colonne
personalizzabili per le colonne delle operazioni file Leggi nello strumento di
amministrazione di SOLIDWORKS PDM.

Le seguenti condizioni si applicano all'operazione combinata Leggi e Check-out:

• Se l'operazione di lettura non riesce, il check-out non viene eseguito.
• Se il check-out non riesce, l'operazione di lettura continua.
• Quando si esegue l'operazione Leggi per una versione precedente, se si seleziona

Check-out, si ottiene la versione specificata con un check-out eseguito.
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Informazioni di accesso per l'autenticazione utente

È possibile visualizzare i dettagli di autenticazione dell'utente per un vault nello strumento
di amministrazione di SOLIDWORKS PDM Professional.

I dettagli di autenticazione includono il nome utente, la data e l'ora in cui l'utente ha
eseguire il log-in e il log-out e SOLIDWORKS PDM Client (Desktop o Web2).

È possibile fare clic con il pulsante destro del mouse sul nome del vault e selezionare
Registri >Mostra registri log-in e log-out per visualizzare i dettagli di autenticazione.
Per visualizzare questa opzione, è necessario disporre del:

• Un vault di SOLIDWORKS PDM Professional.
• Autorizzazione per Gestione vault.
• L'opzione Log-in e Log-out selezionata nelle proprietà del vault in Operazioni di

accesso.
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Apertura dei dati file in Microsoft Excel con miniature

È possibile aprire i dati file in formato Microsoft® Excel® insieme a un'anteprima in miniatura
nelle schede Distinta dei materiali, Contiene e Dove usato di File Explorer di SOLIDWORKS
PDM.

È possibile aprire i dati file con miniature utilizzando Apri tutto con miniature e Apri

visibili con miniature in Apri come CSV nella barra degli strumenti delle schede.

Con l'anteprima in miniatura, è possibile comprendere i dati in modo più semplice e
comunicare in modo efficace il processo all'esterno del vault.

Visualizzazione dell'ordine dell'albero di disegno FeatureManager della
struttura dell'assieme nelle distinte dei materiali calcolate

È possibile visualizzare l'ordine della struttura dell'assieme nelle distinte dei materiali
calcolate di SOLIDWORKS PDM file Explorer per i file sottoposti a check in. La vista è
simile a quella dell'albero di disegno FeatureManager di SOLIDWORKS®.
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L'ordine dei componenti dell'assieme nella distinta dei materiali per i dati già sottoposti
a check-in nel vault non viene modificato per corrispondere all'albero di disegno
FeatureManager.

Recupero delle informazioni sul tempo impiegato nell'apertura dei file

È possibile conoscere il tempo impiegato per aprire un file quando è stato aperto l'ultima
volta in SOLIDWORKS 2023 e versioni successive. Il tempo viene misurato in secondi.
Per conoscere l'ora di apertura del file, alle variabili di SOLIDWORKS PDM è stata aggiunta
una nuova variabile _SW_Last_Open_Time_.
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Recupero di informazioni sulla revisione più recente

È possibile ottenere la revisione più recente per un file in SOLIDWORKS PDM. Per ottenere
la revisione più recente, viene aggiunta una variabile di sistema Revisione più recente
alle variabili di sistema esistenti.

Per recuperare le informazioni di revisione di un file, è possibile utilizzare i comandi

Recupera ultima revisione e Recupera revisione in File Explorer di
SOLIDWORKS PDM in posizioni diverse, ad esempio durante la ricerca dei file, nel menu
di scelta rapida di una vista dei file, nella scheda Versione e nei Set di colonne. Questi
comandi possono essere utilizzati anche nella barra degli strumenti dell'aggiunta
SOLIDWORKS PDM e nel CommandManager.
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Separare i permessi di aggiunta o ridenominazione per file e cartelle

I permessi esistenti Aggiungi o rinomina file e Aggiungi o rinomina cartella sono
suddivisi in permessi separati per l'aggiunta e la ridenominazione.

Gli amministratori possono usare Aggiungi file e Rinomina file in Permessi cartella
e Permessi di stato nello strumento di amministrazione di SOLIDWORKS PDM.
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Connettore da SOLIDWORKS PDM a Electrical

Il connettore da SOLIDWORKS Electrical a SOLIDWORKS PDM è disponibile con
l'installazione di SOLIDWORKS PDM. È integrato con SOLIDWORKS PDM e non è disponibile
come aggiunta di SOLIDWORKS PDM.

È possibile configurare il connettore SOLIDWORKS Electrical dallo strumento di
amministrazione di SOLIDWORKS PDM. Un nodo SOLIDWORKS Electrical viene aggiunto
nel vault di SOLIDWORKS PDM per la configurazione.

L'opzione Cronologia viene aggiunta alle opzioni del CommandManager di SOLIDWORKS
PDM. È possibile visualizzare la cronologia dei progetti SOLIDWORKS Electrical utilizzando
questa opzione per monitorare meglio le modifiche.
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Prestazione del check-in dei file
Le prestazioni di SOLIDWORKS PDM sono migliorate durante il check-in del file nel database
di SOLIDWORKS PDM. L'operazione di check-in dei file è due volte più veloce rispetto a
prima.

Disponibilità della barra degli strumenti di SOLIDWORKSPDM e della scheda
CommandManager

È possibile accedere a SOLIDWORKS PDM e a tutti i relativi comandi da una barra degli
strumenti dedicata di SOLIDWORKS PDM e dalla scheda CommandManager in
SOLIDWORKS quando l'aggiunta SOLIDWORKS PDM viene selezionata.
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Opzioni aggiuntive nel menu di scelta rapida del Task Pane e nella barra
degli strumenti

Il Task Pane dell'aggiunta SOLIDWORKS PDM presenta nuove opzioni nel menu di scelta
rapida e nella barra degli strumenti. Inoltre, alcune delle opzioni esistenti vengono
aggiornate. Tutte le opzioni sono organizzate in gruppi significativi per una maggiore
chiarezza.

Ad esempio, di seguito sono riportate le opzioni aggiunte:

• Vai a : apre il file selezionato nella stessa finestra File Explorer di SOLIDWORKS
PDM.

• Vai a nuova finestra : apre il file selezionato in una nuova finestra di File Explorer
di SOLIDWORKS PDM.

• Scheda dati e Dove usato: consente di visualizzare le informazioni della scheda dati
e dove viene utilizzata. Queste opzioni sono raggruppate con l'opzione Cronologia.

L'opzione Modifica viene rinominata Modifica componente .

È possibile personalizzare la barra degli strumenti del Task Pane per includere le opzioni
usate di frequente.
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Supporto per l'autenticazione SSL o TLS nelle notifiche e-mail SMTP

È possibile attivare l'autenticazione SSL (Secure Socket Layer) o TLS (Transport Layer
Security) nella notifica e-mail SMTP.

Nello strumento di amministrazione di SOLIDWORKS PDM, è possibile selezionare
EnableSSL in Sistema di messaggistica > SMPT > Impostazioni SMTP per abilitare
l'autenticazione SSL o TLS nelle notifiche e-mail SMTP. Si tratta di un'autenticazione
bidirezionale insieme alle credenziali di accesso.

Sono supportati i server SMTP seguenti:

Server SMTPServer di posta

smtp.gmail.comGmail®

smtp.outlook.comOutlook®

smtp.office365.comMicrosoft 365®

smtp.mail.yahoo.comYahoo®
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16
SOLIDWORKS Manage

Questo capitolo comprende i seguenti argomenti:

• Aggiornamenti in batch per i campi Collega a terze parti
• Sincronizzazione con SOLIDWORKS PDM
• Notifiche di data futura
• Aggiornamenti in batch per campi di processo
• Invio degli elementi interessati a nuovi processi
• Commenti di collaborazione nella condivisione dei file
• Controllo della versione client
• Raggruppamenti distinta materiali piana
• Aggiunta di informazioni sull'oggetto dell'attività automatica
• Istantanee del progetto
• Operazioni da processi annullati
• API di SolidWorks
• Creazione di nuovi record di processo da record di processo esistenti
• Inviare al processo gli elementi interessati
• Elementi interessati in Esplora file di Microsoft
• Miniature per distinte dei materiali con Copia da
• Installazione dell'API Web di SOLIDWORKS Manage

SOLIDWORKS® Manage è un sistema di gestione dati avanzato che amplia le integrazioni globali
di gestione e applicazione file, abilitate da SOLIDWORKS PDM Professional.

SOLIDWORKS Manage è l'elemento chiave per fornire la gestione dei dati distribuiti.
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Aggiornamenti in batch per i campi Collega a terze parti

È possibile aggiornare i valori del campo Collega a terze parti per alcuni o tutti i record
in un oggetto.

I non amministratori possono aggiornare i valori per i record selezionati nella griglia
principale o per tutti i record di una pagina. Gli amministratori possono aggiornare i valori
per tutti i record in un oggetto. In questo modo si impedisce agli utenti di influire sulle
prestazioni del sistema se sono presenti molti campi o con query complesse.

Si tratta di un modo pratico per compilare un nuovo campo Collega a terze parti senza
scrivere una query SQL separata.

Implementazione degli aggiornamenti in batch per i campi Collega a terze parti

1. Passare a un oggetto con campi Collega a terze parti.
2. Selezionare i record, quindi fare clic con il pulsante destro del mouse e fare clic su

Strumenti > Ricarica i campi "Collega a terze parti".
3. Nella finestra di dialogo:

a) Specificare le opzioni.
b) Fare clic su Avvio.
c) Dopo l'aggiornamento dei campi, fare clic su Chiudi.
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Sincronizzazione con SOLIDWORKS PDM

Tutti gli utenti possono sincronizzare i record selezionati nella griglia principale di un
oggetto SOLIDWORKS PDM.

SOLIDWORKS Manage legge i dati dal database SOLIDWORKS PDM, quindi sincronizza
le informazioni nel database SOLIDWORKS Manage. In precedenza solo gli amministratori
potevano sincronizzare i record nello strumento Amministrazione sistema.

Fare clic con il pulsante destro del mouse su un record e fare clic su Strumenti >
Sincronizza con SOLIDWORKS PDM.

Notifiche di data futura
È possibile inviare una notifica dopo una determinata data e ora per una notifica del
processo.

L'impostazione rimane attiva anche dopo il termine di un processo, a meno che la notifica
non venga limitata da una condizione. Ciò provoca l'invio di una notifica come un
promemoria di rinnovo o di follow-up al termine di un processo.

Creazione di notifiche di data futura

1. Nello strumento di sistema di amministrazione del sistema, fare clic con il pulsante
destro del mouse su un processo e fare clic su Amministrazione.

2. Nella procedura guidata processo, nella pagina Campi, specificare un campo Date
che contenga la data utilizzata per inviare la notifica.
Se il processo dispone già di un campo Data idoneo, è possibile saltare questo
passaggio.
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3. Nella pagina Proprietà flusso di lavoro, selezionare:
a) Una fase per l'invio della notifica.
b) Il nodo Visibilità.

4. Specificare il campo Data definito nel passaggio 2 per specificare la data di invio della
notifica.
Ad esempio, specificare il valore predefinito come la data corrente e Quando? su
Fine. Specifica la data in cui la fase del processo passa alla fase successiva.

5. Selezionare Notifiche per la fase e modificare una notifica esistente o crearne una
nuova.

6. Nella finestra di dialogo Notifiche fase, nella scheda Generale:
a) Quando inviare, selezionare Personalizzato.
b) Selezionare il campo Data, quindi selezionare il campo Data definito nella fase

2.
c) (Opzionale) Ora, specificare l'ora del giorno nella data selezionata per inviare la

notifica.
d) (Opzionale) Giorni di adeguamento, aggiungere giorni a Selezionare il campo

Data.
e) Fare clic su Salva e quindi su Chiudi.

Aggiornamenti in batch per campi di processo

È possibile modificare i campi per più fasi di processo con lo strumentoModifica in batch.

Con lo strumento Modifica in batch, è possibile modificare un campo per tutte le fasi
in un'unica posizione. In precedenza, era necessario selezionare ogni fase nel diagramma
del flusso di lavoro, quindi salvare il campo modificato.
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Implementazione degli aggiornamenti in batch ai campi processo

1. Nello strumento di sistema di amministrazione del sistema, fare clic con il pulsante
destro del mouse su un processo e fare clic su Amministrazione.

2. Nella pagina Proprietà flusso di lavoro:
a) Selezionare una fase.
b) Selezionare il nodo Visibilità.
c) Fare clic su Modifica in batch.

3. Nella finestra di dialogo Visibilità modifica in batch:
a) Nel pannello a sinistra, selezionare Campo.

Nel riquadro a destra, tutte le fasi definite nel processo vengono visualizzate in
Fase.

b) Modificare le impostazioni per ogni fase, quindi fare clic su Salva.
c) Ripetere i punti 3a e 3b per altri campi.

Se si seleziona un altro Campo senza fare clic su Salva, le modifiche apportate
al campo precedentemente selezionato non vengono salvate.

d) Fare clic su Chiudi.

Invio degli elementi interessati a nuovi processi

È possibile inviare gli elementi interessati dai processi selezionati a nuovi processi.

È possibile inviare il processo stesso o solo gli elementi interessati a un nuovo processo.
In questo modo è più facile inviare nuovamente gli stessi elementi interessati da un
processo all'altro. In precedenza, era necessario aggiungere ogni elemento singolarmente
a un nuovo processo.
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Nella griglia principale di un oggetto di processo, fare clic con il pulsante destro del mouse
su un processo e fare clic su Invia a processo > Elementi selezionati o su Elementi
interessati degli elementi selezionati.

Commenti di collaborazione nella condivisione dei file

È possibile specificare un'opzione che consente ai partecipanti alla condivisione dei file di
aggiungere commenti a ciascun file. In questo modo è più facile comunicare con gli utenti
esterni sui file condivisi.

Per abilitare i commenti di collaborazione nella condivisione dei file:

1. Nella griglia principale di un oggetto, selezionare un record e creare una nuova
condivisione o modificare una condivisione di file esistente nel riquadro di destra.

2. Nella finestra di dialogo Condividi:

a. Selezionare Abilita opzioni di collaborazione.
b. Fare clic sul collegamento Abilita opzioni di collaborazione.

3. Nella finestra di dialogo Opzioni di collaborazione:

a. Selezionare Mostra sezione Commenti.
b. (Opzionale) Selezionare Gli utenti esterni possono aggiungere commenti.
c. (Opzionale) Selezionare Sovrascrivere il nome utente interno nelle griglie

per visualizzare un nome generico in Creato da nella pagina web Condividi file.
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Controllo della versione client

È possibile specificare un'opzione per impedire agli utenti di eseguire l'accesso se utilizzano
una versione del client precedente rispetto alla versione del database.

Per eseguire i controlli della versione client:

1. Nello strumento Amministrazione di sistema, fare clic su Avanzate > Generale >
Accesso.

2. In Controlla versione software all'accesso, specificare un'opzione.

L'impostazione predefinita è Blocca utenti se la loro versione software è
precedente alla versione del database.

Raggruppamenti distinta materiali piana
È possibile visualizzare più righe per lo stesso numero di parte per le viste della distinta
materiali piana (BOM) in base al valore campo della distinta materiali secondaria.

Ad esempio, si consideri che un'istanza di parte di un sottoassieme abbia un valore
specifico di riferimento di Spare Part e che la stessa parte esista altrove nell'assieme
senza un valore. La distinta materiali piana riporta le quantità delle parti con valori vuoti
e le parti con il valore Spare Part su due linee separate. Questa funzionalità è disponibile
anche in Plenary Web ed è possibile accedervi nei report.

In precedenza, non era possibile separare le stesse istanze di parte in gruppi diversi.
Tutte le istanze sono state inserite in una singola linea.

Raggruppamento delle istanze nelle distinte dei materiali piatte

1. Nella barra degli strumenti della scheda delle proprietà della distinta dei materiali,
fare clic su Formato > Vista piatta (avanzata) > Raggruppa per.
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2. Selezionare un campo da utilizzare per il raggruppamento e fare clic su Applica.

La distinta dei materiali mostra una posizione articolo per lo stesso numero di parte
per ogni valore nel campo Raggruppa per selezionato.

Aggiunta di informazioni sull'oggetto dell'attività automatica

È possibile includere i valori dei campi da un oggetto associato nell'oggetto dell'attività.
Ciò rende gli oggetti delle attività associati agli oggetti progetto, processo e caso più
significativi per gli utenti.

Nelle versioni precedenti, era possibile aggiungere solo il numero di parte del record e il
nome della fase corrente.

Per aggiungere informazioni sugli oggetti dell'attività automatica:

1. Modificare ed elaborare un oggetto.
2. Nello strumento Amministrazione sistema, aprire Creazione guidata processo.
3. Nella pagina Proprietà flusso di lavoro:

a. Nella vista flusso di lavoro, selezionare una fase.
b. Selezionare Attività.
c. Modificare un'attività esistente o crearne una nuova.
d. Nella finestra di dialogo Modello attività:

1. All'estremità destra dell'Oggetto, fare clic sull'icona della freccia a destra e
selezionare un campo.

2. (Opzionale) Aggiungere un testo statico o campi aggiuntivi.

e. Fare clic su Salva e quindi su Chiudi.
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Istantanee del progetto

È possibile acquisire i dettagli dei record di progetto in determinati momenti per creare
una cronologia delle modifiche apportate a un record di progetto.

Le istantanee sono disponibili in una scheda di proprietà denominata Istantanee. Il riquadro
a sinistra della scheda visualizza le istantanee create in aggiunta al record corrente. È
possibile confrontare le informazioni dell'istantanea con il record corrente e con altre
istantanee. Il riquadro a destra visualizza le informazioni relative all'istantanea selezionata
o al record corrente. Le informazioni nel riquadro a destra includono:

• Dettagli. Visualizza i valori del campo del record.
• Pianificazione. Mostra la struttura di ripartizione del lavoro e il grafico Gantt.
• Attività. Elenca le attività così com'erano quando è stata acquisita l'istantanea, incluse
le informazioni su avanzamento, stato e attività.

• Risultati finali. Mostra i risultati finali e i relativi stati del ciclo di vita.
• Fogli ore. Visualizza i fogli ore collegati al progetto.
• Risorse. Elenca le risorse assegnate al progetto al momento dell'istantanea.

Creazione di istantanee del progetto

1. Modificare un oggetto di progetto.
2. Nello strumento Amministrazione sistema, aprire Creazione guidata processo.
3. Nella pagina Scheda Proprietà:

a) Selezionare Istantanee.
b) Selezionare gli utenti o i gruppi per accedere alla scheda Istantanee.
c) Fare clic su Avanti e apportare eventuali altre modifiche all'oggetto di progetto.

4. Selezionare la pagina della procedura guidata completata e fare clic su Fine.
5. Aprire un record di progetto ed eseguire il check-out.
6. Nella scheda Istantanee, fare clic su Nuova.
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7. Immettere un nome e un commento per l'istantanea.

L'istantanea viene visualizzata nell'elenco con il record corrente.

8. Apportare modifiche al record del progetto.
Ad esempio, aggiungere una fase di progetto e le attività per la nuova fase.

9. Fare clic su Salva.
10. Selezionare la scheda Istantanee.
11. Selezionare l'istantanea e il record corrente, quindi confrontare le informazioni nella

scheda Pianificazione.

Operazioni da processi annullati
È possibile controllare lo stato delle operazioni associate dai processi annullati. In questo
modo si eliminano le operazioni rimanenti che è possibile vedere dopo l'annullamento dei
processi. È possibile lasciare invariate le operazioni modificate, non modificate o
completate, eliminarle o modificarle in completate quando il processo associato viene
annullato.

Per specificare cosa fare per le operazioni da processi annullati:

1. Nello strumento Amministrazione sistema, aprire Creazione guidata processo.
2. Nella pagina Opzioni, in Opzioni operazioni, specificare le opzioni per Quando un

processo viene annullato.

API di SolidWorks
È disponibile un'API basata sul Web. È possibile utilizzare l'API per ottenere i dati da
SOLIDWORKS Manage e aggiornare o aggiungere record.

L'API viene installata tramite il programma di installazione di SOLIDWORKS Manage Server
nella Gestione installazioni di SOLIDWORKS. È possibile accedere alla documentazione
sul sito Web incluso in Internet Information Services (IIS) tramite il collegamento Sfoglia
sito Web.

Creazione di nuovi record di processo da record di processo esistenti
È possibile creare nuovi record di processo da record di processo esistenti per acquisire
i valori dei campi e altri attributi dal record di origine.

1. Nella griglia principale di un oggetto di processo, fare clic con il pulsante destro del
mouse su un record di processo esistente e selezionare Nuovo da.

2. Apportare modifiche nell'area delle proprietà e selezionare il contenuto da copiare in
Cosa si desidera copiare?.

3. Fare clic su OK.

Inviare al processo gli elementi interessati
È possibile inviare gli elementi interessati da un processo a un nuovo processo.
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Il nuovo processo può essere qualsiasi processo che accetta i tipi di record selezionati.

Se gli elementi interessati selezionati sono in un processo che non è stato completato,
ma gli elementi interessati hanno un outputModifica stato, non è possibile aggiungere
gli elementi interessati a un nuovo processo che presenta anche un output Modifica
stato.

1. Selezionare un record di processo esistente o aprirne la scheda di proprietà.
2. Nella scheda Elementi interessati, fare clic con il pulsante destro del mouse sul record

di un elemento interessato e selezionare Invia a processo.

È possibile selezionare più elementi interessati.

3. Nella finestra di dialogo Seleziona, selezionare un oggetto di processo per il nuovo
record del processo.

Viene visualizzato il nuovo record del processo con i record selezionati aggiunti come
elementi interessati.

Elementi interessati in Esplora file di Microsoft
È possibile accedere alla posizione di Esplora file di Microsoft® per un file SOLIDWORKS
PDM che è un elemento interessato in un processo.

1. Selezionare un record di processo esistente o aprirne la scheda di proprietà.
2. Nella scheda Elementi interessati, fare clic con il pulsante destro del mouse sul record

di un elemento interessato e selezionare Mostra in Esplora risorse.

Esplora risorse si apre con l'elemento interessato selezionato.

Miniature per distinte dei materiali con Copia da
Quando si copiano i dati in una distinta dei materiali (BOM) utilizzando Copia da, la
finestra di dialogo Seleziona record include immagini in miniatura nell'area dei risultati
della ricerca. Le miniature facilitano la comprensione dei dati copiati.

Installazione dell'API Web di SOLIDWORKS Manage
È possibile installare l'API Web Manage nell'installazione guidata InstallShield di
SOLIDWORKS PDM. Durante l'installazione, è possibile utilizzare la porta predefinita o
specificare un altro valore per la porta HTTP.

Inoltre, nella Gestione installazioni di SOLIDWORKS, è possibile installare l'API Web
Manage nella pagina SOLIDWORKS Manage Server e specificare la porta HTTP.
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SOLIDWORKS Simulation

Questo capitolo comprende i seguenti argomenti:

• Rilevamento automatico di corpi sotto vincolo
• Interazioni di unione con offset
• Rigidità della penalità di contatto per shell
• Controllo della rigidità di penalità di contatto per studi non lineari
• Connettore di saldatura del bordo
• Connettore a perno migliorato
• Escludere corpi dall'analisi
• Connettore a molla generale
• Correzione della geometria per l'unione da superficie a superficie
• Mesh

SOLIDWORKS® Simulation Standard, SOLIDWORKS Simulation Professional e SOLIDWORKS
Simulation Premium sono prodotti acquistabili separatamente che possono essere usati con
SOLIDWORKS Standard, SOLIDWORKS Professional, SOLIDWORKS Premium e SOLIDWORKS
Ultimate.

Rilevamento automatico di corpi sotto vincolo
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È possibile rilevare le modalità del corpo rigido nella fase iniziale della soluzione di uno
studio statico lineare.

L'opzione Rileva automaticamente corpi sotto vincolo è disponibile nella finestra di
dialogo Opzioni del sistema - Generale. Questa opzione rileva i corpi che non sono
sufficientemente vincolati durante la simulazione e che possono presentare modalità del
corpo rigido di tipo traslazionale o rotazionale.

Quando il solutore rileva le modalità del corpo rigido, è possibile continuare con la soluzione
oppure interrompere la soluzione e rivedere le modalità rigide utilizzando lo strumento
Corpi sotto vincolo.

Il rilevamento automatico dei corpi rigidi è disponibile per gli studi statici lineari.

Interazioni di unione con offset

L'applicazione delle interazioni di unione da nodo a superficie tra le geometrie all'interno
di un gioco definito dall'utente è stata migliorata.

Questo miglioramento migliora la precisione dell'offset di unione definito dall'utente da
un Intervallo di gioco per unione. È possibile prevedere una migliore precisione della
soluzione per tutte le interazioni di unione (da solido a solido, da shell a shell e da shell
a solido) basate su mesh di qualità bozza o di alta qualità. Gli studi che supportano questo
miglioramento includono statica lineare, frequenza, carico di punta, dinamica lineare,
fatica, scenario di progettazione e recipiente a pressione.
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Rigidità della penalità di contatto per shell

Viene introdotto un nuovo algoritmo per applicare la rigidità della penalità per le interazioni
di contatto delle shell. Questo miglioramento migliora le prestazioni e la precisione per
un'ampia gamma di rapporti di spessore dello shell.

Rapporto spessore shell = spessore shell/lunghezza caratteristica dello shell

L'immagine mostra il miglioramento delle prestazioni per le interazioni di contatto in base
a diversi rapporti di spessore dello shell.

La magnitudine di forza applicata a ciascun caso di prova è stata regolata per i diversi
rapporti di spessore dello shell/lunghezza dello shell per mantenere un piccolo intervallo
di spostamento e spostamenti massimi simili in tutti casi di prova.
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spessore dello shell/lunghezza dello shell =
0,05

spessore dello shell/lunghezza dello shell =
0,1

spessore dello shell/lunghezza dello shell =
0,001

spessore dello shell/lunghezza dello shell =
0,01

La rigidità della penalità si applica al contatto da shell a shell, da solido a shell, da superficie
a superficie e da bordo a superficie negli studi statici lineari.

Controllo della rigidità di penalità di contatto per studi non lineari

È possibile regolare un fattore di scala per la rigidità di penalità applicata alle interazioni
di contatto da superficie a superficie quando si risolvono studi non lineari.

Il valore predefinito per il fattore di rigidità della penalità di contatto è 1,0, che fornisce
la soluzione più accurata. Per ottenere una soluzione approssimativa e valutare le iterazioni
di progettazione più rapidamente, è possibile specificare un valore inferiore a 1,0.
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È possibile impostare il fattore di scala a livello di studio per la rigidità di penalità nella
finestra di dialogo Non lineare - Statico.

Connettore di saldatura del bordo

Diversi miglioramenti apportati al connettore di saldatura del bordo ne ottimizzano
l'usabilità.

• Il programma calcola la Dimensione gola saldatura stimata quando si definiscono
i connettori di saldatura del bordo nel PropertyManager Connettore di saldatura del
bordo. Le formule per il calcolo della Dimensione gola saldatura stimata sono
riportate nella tabella.

Dimensione gola saldatura stimataTipo di saldatura

Dimensione di saldatura valutata * radice
quadrata (2)

Raccordo

Dimensione di saldatura valutataSede per guarnizione

• Le icone per l'Orientamento della saldatura nel PropertyManager Connettore di
saldatura del bordo per il tipo di connettori Giunto o cordone di testa - Un solo lato
sono aggiornati per mostrare una rappresentazione precisa del tipo di saldatura del
bordo.

• L'annotazione Grafico di controllo saldatura elenca anche la Dimensione gola
saldatura calcolata e la Dimensione gola saldatura stimata per ciascun connettore
di saldatura del bordo.
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Connettore a perno migliorato

L'introduzione di un algoritmo di accoppiamento distribuito migliora le prestazioni degli
studi che utilizzano connettori a perno.

I risultati degli studi con connettori a perno applicati alle superfici cilindriche con un
numero elevato di nodi e che utilizzano la connessione distribuita sono più precisi.

Il tempo di risoluzione per questi studi è migliorato con il solutore Intel Direct Sparse.
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Nelle versioni precedenti, quando il numero di nodi era molto grande, solo un sottoinsieme
dei nodi partecipava ai vincoli di accoppiamento distribuiti. In SOLIDWORKS Simulation
2025, i vincoli di accoppiamento distribuiti per i connettori a perno includono tutti i nodi
sulle superfici cilindriche.

Il tempo di risoluzione con il solutore iterativo FFEPlus per studi simili è invariato in
SOLIDWORKS Simulation 2025. Tuttavia, i risultati di sollecitazione sono più precisi
poiché tutti i nodi vengono considerati nella formulazione di accoppiamento distribuito.

Questo miglioramento è disponibile per gli studi statici lineari, insieme agli studi di
progettazione del recipiente associati a fatica, progettazione e pressione.

Escludere corpi dall'analisi

È possibile escludere più corpi da un'analisi.

Da un albero dello studio di simulazione, selezionare una cartella nel nodo Parti e utilizzare
il menu di scelta rapida per escludere dall'analisi tutti i corpi nella cartella selezionata.
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Connettore a molla generale

È possibile specificare un connettore a molla generale tra superfici cilindriche piatte, non
piatte e concentriche.

Il connettore a molla generale utilizza un accoppiamento distribuito per stabilire una
formulazione migliorata del connettore a molla che migliora le prestazioni e la precisione
degli studi di simulazione.

Per rappresentare con precisione il connettore a molla generale, è possibile definire fino
a sei parametri di rigidità utilizzando un sistema di coordinate locale.

Il connettore a molla generale è disponibile con SOLIDWORKS Simulation Professional e
SOLIDWORKS Simulation Premium.

Per aprire il PropertyManager Molla generale:

Nell'albero dello studio di simulazione, fare clic con il pulsante destro del mouse su

Connessioni e fare clic su Molla generale .

207

SOLIDWORKS Simulation



Correzione della geometria per l'unione da superficie a superficie

La precisione della simulazione è migliorata per gli studi con superfici curve unite
(formulazione unione superficie su superficie) quando le dimensioni della mesh delle
superfici di origine e di destinazione sono diverse.

L'algoritmo che impone l'unione superficie su superficie integra i fattori di correzione della
geometria che migliorano la rappresentazione delle superfici curve di geometrie cilindriche,
sferiche e coniche. L'integrazione della correzione della geometria della superficie riduce
il rumore di sollecitazione in prossimità di superfici curve unite, migliorando così la
precisione della soluzione.

L'immagine qui sopra mostra la riduzione del rumore di sollecitazione al limite in cui viene
applicata l'unione solido su solido con correzione della geometria tra due superfici curve.
La geometria delle superfici unite è mostrata nell'immagine seguente.

208

SOLIDWORKS Simulation



Gli studi che supportano questo miglioramento includono statica lineare, frequenza, carico
di punta, dinamica lineare, fatica, scenario di progettazione e recipiente a pressione.

Mesh

Il tempo di mesh totale con il mesher basato su curvatura alternativa viene ridotto per
gli assiemi che hanno più parti identiche.

Il mesher basato sulla curvatura alternativa crea una volta i nodi intermedi degli elementi
di ordine superiore e riutilizza le posizioni dei nodi intermedi tra parti identiche ripetute,
risparmiando così tempo di mesh. Il miglioramento alle prestazioni della mesh è più
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evidente negli assiemi con molte parti ripetute composti da superfici curve e mesh di alta
qualità.

L'immagine mostra la riduzione del tempo totale della mesh per un assieme con 450 parti.
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SOLIDWORKS Visualize

Questo capitolo comprende i seguenti argomenti:

• Divisione di parti (2025 SP3)
• Importazione migliorata delle informazioni sull'aspetto PBR per il formato glTF e

USDZ e supporto per SketchUp 2024 (2025 SP3)
• Aggiornamento dei controlli delle informazioni di sistema e rimozione del requisito

della versione di OpenCL (2025 SP3)
• Supporto Denoiser per il rendering della CPU in Stellar Engine (2025 SP2)
• Posizione casuale, rotazione e scala per gli oggetti (2025 SP2)
• Miglioramento delle immagini con Effetto Bokeh della fotocamera (2025 SP1)
• Aggiornamenti in modalità rapida per motore di rendering Stellar (2025 SP1)
• Miglioramenti relativi all'importazione (2025 SP1)
• Aggiornamenti agli aspetti di Shading Model DSPBR (2025 SP1)
• Supporto per rendering distribuito in SOLIDWORKS Visualize Connected (2025

SP1)
• Dissolvenza del piano
• Aggiunta della modalità Rendering veloce per Stellar
• Selezione del motore di rendering
• Rendering fotorealistico in SOLIDWORKS con l'API SOLIDWORKS Visualize
• Riprogettazione di Visualize Boost

SOLIDWORKS® Visualize è un prodotto acquistabile separatamente che può essere utilizzato
con SOLIDWORKS Standard, SOLIDWORKS Professional, SOLIDWORKS Premium e
SOLIDWORKS Ultimate o come applicazione completamente separata.
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Divisione di parti (2025 SP3)

Ulteriori opzioni consentono di personalizzare la funzionalità di divisione delle parti quando
si selezionano sfaccettature in parti di grandi dimensioni.

La suddivisione è essenziale perché non è possibile assegnare gli aspetti alle facce (o a
qualsiasi altro elemento nella gerarchia inferiore al livello della parte). Se si desidera
assegnare più aspetti a una singola parte, è necessaria la suddivisione.

Quando si utilizza la suddivisione di parti, è possibile:

• Vedere più facilmente la geometria. SOLIDWORKS Visualize esegue il rendering di
tutte le parti della scena in struttura a reticolo su uno sfondo scuro per una migliore
comprensione della struttura della mesh sottostante.

• Specificare le parti da dividere. Il software mostra un'anteprima della mesh divisa in
struttura a reticolo blu e la parte da dividere in struttura a reticolo rossa. Tutte le parti
che non sono presenti nella visualizzazione della suddivisione delle parti vengono
visualizzate come strutture a reticolo sbiadite.

• Utilizzare gli strumenti specificati per avere un maggiore controllo sulla selezione delle
facce. È possibile specificare la Sfaccettatura o laModalità pennello per selezionare
le facce.

Per dividere le parti:

1. Effettuare una delle seguenti operazioni:

• Fare clic su Strumenti > Dividi parte.
• Nella finestra o nella tavolozza, fare clic con il pulsante destro del mouse su una
parte e fare clic su Modifica > Dividi parte.

• Premere CTRL+ALT+P.

2. Nella finestra di dialogo, specificare la Modalità di selezione:
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DescrizioneOpzione

Permette di fare clic sulle sfaccettature delle parti da
dividere. Regolare la Tolleranza angolo
sfaccettatura per specificare la tolleranza di parte.

È possibile utilizzare la selezione di caselle anche in
modalità Sfaccettatura.

Sfaccettatura

Consente di fare clic e trascinare per selezionare più
sfaccettature di parti da dividere. Regolare il Raggio

Pennello

del pennello per regolare con precisione l'area di
selezione.

Visualizza solo la mesh divisa e la parte che subisce
la divisione, anziché l'intera parte. La geometria

Mostra solo parte attiva

rimanente viene nascosta o renderizzata in struttura
a reticolo grigia.

3. Nella finestra, fare clic su una faccia o trascinare un'area di selezione per visualizzare
un'anteprima della parte divisa.

La mesh divisa diventa una struttura a reticolo blu e la parte che subisce la divisione
diventa una struttura a reticolo rossa.

4. Opzionale: premere MAIUSC per rimuovere porzioni dalla selezione della mesh o
CTRL per aggiungere porzioni alla selezione della mesh.

5. Fare clic su Esegui divisione.

Importazione migliorata delle informazioni sull'aspetto PBR per il formato glTF
e USDZ e supporto per SketchUp 2024 (2025 SP3)
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È possibile ottenere risultati migliori quando si importano materiali Physically Based
Rendering (PBR) da file glTF e USDZ in SOLIDWORKS Visualize. Questo supporto fornisce
aspetti più dettagliati e realistici.

Vantaggi: i modelli importati appaiono più realistici grazie ai dettagli dei materiali
migliorati. È inoltre possibile aprire i file di SketchUp 2024 direttamente in SOLIDWORKS
Visualize.

Crediti e licenze:

• © 2023, Darmstadt Graphics Group GmbH. CC BY 4.0 International

• Modello e texture a cura di Eric Chadwic

• © 2015, Khronos Group. Marchio o logo Khronos

• Logo non soggetto a copyright per il logo Khronos

• © 2017, Khronos Group. Marchio o logo Khronos

• Logo non soggetto a copyright per il logo glTF

Aggiornamento dei controlli delle informazioni di sistema e rimozione del
requisito della versione di OpenCL (2025 SP3)

I requisiti hardware sono stati semplificati e aggiornati con le modalità 3DS Stellar Fast
e Accurate e con la modalità AMD ProRender Accurate.

Vantaggi: questi aggiornamenti aiutano a garantire che il computer soddisfi i requisiti
di rendering attuali e evitare potenziali problemi.

La finestra di dialogo Informazioni di sistema include i seguenti aggiornamenti:

Requisito aggiornatoRequisito precedenteComponente

16 GB8 GBMemoria di sistema

10 GB2 GBSpazio libero su disco

4 GB1 GBMemoria grafica

1.3 richiesta per 3DS Stellar
Fast

Versione Vulkan

1.2 richiesta per AMD
ProRender

Non più necessario1.2 o superioreVersione OpenCL

Fare riferimento ai Requisiti di sistema più recenti di SOLIDWORKS Visualize per
un'analisi dettagliata.

Avviso di inizializzazione del raytracing: se non si è mai utilizzato il raytracing, viene
visualizzato un avviso sotto la voce Strumenti > Opzioni > Finestra 3D nell'opzione
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Dispositivo di rendering. È necessario inizializzare il motore di rendering prima di
selezionare un dispositivo GPU.

Il motore di rendering si inizializza automaticamente la prima volta che si passa a una
modalità di rendering in raytracing come 3DS Stellar Accurate o AMD ProRender.

Supporto Denoiser per il rendering della CPU in Stellar Engine (2025 SP2)

SOLIDWORKS Visualize supporta la rimozione del rumore della CPU con il motore 3DS
Stellar Physically Correct.

Vantaggi: La riduzione del rumore riduce il disturbo e migliora la qualità del rendering
con un minor numero di passaggi, aiutando gli utenti della CPU a ottenere più rapidamente
risultati più puliti. In precedenza, la rimozione del rumore era disponibile solo per il
rendering GPU.

Le modifiche principali includono:

• La possibilità di attivare e disattivare il denoiser in modalità CPU.
• Le opzioni Inizializza Denoiser e Mostra pulsante nella barra degli strumenti

principale sono state rimosse dalla sezione Strumenti > Opzioni > Punto di vista
3D > Denoiser.

• Il denoiser è sempre disponibile nella barra degli strumenti principale durante
l'utilizzo:

• 3DS Stellar Physically Correct (CPU o GPU)
• AMD Radeon™ ProRender (GPU)

• È possibile regolare il passaggio iniziale del denoiser in Strumenti > Opzioni >
Punto di vista 3D > Denoiser.
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• Quando si utilizza 3DS Stellar Physically Correct in modalità veloce, la riduzione del
rumore è sempre abilitata e non può essere disattivata. Il pulsante Denoiser nella barra
degli strumenti principale rimane visibile ma disattivato, con una descrizione del suo
stato.

Posizione casuale, rotazione e scala per gli oggetti (2025 SP2)

È possibile applicare facilmente una quantità casuale di valori di posizione, rotazione e
scala a un gruppo di istanze di ripetizione e ad altri oggetti selezionati.

Vantaggi: Questa funzione aiuta a creare rendering più realistici quando si ha a che fare
con collezioni di oggetti uguali, modificando in modo casuale la loro posizione, rotazione
o scala.

È possibile randomizzare:

• Posizione (X, Y, Z): regola la posizione degli oggetti in modo casuale sull'asse
selezionato.

• Rotazione (X, Y, Z): regola la rotazione degli oggetti in modo casuale intorno all'asse
selezionato.

• Scala (X, Y, Z): regola la scala degli oggetti in modo casuale sull'asse selezionato.
• Ridimensiona tutto: regola la scala degli oggetti su tutti gli assi con un valore casuale.

È possibile randomizzare le trasformazioni quando si selezionano più parti, gruppi o
modelli. Quando si attiva la funzione Randomizza nello strumento Trasformazione
relativa, ogni oggetto ottiene un valore casuale diverso all'interno dell'intervallo scelto.
Ad esempio:

• Posizione: gli oggetti si spostano in modo casuale +/- il valore immesso.
• Rotazione: gli oggetti ruotano in modo casuale +/- intorno all'asse selezionato.
• Scala: gli oggetti vengono ridimensionati in modo casuale all'interno dell'intervallo
specificato. Se il valore è inferiore a 1,0, gli oggetti vengono ridimensionati tra quel
valore e 1,0. Se il valore è superiore a 1,0, la scala dell'oggetto è compresa tra 1,0 e
il valore immesso.
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• Ridimensiona tutto: gli oggetti si ridimensionano in modo casuale su tutti gli assi.
Se il valore è inferiore a 1,0, gli oggetti vengono ridimensionati tra quel valore e 1,0.
Se il valore è superiore a 1,0, la scala dell'oggetto è compresa tra 1,0 e il valore
immesso.

• Serie randomizzata: ogni serie randomizzata genera un insieme univoco di valori
casuali. L'utilizzo della stessa serie randomizzata genera sempre gli stessi valori casuali.
Questo è utile quando si trova una serie che offre un risultato soddisfacente. È possibile
riutilizzarla per ottenere lo stesso risultato per un dato input

Miglioramento delle immagini con Effetto Bokeh della fotocamera (2025 SP1)

L'Effetto Bokeh della Profondità di campo, visibile nella fotografia e nel rendering 3D,
crea una sfocatura nelle aree fuori fuoco, conferendo alle aree luminose una forma morbida
e circolare o poligonale. Ad esempio, è possibile pensare alle luci sfocate in un contesto
notturno. Nella fotografia tradizionale, le lamelle dell'apertura dell'obiettivo hanno la
forma di queste aree luminose.

Con SOLIDWORKS Visualize, è possibile ottimizzare questo effetto regolando il Numero
lamelle e l'Angolo lamelle, così da permettere di personalizzare la forma delle aree
luminose Bokeh. Per accedere a questi parametri, andare a Tavolozza > Fotocamera
> Generale > Profondità del campo e selezionare sia Profondità di campo sia Effetto
Bokeh.

• Numero lamelle: Specifica il numero di lamelle di apertura che danno forma al Bokeh.
Valori più elevati determinano un effetto più uniforme e circolare.

• Angolo lamelle: Regola l'orientamento dell'Effetto Bokeh da 0° a 360°.
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Aggiornamenti in modalità rapida per motore di rendering Stellar (2025 SP1)

Gli ultimi aggiornamenti alla modalità Rapida per il motore di rendering Stellar migliorano
le prestazioni, la facilità d'uso e l'accesso alle impostazioni critiche.

• Upscaling AI.

• La modalità Rapida consente di bilanciare prestazioni e qualità visiva. A seconda
dell'hardware in uso, l'opzione non viene visualizzata.

• Automatico regola la modalità di Upscaling AI in base alla risoluzione della vista.
Questa opzione è utile se si modifica frequentemente la dimensione della vista.

• La Velocità ottimizza la reattività con dettagli con un livello di definizione inferiore.
La Qualità offre una grafica più nitida con prestazioni ridotte. Spostando il cursore
tra queste opzioni si ottiene un equilibrio intermedio tra l'interattività e la chiarezza
dell'immagine.

• Sfocatura movimento fotocamera.

Aggiungendo una sfocatura naturale agli oggetti in movimento, la modalità Rapida
crea una grafica più fluida mantenendo le prestazioni inalterate.

• Controlli semplificati.

Non è più necessario specificare i limiti di superamento o il tempo nella procedura
guidata di rendering per i rendering finali. Questa rimozione garantisce risultati di alta
qualità e consente di concentrarsi maggiormente sulla creatività.
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Miglioramenti relativi all'importazione (2025 SP1)

I miglioramenti apportati all'importazione in SOLIDWORKS Visualize migliorano il
caricamento dei formati e offrono un maggiore controllo sulla qualità di rifinitura della
mesh.

SOLIDWORKS Visualize utilizza un nuovo componente di caricamento del formato che
sostituisce i metodi di importazione precedenti. Questo aggiornamento migliora la qualità
della rifinitura della mesh per una maggiore precisione e livello di dettaglio durante
l'importazione. Inoltre, gestisce in modo più efficiente materiali, texture e tipi di file
specifici, accelerando il caricamento della visualizzazione. In più, l'esperienza di rifinitura
della mesh è progettata per allinearsi sempre più a SOLIDWORKS, offrendo un flusso di
lavoro più coerente.

La scheda Geometria nella finestra di dialogo Impostazioni di importazione offre le seguenti
modalità di Rifinitura mesh:

• Predefinito

Offre la massima velocità di importazione preservando al contempo le proprietà
complete del materiale, incluse le texture. Questa modalità utilizza i dati di tessellatura
esistenti o le impostazioni predefinite.

• Semplice

Supporta la rifinitura della mesh di base con proprietà del materiale limitate (solo
colore). È possibile regolare la rifinitura della mesh utilizzando un singolo cursore e
successivamente ridefinire parte del modello utilizzando la scheda Modelli nella
Tavolozza, che offre gli stessi controlli di Rifinitura mesh.

• Avanzata

Offre maggiore flessibilità per personalizzare le impostazioni di rifinitura della mesh,
anche se le proprietà del materiale sono limitate solo al colore. Simile alla modalità
Semplice, questa modalità consente di ridefinire parti del modello dopo l'importazione
utilizzando la scheda Modelli nella Tavolozza.
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Aggiornamenti agli aspetti di Shading Model DSPBR (2025 SP1)

SOLIDWORKS Visualize ottimizza i flussi di lavoro di aspetto per Shading Model DSPBR
con i parametri Colore traslucenza e Pellicola sottile.

Questi parametri offrono un maggiore controllo sul modo in cui la luce interagisce con i
materiali:

• Colore traslucenza consente di aggiungere un colore diffuso ai materiali trasparenti,
in modo simile a Colore della sottosuperficie. È utile per simulare oggetti come
tende traslucide.

• L'effetto Pellicola sottile simula la diffrazione luminosa, creando motivi colorati sui
materiali. È ideale per effetti quali bolle di sapone o olio sull'acqua.

Per gli aspetti DSPBR precedenti, fare clic sul pulsante Converti accanto a Tipo di aspetto
per aggiornare tali aspetti e accedere alle ultime funzionalità e controlli disponibili. Una
descrizione comandi mostra la versione corrente e la versione in cui verranno convertiti.
I nuovi aspetti includono automaticamente questi parametri nell'interfaccia utente.

Supporto per rendering distribuito in SOLIDWORKS Visualize Connected
(2025 SP1)

SOLIDWORKS Visualize Connected supporta il rendering distribuito tramite Visualize
Boost.

Per semplificare questa funzionalità, l'interfaccia SOLIDWORKS Visualize Connected include
controlli Boost identici a quelli dell'app desktop SOLIDWORKS Visualize.

• Strumenti > Opzioni > Boost

La scheda Boost visualizza l'Indirizzo IP coordinatore, la Porta Boost e lo Stato
Boost per facilitare l'accesso e la gestione.
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• Vista con preavviso (HUD, Heads-Up Display) e Procedura guidata di rendering
> Qualità

Queste aree includono i controlli Stato Boost, che offrono visibilità sull'attività e sullo
stato del Boost durante il rendering.

Eseguire Visualize Boost su un computer diverso da quello in cui è installato
SOLIDWORKS Visualize Connected.

Per informazioni dettagliate sull'installazione e la configurazione di Visualize Boost,
vedere Riprogettazione di Visualize Boost e la Guida in linea di SOLIDWORKS
Visualize.

Dissolvenza del piano

In SOLIDWORKS Visualize, è possibile dissolvere il piano in modo simile alla dissolvenza
delle parti. Ciò rende il terreno invisibile pur continuando a influenzare i riflessi e
l'ombreggiatura delle parti vicine.
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Abilitato, dissolvenzaAbilitato, nessuna dissolvenza

Durante la modifica e la post-elaborazione, in alcune occasioni è necessario nascondere
il piano. Ciò può alterare la rappresentazione visiva delle parti a causa dell'assenza di
interazioni tra il piano e le parti.

È possibile accedere alla proprietà Dissolvenza Tavolozza > Scene > Avanzate >
Rilevatore ombre sul terreno.

Questa funzione è supportata esclusivamente in modalità Accurato e non è accessibile
in modalità Anteprima o Veloce.

Aggiunta della modalità Rendering veloce per Stellar

SOLIDWORKS Visualize offre il rendering in modalità Veloce con il motore di rendering
Stellar, per un rendering interattivo in tempo reale per la vista di Visualize e i rendering
offline.

Utilizza l'API di raytracing Vulkan e la tecnologia d'intelligenza artificiale Deep Learning
per ottenere prestazioni di raytracing in tempo reale, rendendolo ideale per schede video
di nuova generazione e risoluzioni elevate.
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Selezione del motore di rendering

Con il completamento dell'implementazione del motore di rendering Stellar Physically
Correct, SOLIDWORKS Visualize ha interrotto il supporto per NVIDIA Iray.

Di conseguenza, l'opzione per scegliere NVIDIA Iray come motore di rendering è stata
rimossa dal menu Strumenti > Opzioni, in modo che gli utenti non possano più
selezionarla.

Rendering fotorealistico in SOLIDWORKS con l'API SOLIDWORKSVisualize
Utilizzando l'API di SOLIDWORKS Visualize, è possibile creare funzionalità per il rendering
fotorealistico dei modelli SOLIDWORKS.

Questa API, disponibile tramite l'aggiunta SOLIDWORKS Visualize, consente di eseguire
il rendering dei documenti SOLIDWORKS o convertirli in file di progetto Visualize.

Per assistenza API, fare clic su Guida in linea > Guida in linea API.
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Riprogettazione di Visualize Boost

Visualize Boost è stato sottoposto a una significativa riprogettazione, introducendo
funzionalità avanzate personalizzate per la gestione delle attività di rendering di
SOLIDWORKS Visualize su più macchine.

Grazie a un processo di configurazione semplificato e intuitivo, la configurazione dei
processi di rendering in una rete è più efficiente che mai.

L'ultima versione di Visualize Boost vanta un'interfaccia di configurazione intuitiva,
un'individuazione delle macchine semplificata e una maggiore stabilità.

Per installare e configurare Visualize Boost:

1. Utilizzare la Gestione installazioni di SOLIDWORKS per installare Boost su uno o più
computer accessibili in rete.

2. Su ciascuna macchina Boost, procedere come indicato di seguito:

a. Avviare SOLIDWORKS Visualize Boost 2025.
b. Andare su File > Impostazioni.
c. Per una macchina, selezionare Coordinatore per renderlo il nodo coordinatore.

Lasciare la casella di controllo Coordinatore deselezionata per tutti gli altri nodi
Boost.

d. Per i nodi Boost non coordinatori, immettere l'indirizzo IP coordinatore.
e. Fare clic su Applica.

3. In SOLIDWORKS Visualize, andare a Strumenti > Opzioni > Boost e immettere
l'indirizzo IP coordinatore.

4. Fare clic su Connetti a.

Una volta connesso, è possibile scegliere Boost Renderer nella pagina Configurazione
guidata/qualità rendering per avviare un rendering distribuito in rete.
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19
SOLIDWORKS CAM

Questo capitolo comprende i seguenti argomenti:

• Percorsi utensile per la contornatura dal basso verso l'alto
• Riconoscimento automatico delle funzioni di tornitura
• Legende ancorabili per simulazioni di percorsi utensili

SOLIDWORKS® CAM è disponibile in due versioni. SOLIDWORKS CAM Standard è incluso con
qualsiasi licenza SOLIDWORKS che dispone dei servizi di abbonamento SOLIDWORKS.

SOLIDWORKS CAM Professional è disponibile come prodotto acquistabile separatamente che
può essere utilizzato con SOLIDWORKS Standard, SOLIDWORKS Professional, SOLIDWORKS
Premium e SOLIDWORKS Ultimate.

Percorsi utensile per la contornatura dal basso verso l'alto
È possibile specificare un'opzione per generare percorsi utensile per la contornatura dal
basso verso l'alto per le funzioni di fresatura a 2,5 assi.

Questa opzione aiuta durante la lavorazione:

• Caratteristiche coniche
• Funzioni delle scanalature a T (gli utensili consigliati per tali funzioni includono gli
utensili lollipop e fresa a T).

Per specificare questa opzione:

1. Nella finestra di dialogo Parametri operativi, nella scheda Contorno, in Elaborazione
profondità, selezionare Dal basso verso l'alto.
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Riconoscimento automatico delle funzioni di tornitura

Sono disponibili opzioni per il riconoscimento delle funzioni di tornitura tramite il
riconoscimento automatico delle funzioni (AFR).

Nelle versioni precedenti, quando si utilizzava l'AFR con lo strumento Estrai feature
lavorabili (EMF), SOLIDWORKS CAM ha riconosciuto tutte le funzioni di tornitura nel
modello. Impossibile controllare quali tipi di funzione riconoscere.

Per specificare queste opzioni:

1. Fare clic su Strumenti > SOLIDWORKS CAM > Opzioni.
2. Nella finestra di dialogo, nella scheda Funzioni di tornitura, in Estrai feature

lavorabili, specificare le opzioni Tipi di funzione.

DescrizioneOpzione

Riconosce i diametri esterni (OD) del profilo nella parte attiva
tramite lo strumento Estrai feature lavorabili.

OD profilo

Riconosce i diametri interni (ID) del profilo nella parte attiva
tramite lo strumento Estrai feature lavorabili.

ID del profilo
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DescrizioneOpzione

Riconosce le spianature a seconda del tipo di grezzo:
• Barra grezza tonda. Riconosce una spianatura singola
all'inizio del modello di parte.

• Qualsiasi tipo di grezzo diverso da quello con barra grezza
tonda. Riconosce:

• Spianature all'inizio del modello di parte. (Queste
funzioni sono visualizzate sotto lo stesso Setup
tornitura delle altre funzioni di tornitura riconosciute.)

• Spianature alla fine del modello di parte. (Queste
funzioni sono visualizzate nel Setup tornitura inverso.)

Se deselezionata, il software non crea una spianatura in
Setup tornitura. È possibile aggiungere spianature
utilizzando il riconoscimento interattivo delle funzioni.

Spianatura

Riconosce le sedi per guarnizione nella parte attiva tramite
lo strumento Estrai feature lavorabili.

Sede per
guarnizione

Riconosce il tipo specificato di funzioni di taglio:
• Barra grezza. Se il tipo di grezzo è una barra grezza,
riconosce le funzioni Taglio con lo stesso Setup tornitura
delle altre funzioni riconosciute.

• Altri tipi di grezzo. Se il tipo di grezzo è diverso da una
barra tonda, riconosce le funzioni Taglio nello stesso Setup
tornitura delle altre funzioni riconosciute.

Taglio
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Legende ancorabili per simulazioni di percorsi utensili

Durante le simulazioni del percorso utensile, è possibile spostare la legenda che mostra
il confronto grafico della parte lavorata e della parte di progetto.

Nel PropertyManager Simula percorso utensile, in Opzioni di visualizzazione, fare clic
su Mostra differenza . Nell'area grafica, è possibile spostare la legenda.
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20
CircuitWorks

Questo capitolo comprende i seguenti argomenti:

• Annullare le ultime modifiche MCAD in CircuitWorks (2025 SP1)
• Ripristino dello stato di collaborazione dopo il riavvio o l'arresto anomalo di

SOLIDWORKS (2025 SP1)

CircuitWorks™ è disponibile in SOLIDWORKS® Standard, SOLIDWORKS Professional,
SOLIDWORKS Premium e SOLIDWORKS Ultimate.

Annullare le ultime modifiche MCAD in CircuitWorks (2025 SP1)

È ora possibile annullare le ultime modifiche MCAD se ECAD non ha iniziato a lavorare su
di esse.

Quando MCAD propone una modifica, è possibile annullarla nella sezione Collaborazione
EDMD se ECAD non ha elaborato l'attività. In questo modo, SOLIDWORKS e CircuitWorks
vengono ripristinati all'ultimo stato sincronizzato.

Vantaggi:

• Consente di annullare le modifiche MCAD non necessarie o non corrette per mantenere
sincronizzati CircuitWorks e SOLIDWORKS.
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• Consente di tornare facilmente a uno stato precedente senza influire su altre attività
in corso.

Per ripristinare le modifiche MCAD:

1. In CircuitWorks, selezionare la sezione Collaborazione EDMD.
2. Fare clic su Ripristina modifiche MCAD.

Ripristina modifiche MCAD è disponibile solo nel caso in cui MCAD abbia effettuato
la modifica più recente.

Ripristino dello stato di collaborazione dopo il riavvio o l'arresto anomalo di
SOLIDWORKS (2025 SP1)

CircuitWorks include ora una funzione di ripristino della collaborazione che consente di
riprendere la collaborazione ECAD e MCAD senza problemi in caso di riavvio o arresto
anomalo di SOLIDWORKS.

Dopo un riavvio o un arresto anomalo, aprire il primo file di backup nella cartella
Collaborazione EDMD (identificare file base .idx in base all'indicazione di data e ora) per
riprendere la collaborazione. In questo modo si preserva il flusso di lavoro e si riducono
al minimo le interruzioni.
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21
SOLIDWORKS Composer

Questo capitolo comprende i seguenti argomenti:

• Plug-In Composer per Adobe Acrobat
• Impedire la generazione dei contorni per la geometria nascosta

Il software SOLIDWORKS® Composer™ semplifica la creazione di contenuto grafico 2D e 3D
per la comunicazione prodotto e le illustrazioni tecniche.

Plug-In Composer per Adobe Acrobat
Il plug-in di Composer per Adobe® Acrobat® non è più supportato dalle configurazioni
Adobe a 64 bit.

È comunque supportato dalle configurazioni Adobe a 32 bit.

Impedire la generazione dei contorni per la geometria nascosta

La proprietà GenerateOutlineForHiddenActor disponibile nella categoria Viewport
della pagina Proprietà avanzate specifica se gli attori nascosti vengono evidenziati o meno
in modalità di rendering.
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Per evitare che i contorni vengano generati da attori nascosti, deselezionare questa
opzione. Ciò consente di risparmiare tempo quando si utilizza la modalità di rendering
per assiemi di grandi dimensioni.

232

SOLIDWORKS Composer



22
SOLIDWORKS Electrical

Questo capitolo comprende i seguenti argomenti:

• Consentire valori di colonna non ripetuti per circuiti, terminali e conduttori del
cavo (2025 SP2)

• Esportazione di file PDF (2025 SP2)
• Opzioni filtro per le finestre di dialogo di configurazione (2025 SP2)
• Scheda 3D (2025 SP1)
• Associazione di accessori per componenti complessi e assiemi elettrici
• Gestione dei cavi
• Distribuzione dei terminali
• Nuove variabili in gestione delle formule
• Aggiornamento e sostituzione dei dati in SOLIDWORKS Electrical 3D
• Tipi di terminali fili

SOLIDWORKS® Electrical è un prodotto acquistabile separatamente.

Consentire valori di colonna non ripetuti per circuiti, terminali e conduttori del
cavo (2025 SP2)
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È possibile importare i dati in modo più efficiente applicando valori condivisi a più circuiti,
terminali o conduttori del cavo. Durante l'importazione, se i valori inseriti non contengono
separatori, il singolo valore si applica a tutti i circuiti, i terminali o i conduttori del cavo.

Vantaggi: Consente di risparmiare tempo e di ridurre gli errori di input manuale.

Durante l'importazione del modello in Gestione pezzi costruttore, se si immette un singolo
valore per una colonna di un terminale, questo viene applicato a tutti i terminali del
circuito. Ad esempio, se per tutti i terminali la Sezione massima filo è 6, è possibile
immettere solo il valore 6 senza ripetere le informazioni. In precedenza, era necessario
immettere il valore 6;6|6;6. Ciò è applicabile quando si seleziona Una riga per
riferimento per i riferimenti dei pezzi costruttore e dei cavi e Una riga per circuito per
i pezzi costruttore.

Esportazione di file PDF (2025 SP2)

È possibile esportare un PDF per progetto, album o pagina e automatizzare l'orientamento
e le dimensioni di ogni pagina del file PDF in base al formato del disegno. Nella finestra
di dialogo Esporta file PDF è anche possibile definire la formula per denominare i
documenti.

In Proprietà, per Formato carta, selezionare Abbina dimensioni disegno per
ridimensionare automaticamente il formato carta in modo che corrisponda alle dimensioni
del disegno. Le opzioni nella finestra di dialogo Stampa disegni vengono riorganizzate in
modo da corrispondere alle modifiche nella finestra di dialogo Esporta file PDF.

Vantaggio: Migliora l'organizzazione e rende il processo più efficiente e intuitivo. Consente
di migliorare l'esperienza utente, offrendo una struttura della finestra di dialogo più chiara.

234

SOLIDWORKS Electrical



Opzioni filtro per le finestre di dialogo di configurazione (2025 SP2)

È possibile utilizzare le opzioni di filtro per filtrare e aggiornare l'elenco di configurazione
tra più file di configurazione.

Vantaggi: Riduce il tempo necessario per ricercare una configurazione specifica.

Le finestre di dialogo di configurazione includono un nuovo gruppo di opzioni in Filtri.

È possibile filtrare i file di configurazione immettendo il testo pertinente e selezionando
il tipo di configurazione nei seguenti campi:

• Titolo
• Descrizione
• Tipo

La disponibilità dei filtri dipende dal contenuto della finestra di dialogo di configurazione.

È inoltre possibile utilizzare contemporaneamente le opzioni Titolo, Descrizione e Tipo
per filtrare i file di configurazione.

Le opzioni di filtro si applicano sia alle Configurazioni dell'applicazione sia alle
Configurazioni del progetto.
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Scheda 3D (2025 SP1)

L'interfaccia utente della scheda 3D nella finestra di dialogo Impostazioni applicazione
è stata aggiornata.

Aggiornamento dell'interfaccia utente
Un elenco di proprietà dinamiche sostituisce le caselle di controllo statiche.

È stato aggiunto il titolo Opzioni per SOLIDWORKS Electrical 3D per migliorare
l'organizzazione delle opzioni.

Opzione Mantieni associazioni
L'opzioneMantieni associazioni se l'assieme non viene salvato consente di mantenere
le associazioni tra componenti 3D e parti elettriche, anche se non si salva l'assieme
SOLIDWORKS.

Vantaggi: Questa opzione migliora la flessibilità del flusso di lavoro e impedisce la perdita
di dati.

Per accedere a questa opzione, fare clic su Strumenti > SOLIDWORKS Electrical >
Strumenti > Impostazioni applicazione > 3D.
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Associazione di accessori per componenti complessi e assiemi elettrici

È possibile semplificare il processo di assemblaggio collegando le parti di accessori a
circuiti o morsetti specifici su un componente. Ciò è particolarmente utile per la produzione
di connettori personalizzati o complessi.

Vantaggi: È possibile verificare che solo le selezioni valide siano associate e aggiornare
le associazioni senza rimuoverne quelle esistenti, semplificando anche la configurazione
degli accessori.

Le finestre di dialogo Proprietà del componente e Proprietà dell'assieme elettrico

contengono ora i comandi Associa e Dissocia per gli accessori. È possibile
accedere a questi comandi tramite il menu di scelta rapida e selezionare l'accessorio e
rilasciarlo sulle parti a cui si desidera associarlo.

• Associa accessori: Consente agli utenti di associare uno o più accessori a un circuito
o a un morsetto specifico.

• Dissocia accessori: Rimuove l'associazione tra gli accessori e la parte o il morsetto
di base selezionati.

Aggiornamenti dell'interfaccia utente per visualizzare l'associazione
• Le finestre di dialogo Proprietà del componente e Proprietà dell'assieme elettrico
contengono ora nuove colonne, come segue:

• Numero d'ordine : visualizza il numero d'ordine dei componenti della stessa
categoria, per distinguere tra più istanze dello stesso componente nell'assieme.

• Relazione: visualizza le relazioni tra le parti, i componenti, i circuiti e i morsetti di
base insieme agli accessori associati.

È inoltre possibile visualizzare la relazione nel campo di testo in fondo alla finestra
di dialogo Proprietà del componente.

Associazione e dissociazione di accessori con assiemi elettrici

È possibile gestire associazioni e dissociazioni degli accessori all'interno di assiemi elettrici
complessi, salvare le relazioni degli accessori nel database e applicarle ai componenti.
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Un assieme complesso consiste di numerosi componenti elettrici interconnessi,
sottoassiemi, cavi, circuiti e morsetti che lavorano insieme per svolgere una funzione
specifica.

È possibile collegare e scollegare parti accessorie a specifici circuiti o morsetti su un
assieme complesso, il che aiuta a semplificare il processo di assemblaggio. Questi
collegamenti vengono salvati nella libreria.

Per associare l'accessorio all'assieme:

1. Fare clic su Libreria > Gestione pezzi costruttore.
2. Nella finestra di dialogo Gestione pezzi costruttore, in Classificazione, selezionare

una classe valida.
3. Scegliere una delle seguenti opzioni:

• Fare clic su Aggiungi pezzo costruttore > Aggiungi assieme elettrico .

• Fare clic su Inserimento multiplo > Aggiungi assiemi elettrici .

4. Nella finestra di dialogo Proprietà dell'assieme elettrico fare clic su Pezzi

costruttore .
5. Da un elenco di pezzi costruttore, un elenco di circuiti o un elenco di morsetti,

selezionare qualsiasi componente e accessorio da associare.
6. Scegliere una delle seguenti opzioni:

• Per l'associazione:

• Fare clic su Associa o fare clic con il pulsante destro del mouse e selezionare

Associa .
• Trascinare l'accessorio selezionato sulla parte da associare.

• Per rimuovere un'associazione, eseguire una delle operazioni seguenti:

• Selezionare la parte associata e fare clic su Dissocia .
• Fare clic con il pulsante destro del mouse sulla parte associata e selezionare

Dissocia .

L'app controlla se la selezione è valida. Ad esempio, se le parti selezionate non
includono gli accessori, l'app visualizza un messaggio di avvertenza e annulla il
comando.

È possibile visualizzare la relazione di associazione tra pezzo costruttore, circuito
e morsetto di base con il relativo accessorio nella colonna Relazione. Se non è
presente alcuna associazione, la colonna rimane vuota.

È inoltre possibile vedere la relazione nel campo di testo in fondo alla finestra di
dialogo.

7. Fare clic su OK.
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Associazione e dissociazione di accessori con componenti

È possibile aggiungere accessori a un pezzo, circuito o morsetto di base mentre si lavora
con i componenti.

I nuovi comandi e i miglioramenti delle finestre di dialogo consentono di migliorare
l'associazione, la dissociazione e la visualizzazione delle relazioni con gli accessori, fornendo
maggiori dettagli per il processo di produzione.

Per associare l'accessorio a un componente:

1. Fare clic con il pulsante destro del mouse su un componente di un progetto elettrico

e selezionare Componente .
2. Nella finestra di dialogo Proprietà del componente, fare clic su Pezzo costruttore e

circuiti .
3. Da un elenco di pezzi costruttore, un elenco di circuiti o un elenco di morsetti,

selezionare qualsiasi componente e accessorio da associare.
4. Scegliere una delle seguenti opzioni:

• Per l'associazione:

• Fare clic su Associa o fare clic con il pulsante destro del mouse e selezionare

Associa .
• Trascinare l'accessorio selezionato sul componente che si desidera associare.

• Per rimuovere un'associazione, eseguire una delle operazioni seguenti:

• Selezionare la parte associata e fare clic su Dissocia .
• Fare clic con il pulsante destro del mouse sulla parte associata e selezionare

Dissocia .

L'app controlla se la selezione è valida. Ad esempio, se i componenti selezionati non
includono gli accessori, l'app genera un messaggio di avvertenza e annulla il comando.

È possibile visualizzare la relazione di associazione tra componenti, circuiti e morsetti
con il relativo accessorio nella colonna Relazione. Se non è presente alcuna
associazione, la colonna rimane vuota.

È inoltre possibile vedere la relazione nel campo di testo in fondo alla finestra di
dialogo.

5. Fare clic su OK.
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Gestione dei cavi

La gestione e la configurazione dei cavi sono migliorate per offrire un'esperienza utente
migliore.

• Nella finestra di dialogo Proprietà di riferimento del cavo, è possibile specificare l'opzione
Radice contrassegno nella scheda Proprietà. Quando si aggiunge un cavo a un
progetto dal riferimento del cavo, copia automaticamente la Radice contrassegno
dal riferimento del cavo alla radice contrassegno del cavo. Questo valore è accessibile
anche per i filtri.

• Esistono nuove variabili per un'efficiente organizzazione dei cavi:

• Posizione
• Origine/destinazione componente
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Distribuzione dei terminali

Lo strumento Distribuisci terminale consente di collegare i simboli a circuiti e perni
specifici, semplificando la rappresentazione di disposizioni dei terminali complesse negli
schemi elettrici. Offre un'interfaccia intuitiva per la selezione dinamica di circuiti e perni,
garantisce una mappatura precisa da simbolo a terminale e migliora la precisione del
progetto.

È possibile selezionare un terminale specifico quando si aggiunge una nuova morsettiera,
oltre a selezionare il circuito. Distribuisce un singolo circuito su più simboli dello schema
elettrico.

Questa funzionalità è disponibile solo per i componenti dei terminali.

Lo strumento Distribuisci terminale consente inoltre di modificare la mappatura tra i
punti di connessione dei simboli e i terminali dei circuiti dei componenti. Questo comando
è attivato quando sono selezionati due terminali. È possibile commutare i collegamenti
dei componenti tra diversi circuiti.

La finestra di dialogo Proprietà del componente contiene una sezione Terminale che
dispone di un elenco di terminali con colonne per Circuito, Indice, Contrassegno e
Relazione.

Distribuzione dei componenti dei terminali

È possibile utilizzare lo strumento Distribuzione dei terminali per gestire e commutare
le connessioni dei componenti.
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Per distribuire un terminale:

1. Fare clic su Inserisci terminali .

Nella scheda Contrassegno morsetto, nel riquadro di destra viene visualizzato un
nodo per i terminali.

• Il software raggruppa i terminali dello stesso circuito e visualizza i circuiti disponibili
per i componenti del terminale multilivello.

• I circuiti parzialmente utilizzati sono accompagnati da un'icona mezza
colorata/mezza grigia nell'albero dei componenti e mostra solo i terminali liberi.

2. Selezionare un componente da associare ai terminali del circuito.

3. Nella scheda Pezzi costruttore e circuiti, fare clic su Distribuzione dei terminali
per gestire e commutare le connessioni dei componenti.

Nuove variabili in gestione delle formule

Nella finestra di dialogo Gestione formule sono disponibili nuove variabili che consentono
di etichettare le frecce di origine e di destinazione in modo più efficace. In questo modo
è più facile trovare e comprendere i segnalibri, soprattutto quando le frecce si trovano
nello stesso album.

Nella finestra di dialogo Gestione delle formule: Contrassegno rinvio, nella scheda Variabili
e formule semplici:

• La variabile BOOK_TAG_ALWAYS viene visualizzata in BOOK_TAG.
• STRZ(VAL(BOOK_ORDERNO_ALWAYS), 2, 0) viene visualizzata in

STRZ(VAL(BOOK_ORDERNO), 2, 0).

Nella finestra di dialogo Gestione attributi, #BUN_TAG_ALWAYS viene visualizzato in
#BUN_TAG.
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Aggiornamento e sostituzione dei dati in SOLIDWORKS Electrical 3D

Gli strumenti Aggiorna dati e Sostituisci dati sono disponibili nella barra degli strumenti
SOLIDWORKS Electrical 3D Progetto.

È inoltre possibile accedere a questi strumenti da Strumenti > SOLIDWORKS Electrical
> Processo.

Nelle versioni precedenti, questi strumenti erano disponibili solo in SOLIDWORKS Electrical
Schematic. Con questi strumenti in SOLIDWORKS Electrical 3D, è possibile aggiornare i
dati di progetto come le proprietà dei pezzi costruttore, i riferimenti dei cavi, i simboli e
i cartigli. Non è necessario tornare ogni volta all'applicazione SOLIDWORKS Electrical
Schematic per aggiornare le modifiche.

Tipi di terminali fili
È possibile aggiungere dati utente e personalizzare i dettagli sui tipi di terminali fili nei
progetti elettrici.

• Dati utente e Dati traducibili vengono aggiunti nella finestra di dialogo Proprietà
del tipo di terminale filo.

• Sono disponibili nuovi attributi per i dati utente e i tipi di terminali.
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23
SOLIDWORKS Inspection

SOLIDWORKS® Inspection è un prodotto acquistabile separatamente che può essere utilizzato
con SOLIDWORKS Standard, SOLIDWORKS Professional, SOLIDWORKS Premium e
SOLIDWORKS Ultimate oppure come applicazione completamente separata (vedere
SOLIDWORKS Inspection Standalone).

Esportazione dei rapporti FAI nel modello di revisione C AS9102 (2025 SP2)

È possibile esportare i dati del progetto di ispezione nel formato standard del rapporto di
revisione C AS9102.

Questa funzione è disponibile in entrambi i componenti aggiuntivi SOLIDWORKS Inspection
Standalone e SOLIDWORKS Inspection.
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24
SOLIDWORKS MBD

Questo capitolo comprende i seguenti argomenti:

• Specifica delle edizioni STEP 242 (2025 SP2)
• Allineamento delle quote DimXpert (2025 SP2)
• Creazione di quote DimXpert dalle quote di funzione e di riferimento (2025 SP2)
• Salvataggio delle quote DimXpert nelle funzioni di libreria (2025 SP1)
• Creazione di quote DimXpert da quote di schizzo
• Uso dell'aggiunta SOLIDWORKS MBD con SolidNetWork License
• Eliminazione della tolleranza del profilo generale
• Creazione delle quote di lunghezza nelle funzioni di sformo
• Creazione di due tolleranze di posizione separate per le asole

SOLIDWORKS® MBD è un prodotto acquistabile separatamente che può essere utilizzato con
SOLIDWORKS Standard, SOLIDWORKS Professional, SOLIDWORKS Premium e SOLIDWORKS
Ultimate.

Specifica delle edizioni STEP 242 (2025 SP2)
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Nel PropertyManager Pubblica in STEP242, quando si pubblica in STEP 242, è possibile
specificare Edizione 1.0, 2.0 o 3.0.

Per specificare le edizioni STEP 242:

1. Fare clic su Pubblica file STEP 242 (barra degli strumenti MBD).

2. Nel PropertyManager, in Edizione STEP 242, fare clic su e specificare un'opzione:

• Edizione 1.0
• Edizione 2.0
• Edizione 3.0

L'impostazione predefinita è Edizione 1.0.

3. Fare clic su .

Allineamento delle quote DimXpert (2025 SP2)

È possibile allineare le annotazioni DimXpert a un piano definito dall'utente.

Le quote DimXpert possono oscurarsi quando vengono applicate alla geometria con
contorno. È possibile allineare le annotazioni DimXpert spostandole su un piano o una
faccia planare selezionati.

Per allineare le annotazioni DimXpert a un piano definito dall'utente:

1. Fare clic con il pulsante destro del mouse su un'annotazione DimXpert e fare clic su
Seleziona vista annotazione > Per selezione.

2. Nell'area grafica, selezionare un piano o faccia planare per definire il nuovo
orientamento.

3. Nel PropertyManager, selezionare Modifica vista annotazione per spostare
l'annotazione alla vista dell'orientamento corrispondente al nuovo orientamento.
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4. Fare clic su .

Creazione di quote DimXpert dalle quote di funzione e di riferimento (2025
SP2)

È possibile creare quote DimXpert da quote di funzione e di riferimento.

Per creare quote DimXpert da quote di funzione e riferimento:

1. Fare clic su Inserisci quote (barra degli strumenti MBD Dimension) o su
Strumenti > MBD Dimension > Inserisci quote.

2. Nel PropertyManager:

a. Per Funzioni, selezionare le funzioni nell'area grafica o nell'albero di disegno
FeatureManager®.

b. Per Quote di funzione o Quote di riferimento, selezionare le quote nell'area
grafica.

c. Fare clic su .
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Salvataggio delle quote DimXpert nelle funzioni di libreria (2025 SP1)

Le quote DimXpert possono essere salvate nelle funzioni di libreria.

Vantaggi: È possibile salvare le quote DimXpert nelle parti delle funzioni di libreria per
riutilizzarle quando si usa una funzione di libreria su un modello.

Per salvare le quote DimXpert nelle funzioni di libreria:

1. fare clic su Aggiungi alla libreria nella scheda Libreria del progetto del Task
Pane.

2. Nel PropertyManager:

a. Per Elementi da aggiungere, selezionare le funzioni dall'area grafica o dall'albero
di disegno FeatureManager.

b. Per Nome file, digitare un nome file (il nome predefinito è il nome del documento).
c. Per la cartella Libreria del progetto, selezionare una sottocartella per

aggiungere la funzione di libreria.
d. Per la Descrizione, immettere una descrizione da visualizzare nella descrizione

dei comandi dell'elemento.

e. Selezionare Includi MBD Dimensions e fare clic su .
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Creazione di quote DimXpert da quote di schizzo

È possibile creare quote DimXpert da quote di schizzo.

Per creare quote DimXpert da quote di schizzo:

1. Fare clic su Inserisci quote (barra degli strumenti MBD Dimension) o su
Strumenti > MBD Dimension > Inserisci quote.

2. Nel PropertyManager:

a. Per Funzioni, selezionare le funzioni dall'area grafica o dall'albero di disegno
FeatureManager®.

b. Per Quote di schizzo, selezionare le quote nell'area grafica per creare quote
DimXpert.

c. Fare clic su .
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Uso dell'aggiunta SOLIDWORKS MBD con SolidNetWork License

I clienti SolidNetWork License (SNL) possono utilizzare l'aggiunta SOLIDWORKS MBD.

Per utilizzare l'aggiunta SOLIDWORKS MBD con SNL:

1. In SOLIDWORKS, fare clic su Strumenti > Aggiunte.
2. Nella finestra di dialogo, in Aggiunte SOLIDWORKS, selezionare SOLIDWORKS

MBD e fare clic su OK.

Eliminazione della tolleranza del profilo generale
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In Design with SOLIDWORKS, è possibile eliminare una tolleranza del profilo generale.

Per eliminare una tolleranza del profilo generale, in DimXpertManager , fare clic con il
pulsante destro del mouse su una tolleranza del profilo generale e fare clic su Elimina.

Creazione delle quote di lunghezza nelle funzioni di sformo

È possibile creare quote di lunghezza nelle funzioni di sformo.

Lo strumento Quote di dimensione DimXpert può essere utilizzato per creare quote
per le funzioni di sformo, ad esempio cunei e coni. La quota è in genere una quota di
distanza con tolleranze. La quota può essere compresa tra due bordi delle estremità di
sformo o bordi circolari di un cilindro.
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Creazione delle quote di lunghezza nei cunei

Per creare quote di lunghezza nei cunei:

1. Fare clic su Quote di dimensione (barra degli strumenti MBD Dimension), oppure
selezionare Strumenti > MBD Dimension > Quote di dimensione.

2. Fare clic sulla faccia di uno dei piani laterali.

3. Nel selettore di funzioni, fare clic su Crea funzione di larghezza/cuneo .
4. Fare clic sulla faccia del secondo lato.
5. Fare clic sulla faccia del piano finale, cioè il piano che interseca i due lati, quindi fare

clic su .
6. Posizionare la quota angolare.

7. Fare clic su Quote di dimensione (barra degli strumenti MBD Dimension), oppure
selezionare Strumenti > MBD Dimension > Quote di dimensione.

8. Fare clic sul piano finale.
9. Fare clic nell'area grafica per inserire la quota di larghezza.
10. Applicare una tolleranza di forma alla quota di larghezza per creare la didascalia di

posizione.
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Creazione delle quote di lunghezza nei coni

Per creare quote di lunghezza nei coni:

1. Fare clic su Quote di dimensione (barra degli strumenti MBD Dimension), oppure
selezionare Strumenti > MBD Dimension > Quote di dimensione.

2. Fare clic sulla faccia conica per creare la funzione cono.
3. Posizionare la quota angolare.
4. Fare clic sul bordo superiore per creare la funzione del cerchio d'intersezione e la

quota del diametro.

Vedere la Guida di SOLIDWORKS: Funzioni DimXpert.

5. Applicare una tolleranza di forma alla funzione del cerchio d'intersezione per creare
la didascalia di posizione.
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Creazione di due tolleranze di posizione separate per le asole

È possibile creare due tolleranze di posizione separate per le asole.

Per creare due tolleranze di posizione separate per le asole:

1. Fare clic su Quote di dimensione (barra degli strumenti MBD Dimension), oppure
selezionare Strumenti > MBD Dimension > Quote di dimensione.

2. Fare clic sul bordo della lunghezza di un'asola e fare clic nell'area grafica per
posizionare la quota.

3. Fare clic su .
4. Applicare una tolleranza di forma e una tolleranza di posizione e fare clic nell'area

grafica per posizionare la tolleranza.

5. Fare clic su .

6. Fare clic su Quote di dimensione (barra degli strumenti MBD Dimension), oppure
selezionare Strumenti > MBD Dimension > Quote di dimensione.

7. Fare clic sul bordo della larghezza di un'asola e fare clic nell'area grafica per posizionare
la quota.

8. Fare clic su .
9. Per scegliere il tipo di quota da applicare a una funzione, ad esempio "6XR"

nell'illustrazione, vedere Guida in linea di SOLIDWORKS: Utilizzo del PropertyManager
Quota.
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25
DraftSight

Questo capitolo comprende i seguenti argomenti:

• Simboli di saldatura (2025 SP3)
• Aggiunta dell'adattamento alla quota (2025 SP3)
• Aggiunta di una tolleranza alla quota (2025 SP3)
• Rappresentazione delle saldature (2025 SP3)
• Linee di costruzione (2025 SP3)
• Importazione di un file PDF come blocco da 3DEXPERIENCE platform (solo

DraftSight Connected) (2025 FD02)
• Sheet Set Manager su 3DEXPERIENCE platform (solo DraftSight Connected) (2025

FD02)
• Compatibilità della tavolozza Risorse di progettazione con 3DEXPERIENCE platform

(2025 FD01)
• File allegati da 3DEXPERIENCE platform (solo DraftSight Connected) (2025 FD01)
• Segnalibri per salvataggio in batch in 3DEXPERIENCE (solo DraftSight Connected)
• Finestra di dialogo Apri (solo DraftSight Connected)
• Server di licenza Managed DS
• Esportazione file DGN
• Riempimento automatico delle celle della tabella
• Accesso alle tabelle e creazione di interruzioni tabella
• Librerie di blocchi dinamici
• Ricerca dinamica nella finestra di dialogo Opzioni
• Finestra di dialogo Stili di quotatura
• Tavolozza della struttura blocchi
• Modifica dei riferimenti esterni e dei blocchi ritagliati
• Ordine di disegno
• Gestione della spaziatura tra le quote
• Visibilità della barra dei menu
• Vincoli di quotatura per blocchi personalizzati
• Comando FLATTEN
• Stili visivi
• Stampa in MacOS
• Comando AMUSERHATCH (solo DraftSight Mechanical)
• Modifiche della tabella
• Importazione dei file STEP
• Comando DWGUNITS
• Esportazione PDF e utilizzo della stampa in batch
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• Blocchi nella tavolozza Risorse di progettazione
• Più elementi di visibilità
• Lazo

DraftSight® è un prodotto acquistato separatamente che può essere utilizzato per creare disegni
CAD professionali. È disponibile nei formati DraftSight Professional, DraftSight Premium e
DraftSight Mechanical. Inoltre, DraftSight Enterprise ed Enterprise Plus sono disponibili su
licenza di rete. 3DEXPERIENCE® DraftSight è una soluzione che combina DraftSight con le
funzionalità avanzate di 3DEXPERIENCE Platform.

Simboli di saldatura (2025 SP3)

È possibile utilizzare il comando AM_WELDINGSYMBOL per aggiungere simboli di saldatura
ai disegni.

I simboli di saldatura garantiscono una comunicazione chiara delle specifiche di saldatura
e l'aderenza agli standard industriali. Migliorano l'accuratezza e la qualità della
documentazione tecnica.

Il comando AMWELDSYM offre diverse opzioni per un posizionamento flessibile e preciso
dei simboli di saldatura:

• Supporta un'ampia gamma di simboli di saldatura standard che rappresentano vari
tipi di saldatura.

• Consente di personalizzare il tipo, le dimensioni, l'angolo e la posizione dei simboli per
soddisfare i requisiti del progetto.

• Fornisce opzioni per l'aggiunta di simboli come ambiente circostante, saldatura di
campo e saldature di raccordo sfalsate alla giunzione della freccia con la linea di
riferimento.

• Permette di includere più linee di riferimento e frecce per indicare sequenze di saldatura
e posizioni di saldatura identiche.

• Collega i simboli agli oggetti e fa in modo che si spostino con l'oggetto quando viene
riposizionato.
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• Posiziona i simboli come annotazioni autonome.
• Include la possibilità di aggiungere dettagli per processi di saldatura specifici.

Aggiunta dell'adattamento alla quota (2025 SP3)

È possibile aggiungere informazioni precise sull'adattamento alle quote nei disegni. Questo
migliora il processo di progettazione recuperando automaticamente i valori di
accoppiamento dei fori e degli alberi. Recupera i valori da una tabella di dati in base alla
dimensione nominale selezionata.

Incorporando i dati di accoppiamento direttamente nelle dimensioni, è possibile garantire
che i pezzi accoppiati raggiungano il grado di tenuta o di allentamento richiesto, rispettino
gli standard industriali e migliorino la precisione dell'assemblaggio. L'aggiunta di valori
di adattamento alla quota presenta i seguenti vantaggi:

• Riduce i calcoli manuali e gli errori recuperando automaticamente i valori di
accoppiamento dei fori e degli alberi da una tabella di dati.

• Consente di specificare la precisione dell'adattamento.
• Garantisce la conformità con le classi di vestibilità standard del settore e le
rappresentazioni per un'accurata compatibilità di produzione.

• Fornisce un facile accesso alle opzioni di Adattamento attraverso la scheda contestuale
della barra multifunzione Power Dimensioning e la Tavolozza delle proprietà.

• Consente di confrontare gli accoppiamenti di alberi e fori, di selezionare le notazioni
appropriate e di visualizzare i valori nella finestra di dialogo Adattamento.
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Aggiunta di una tolleranza alla quota (2025 SP3)

È possibile aggiungere informazioni di tolleranza direttamente alle quote nei disegni.

Ciò garantisce chiarezza, specificando le variazioni di dimensioni ammesse, e supporta
processi di produzione e assemblaggio accurati. L'aggiunta di tolleranza comporta i
seguenti vantaggi:

• Consente di definire direttamente i limiti superiori e inferiori delle dimensioni.
• Fornisce vari metodi di tolleranza, come le rappresentazioni simmetriche, di deviazione
e basate sui limiti.

• Consente di controllare la precisione delle tolleranze in modo indipendente.
• Fornisce un facile accesso alle opzioni di tolleranza attraverso la scheda della Barra
multifunzione Power Dimensioning e la Tavolozza delle proprietà.
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Rappresentazione delle saldature (2025 SP3)

Con il comando AM_SIMPLEWELD è possibile creare e personalizzare saldature di raccordo
e saldature di testa a V singola su varie entità, tra cui ellissi, cerchi, archi, linee e polilinee.

Questo comando supporta le rappresentazioni della saldatura con vista frontale e laterale,
offrendo un controllo preciso e flessibilità nella definizione dei dettagli di saldatura.
Semplifica il processo di creazione dei simboli di saldatura, aumenta la produttività e
garantisce la conformità agli standard industriali. Il comando:

• Offre un controllo preciso delle dimensioni delle saldature, della larghezza delle gambe
e del posizionamento dei simboli.

• Consente di modificare le proprietà della saldatura con il comando AM_SIMPLEWELDEDIT
o direttamente con la Tavolozza delle proprietà.
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Linee di costruzione (2025 SP3)

Il comando AM_CONSTLINES offre una soluzione completa per la creazione di linee di
costruzione nei disegni.

Le linee di costruzione sono guide di riferimento che aiutano ad allineare, posizionare e
disporre gli oggetti durante il processo di progettazione. Ciò semplifica le attività di
progettazione complesse, migliorando l'accuratezza e l'efficienza del flusso di lavoro. Offre
diversi tipi di linee di costruzione, tra cui raggi, xlinee e linee circolari.

Le linee di costruzione permettono di:

• Creare linee che si estendono all'infinito in una o entrambe le direzioni o linee di
costruzione circolari per fare riferimento a geometrie curve.

• Fare clic su punti chiave (ad esempio, intersezioni o punti mediani) per garantire un
posizionamento preciso degli oggetti.

• Posizionare automaticamente le linee di costruzione su un livello dedicato (AM_CL)
che è possibile personalizzare, bloccare e congelare per una migliore gestione.

• Ridurre i calcoli manuali e le regolazioni del disegno grazie a configurazioni avanzate
come bisettrici, linee perpendicolari e cerchi concentrici.

I comandi utilizzati con le linee di costruzione sono:

DescrizioneComando

Consente di selezionare il tipo di linea di costruzione.AM_CONSTLINES

Attiva o disattiva la modalità raggio.AM_CONSTSWI

Disattiva la modalità raggio.
Le linee di costruzione si estendono all'infinito in entrambe le
direzioni.

AM_CONSTSWI_XLINE
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DescrizioneComando

Attiva la modalità raggio.
Le linee di costruzione si estendono all'infinito in una sola
direzione.

AM_CONSTSWI_RAY

Cancella le linee di costruzione selezionate.AM_ERASECL

Cancella tutte le linee di costruzione.AM_ERASEALLCL

Blocca o sblocca il livello della linea di costruzione.AM_CLINEL

Congela o scongela i livelli della linea di costruzione.AM_CLINEO

Crea una linea di costruzione orizzontale.AM_CONSTHOR

Crea una linea di costruzione attraverso un punto specificando
un angolo rispetto a una linea apparente.

AM_CONSTHW

Crea una linea di costruzione perpendicolare a una linea
specificata.

AM_CONSTLOT

Crea una linea di costruzione circolare concentrica al cerchio
o all'arco selezionato.

AM_CONSTCC

Crea una linea di costruzione circolare.AM_CONST_CIRCLE

Crea una linea di costruzione verticale.AM_CONSTVER

Crea una linea di costruzione parallela alla linea esistente a
una distanza specificata dalla linea selezionata.

AM_CONSTPAR

Crea una linea di costruzione che biseca un angolo.AM_CONSTHM

Crea una linea di costruzione circolare per rappresentare la
vista dall'alto di un albero o di un foro.

AM_CONSTCCREA

Crea una linea di costruzione rettangolare intorno a un cerchio.AM_CONSTCIRCLI

Crea un incrocio di linee di costruzione.AM_CONSTCRS

Crea una linea di costruzione parallela a una linea esistente e
biseca la distanza tra la linea selezionata e un punto specificato.

AM_CONSTPAR2

Crea due linee di costruzione parallele tangenti a un cerchio
specificato.

AM_CONSTTAN

Crea una linea di costruzione circolare che utilizza una linea
specificata come tangente.

AM_CONSTC2
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DescrizioneComando

Crea linee di costruzione che partono da un punto e si
estendono all'infinito in una direzione.

AM_CONSTXRAY

Crea una linea di costruzione specificando due punti o un punto
e un angolo.

AM_CONSTHB

Crea una linea di costruzione attraverso un punto specificato
perpendicolare a una direzione.

AM_CONSTLOT2

Crea linee di costruzione tangenti a due cerchi specificati.AM_CONSTTC

Crea una linea di costruzione tangente a due linee o cerchi
specificati.

AM_CONSTK

Crea una linea di costruzione passante per un punto, che si
estende all'infinito in entrambe le direzioni.

AM_CONSTXLINE

Crea una linea di costruzione in direzione Z.AM_CONSTZ

Importazione di un file PDF come blocco da 3DEXPERIENCE platform (solo
DraftSight Connected) (2025 FD02)

È possibile utilizzare il comando IMPORTPDFFROM3DEXPERIENCE per importare un
file PDF come blocco da 3DEXPERIENCE platform.

Per importare un file PDF come blocco da 3DEXPERIENCE platform:

1. Scegliere una delle seguenti opzioni:
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Fare clic su Importa > Importa da 3DEXPERIENCE.•
• Fare clic su File > Importa > Importa da 3DEXPERIENCE.
• Digitare IMPORTPDFFROM3DEXPERIENCE nella finestra del comando.

2. Nella finestra di dialogo Importa da 3DEXPERIENCE:

a. In Formato file, selezionare PDF (*.pdf).
b. Fare clic su Scegli file.

3. Nella finestra di dialogo Apri:

a. Selezionare un file PDF.
b. Fare clic su Apri.

Nella finestra di dialogo Importa da 3DEXPERIENCE, Nome file visualizza il file
selezionato.

4. Fare clic su Importa.
5. Nella finestra di dialogo Importazione PDF, fare clic su OK.

Sheet Set Manager su 3DEXPERIENCE platform (solo DraftSight Connected)
(2025 FD02)

3DEXPERIENCE DraftSight consente di creare i file Sheet Set Data (DST) e di salvarli nei
segnalibri. È possibile aprire i file DST salvati dai segnalibri.

È inoltre possibile definire le proprietà di Sheet Set Manager. Consultare Utilizzo dei set
di fogli di disegno. È possibile creare file DST utilizzando un disegno esistente o un
modello di set di fogli di disegno. 3DEXPERIENCE DraftSight crea i file DST come oggetti
PLM.
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Creazione di set di fogli di disegno utilizzando un disegno esistente

È possibile utilizzare la procedura guidata Crea set di fogli di disegno per creare set di
fogli di disegno da un disegno esistente.

Per creare set di fogli di disegno usando un disegno esistente:

1. Nella tavolozza Gestione set di fogli, fare clic su Nuovo set di fogli di disegno
.

2. Nella procedura guidata Crea set di fogli di disegno - Avvia, selezionare Disegni
esistenti e fare clic su Avanti.

3. Fare clic su Sfoglia per la Posizione del file di dati del set di fogli di disegno
(*.dst).

4. Nella finestra di dialogo Cerca cartella set di fogli di disegno, fare clic su Seleziona
da 3DEXPERIENCE.

5. Nella finestra di dialogo Seleziona un segnalibro:
a) Selezionare un segnalibro esistente o creare un segnalibro in cui salvare il file

DST.
b) Fare clic su Seleziona.

In alternativa, è possibile selezionare una cartella da Questo PC.

6. Fare clic su Proprietà set fogli di disegno per selezionare un segnalibro per la
Vista del modello da 3DEXPERIENCE platform.
È possibile selezionare un segnalibro per il Blocco etichetta per le viste e i Blocchi
didascalia.

7. Nella procedura guidata Crea set di fogli di disegno - Dettagli di set di fogli di disegno,
fare clic su Avanti.

8. Nella procedura guidata Crea set di fogli di disegno - Scegli fogli, fare clic su Sfoglia.
a) Nella finestra di dialogo Sfoglia cartelle, selezionare una cartella dal computer o

un segnalibro che contenga disegni.
b) Fare clic su Specifica cartella.

9. Nella procedura guidata Crea set di fogli di disegno - Scegli fogli, fare clic su Avanti.
10. Nella procedura guidata Crea set di fogli di disegno - Finalizza, fare clic su Fine.

Creazione di set di fogli di disegno utilizzando un modello di set di fogli di disegno

È possibile utilizzare la procedura guidata Crea set di fogli di disegno per creare set di
fogli di disegno utilizzando un modello di set di fogli di disegno.

Per creare set di fogli di disegno utilizzando unmodello di set di fogli di disegno:

1. Nella tavolozza Gestione set di fogli, fare clic su Nuovo set di fogli di disegno
.

2. Nella procedura guidata Crea set di fogli di disegno - Avvia, selezionare Un modello
di set di fogli di disegno e fare clic su Avanti.

3. Nella procedura guidata Crea set di fogli di disegno - Modello di set di fogli di disegno:
a) Selezionare Cerca un altro foglio di disegno da utilizzare come modello.
b) Fare clic su Sfoglia.
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4. Nella finestra di dialogo Cerca set di fogli di disegno, fare clic su Apri da
3DEXPERIENCE.

5. Nella finestra di dialogo Apri:
a) Selezionare un modello di set di fogli di disegno (.DST) da 3DSearch o da

Segnalibri.
b) Fare clic su Apri.
Nella procedura guidata Crea set di fogli di disegno - Modello di set di fogli di disegno,
appare il nome del modello di set di fogli di disegno (DST).

6. Nella procedura guidata Crea set di fogli di disegno - Modello di set di fogli di disegno,
fare clic su Avanti.

7. Nella procedura guidata Crea set di fogli di disegno - Dettagli di set di fogli di disegno,
fare clic su Avanti.

8. Nella procedura guidata Crea set di fogli di disegno - Finalizza, fare clic su Fine.

Apertura di set di fogli di disegno

Per aprire i set di fogli di disegno:

1. Nella tavolozza Gestione set di fogli, fare clic su Apri set fogli di disegno .
2. Nella finestra di dialogo, effettuare una delle seguenti operazioni:

• Selezionare il set di fogli di disegno (DST) e fare clic su OK.
• Da Segnalibri o 3DSearch, fare clic su Apri da 3DEXPERIENCE, selezionare il
file di gestione del set di fogli e fare clic su Apri.

La tavolozza Gestione set di fogli visualizza i riferimenti del file DST.

Compatibilità della tavolozza Risorse di progettazione con 3DEXPERIENCE
platform (2025 FD01)
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La tavolozza Risorse di progettazione consente di accedere alle risorse e ai contenuti
dei file di disegno disponibili su 3DEXPERIENCE platform.

La compatibilità si applica a DraftSight Connected e Design with DraftSight.

Aggiungi segnalibro consente di aggiungere segnalibri da 3DEXPERIENCE platform.
In Contenuto, è possibile visualizzare i file del segnalibro e le categorie di file di disegno.

Apri risorse consente di aprire i file da 3DEXPERIENCE platform.

Vedere la Guida di DraftSight: Tavolozza Risorse di progetto.

Aggiunta di segnalibri da 3DEXPERIENCE platform

Per aggiungere segnalibri da 3DEXPERIENCE platform:

1. Nella tavolozza Risorse di progettazione, nella scheda 3DEXPERIENCE, fare clic su

Aggiungi segnalibro .
2. Nella finestra di dialogo Seleziona un segnalibro, selezionare un segnalibro e fare clic

su Seleziona.

Nell'elenco, vengono visualizzati i segnalibri selezionati.

3. Fare clic con il pulsante destro del mouse su un segnalibro e specificare un'opzione:

DescrizioneOpzione

Verifica lo stato del segnalibro.

appare per indicare se il segnalibro non è aggiornato.

Verifica stato

Aggiorna il segnalibro con i file più recenti.Aggiorna

Rimuove il segnalibro dall'elenco.Rimuovi
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File allegati da 3DEXPERIENCE platform (solo DraftSight Connected) (2025
FD01)

È possibile allegare file di disegno, immagine e PDF da 3DEXPERIENCE platform come
riferimenti esterni al disegno corrente.

Per allegare file da 3DEXPERIENCE platform:

1. Procedere in uno dei modi seguenti:

• Nell'area di lavoro Disegno e annotazione, fare clic su Allega > Allega da
3DEXPERIENCE.

• Nella tavolozza Riferimenti, selezionare Allega da 3DEXPERIENCE.
• Digitare ATTACHFROM3DEXPERIENCE nella finestra del comando.

2. Nella finestra di dialogo Allega da 3DEXPERIENCE, selezionare una delle seguenti
opzioni:

• 3DSearch
• Bloccato da me
• Contenuti personali
• Segnalibri

3. Selezionare un file da allegare.

È possibile utilizzare 6WTags per cercare un tipo di file specifico.

In base al tipo di file selezionato, si apre la finestra di dialogo corrispondente:

Finestra di dialogoTipo file

Inserisci riferimento: DisegnoFile DWG
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Finestra di dialogoTipo file

Inserisci riferimento: PDF sottopostoPDF

Inserisci riferimento: DGN sottopostoDGN

Inserisci riferimento: Immagine di sfondoPNG

4. Selezionare il file da allegare, quindi fare clic su Allega.

Il file selezionato viene allegato al file di disegno.

Allegati dalla finestra di dialogo 3DEXPERIENCE

La finestra di dialogo Allega da 3DEXPERIENCE consente di allegare file da 3DSearch,
Segnalibri, Contenuto personale e file bloccati dall'utente.

Per aprire la finestra di dialogo:

Procedere in uno dei modi seguenti:

• Nell'area di lavoro Disegno e annotazione, fare clic su Allega > Allega da
3DEXPERIENCE.

• Nella tavolozza Riferimenti, selezionare Allega da 3DEXPERIENCE.
• Digitare ATTACHFROM3DEXPERIENCE nella finestra del comando.

3DSearch
Visualizza i file salvati in 3DEXPERIENCE platform.

Bloccato da me
Visualizza i file bloccati dall'utente. Fare clic su Cancella filtro per cancellare i risultati
e visualizzare tutti i file.

Contenuto utente
Visualizza i file creati dall'utente. Fare clic su Cancella filtro per cancellare i risultati e
visualizzare i file creati da tutti gli utenti.

Segnalibri
Visualizza i segnalibri e i file salvati nei segnalibri.

Attacca
Allega il file selezionato al disegno.
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Segnalibri per salvataggio in batch in 3DEXPERIENCE (solo DraftSight
Connected)

È possibile caricare in batch i file nei segnalibri su 3DEXPERIENCE Platform.

Per aprire la finestra di dialogo Salva in batch in 3DEXPERIENCE - Opzioni, nella barra
multifunzione, fare clic su DraftSight > Salva in batch in 3DEXPERIENCE.

Finestra di dialogo Seleziona un segnalibro

È possibile utilizzare questa finestra di dialogo per selezionare un segnalibro esistente o
creare nuovi segnalibri.

Per accedere alla finestra di dialogo Seleziona un segnalibro, nella finestra di dialogo

Salva in batch in 3DEXPERIENCE - Opzioni, fare clic su .

Barra degli strumenti

DescrizioneStrumento

Consente di creare un nuovo segnalibro.Nuovo segnalibro

Consente di contrassegnare i segnalibri come preferiti.Preferito

Consente di espandere la struttura delle cartelle.Espandi tutto

Cerca il file nel segnalibro selezionato.Trova nell'albero

Consente di ordinare i segnalibri in ordine alfabetico.Ordine alfabetico
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DescrizioneStrumento

Consente di ordinare i segnalibri in base alla data di creazione.Ordina per data

Preferenze
Elenca i segnalibri preferiti.

Segnalibri
Elenca i segnalibri disponibili in 3DEXPERIENCE Platform e i nuovi segnalibri creati.

Finestra di dialogo Apri (solo DraftSight Connected)

È possibile utilizzare la finestra di dialogo Apri per aprire i file di disegno e i file aperti di
recente in 3DSearch, bloccati dall'utente, in I miei contenuti e nei segnalibri.

La finestra di dialogo contiene varie opzioni che consentono di visualizzare i file nel pannello
Risultati.

Per aprire la finestra di dialogo, procedere in uno dei modi seguenti:

• Fare clic su Apri (barra strumenti Accesso rapido).
• Fare clic su File > Apri.
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• Digitare Open nella finestra del comando.

DescrizioneOpzione

Visualizza i file aperti di recente. Il simbolo
della nuvola indica il file aperto su
3DEXPERIENCE Platform. Selezionare il file
e fare clic su Apri per aprirlo.

Recente

Visualizza il file salvato su 3DEXPERIENCE
Platform.

3DSearch

Visualizza i file bloccati dall'utente. Fare clic
su Cancella filtro per cancellare i risultati
e visualizzare tutti i file.

Bloccato da me

Visualizza i file creati dall'utente. Fare clic
su Cancella filtro per cancellare i risultati
e visualizzare i file creati da tutti gli utenti.

Contenuti personali

Visualizza i segnalibri e i file salvati nei
segnalibri.

Segnalibri

Apre i file salvati localmente.Questo PC

Apre il file selezionato dai risultati.

Se si sta lavorando in modalità offline, è
possibile aprire solo i file aperti di recente
e salvati localmente.

Aperto
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Server di licenza Managed DS

DraftSight supporta il server di licenza Managed DS.

Il server di licenza Managed DS (DSLS) è noto anche conosciuto come Managed Licensing
Service. Con Managed DSLS, i clienti in sede non hanno bisogno di un computer fisico
per installare il DSLS.

Vedere Managed Licensing Service.

Configurazione di Managed DSLS nella procedura di installazione

È possibile utilizzare il tipo di server Managed DSLS quando si configura il server nella
procedura di installazione di DraftSight.

Per configurare Managed DSLS nella procedura di installazione:

1. In Procedura di installazione di DraftSight, selezionare il Server di licenza Dassault
Systèmes (DSLS).

2. Per il Tipo server, selezionare Managed DSLS.
3. Immettere i dettagli del server ricevuti dopo aver selezionato la modalità Managed

Licensing Service.

Configurazione di Managed DSLS in DraftSight

È possibile impostare il tipo di server Managed DSLS quando si installa DraftSight.

Quando si installa DraftSight, selezionare il Server delle licenze di Dassault Systèmes
(DSLS) come tipo di licenza.

Per configurare un server DSLS gestito in DraftSight:

1. In Amministratore licenze DraftSight, selezionare Aggiungi server.
2. Per il Tipo server, selezionare Managed DSLS.
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Esportazione file DGN
È possibile utilizzare i comandi EXPORTDGN o DGNEXPORT per esportare i file DGN.

Per utilizzare l'esportazione di file DGN:

Scegliere una delle seguenti opzioni:

• Nella barra multifunzione, fare clic su Menu > Esporta > Esporta DGN.
• Nel menu, fare clic su Manu > Esporta > Esporta DGN.
• Immettere EXPORTDGN o DGNEXPORT nella finestra del comando.

Riempimento automatico delle celle della tabella

Il riempimento automatico è utile quando si desidera che i dati siano in ordine logico o
ripetitivo nelle celle adiacenti di una tabella. I dati includono date, numeri sequenziali,
giorni della settimana, mesi, ecc.

Questa funzione è utile anche quando si desidera ripetere la formula di una cella ad altre.

Per utilizzare la funzione riempimento automatico:

1. Selezionare una cella.

Il quadratino di riempimento si trova nell'angolo inferiore destro della cella selezionata.

2. Trascinare il quadratino di riempimento nella direzione in cui riempire con i dati.

Le celle nella riga vengono riempite automaticamente se si trascina il quadratino
orizzontalmente. Le celle nella colonna vengono riempite automaticamente se si
trascina il quadratino verticalmente.
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Accesso alle tabelle e creazione di interruzioni tabella

È possibile utilizzare il comando TABLE per creare tabelle e separare le tabelle di grandi
dimensioni in più tabelle in modo che si adattino a un'area di disegno o a un foglio.

Per le tabelle con molte righe, è possibile interrompere la tabella in modo che la tabella
mostri le righe affiancate.

È possibile definire l'altezza della tabella trascinando il punto di presa, oppure immettere
l'altezza nelle unità di disegno nella tavolozza Proprietà.

Per accedere alle tabelle:

Scegliere una delle seguenti opzioni:

• Nella barra multifunzione, fare clic su Annota > Tabella > Inserisci.
• Nel menu, fare clic su Disegna > Tabella.
• Immettere TABLE nella finestra del comando.
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Librerie di blocchi dinamici

Le tavolozze strumenti includono più di 400 blocchi dinamici. I blocchi sono parametrici
e compatibili con AutoCAD®.

Invece di creare nuovi blocchi per adattare o aggiornare un progetto, è possibile regolare
le dimensioni, la forma e la configurazione dei blocchi dinamici. Ciò può semplificare il
processo di disegno e ridurre le attività ripetitive.

I blocchi dinamici includono simboli per architettura, design di interni, HVAC, elettricità,
idraulica, ingegneria civile e pianificazione urbana. Essi sono raggruppati in tavolozze in
base al focus del settore.
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Ricerca dinamica nella finestra di dialogo Opzioni

La funzionalità di ricerca nella finestra di dialogo Opzioni è più intuitiva e facile da usare,
e consente di trovare rapidamente le opzioni.

Nella casella Ricerca della finestra di dialogo Opzioni, iniziare a immettere un termine o
un nome della variabile di sistema per visualizzare un elenco di opzioni contenente la
stringa immessa. Le opzioni pertinenti vengono visualizzate in un elenco. È possibile fare
clic su un'opzione per andare direttamente all'opzione specificata.

Per utilizzare la ricerca dinamica nella finestra di dialogo Opzioni:

Scegliere una delle seguenti opzioni:

• Nella barra multifunzione, fare clic su Gestisci > Personalizzazione > Opzioni.
• Nel menu, fare clic su Strumenti > Opzioni.
• Immettere OPTIONS nella finestra del comando.

276

DraftSight



Finestra di dialogo Stili di quotatura

La finestra di dialogo Stili di quotatura è semplificata per modificare gli stili di quotatura.

Quando si modificano gli stili di quotatura, l'interfaccia utente assomiglia maggiormente
all'interfaccia AutoCAD. Ciò garantisce una transizione più fluida per gli utenti che migrano
da AutoCAD a DraftSight.

Per accedere alla finestra di dialogo Stili di quotatura:

Scegliere una delle seguenti opzioni:

• Nella barra multifunzione, fare clic su Annota > Quota > Stile quota.
• Nel menu, fare clic su Formato > Stile quota.
• Nella finestra del comando immettere DIMSTYLE / DIMENSIONSTYLE.
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Tavolozza della struttura blocchi

La tavolozza della struttura blocchi consente di visualizzare, gestire e navigare in gerarchie
di blocchi complesse. Migliora l'efficienza e l'organizzazione delle attività di progettazione
e bozza.

Una struttura blocchi è una disposizione di blocchi annidati che creano una gerarchia. La
tavolozza della struttura blocchi visualizza le strutture blocchi nidificate e consente di
gestire i blocchi.

La tavolozza offre i seguenti vantaggi:

• Visualizzazione della gerarchia. Ciò consente di gestire progetti di grandi dimensioni
e complessi con numerosi blocchi annidati.

• Ottenere una vista strutturata dell'organizzazione del blocco all'interno di un disegno.
• Visualizzare una rappresentazione visiva della struttura blocchi per un'istanza del
blocco selezionata.

• Facilitare la creazione e la gestione di strutture blocchi gerarchiche.
• Evidenziare i blocchi annidati all'interno del blocco principale o del blocco padre. Un
blocco può fungere da blocco nidificato all'interno di diversi blocchi padre. La
tavolozza visualizza il blocco come elemento annidato all'interno di tutte le relative
strutture del blocco padre.

• Supporto per strutture a blocchi nidificate-interne.
• Comprimere o espandere la struttura blocchi.
• Controllare il livello di dettaglio visualizzato.
• Mostrare o nascondere le singole istanze di blocco nell'area grafica.
• Gestire la visibilità di blocchi specifici all'interno della struttura.

• Gestione dei blocchi. L'organizzazione ottimizzata garantisce che il disegno CAD rimanga
coerente e più semplice da utilizzare.
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Accedere e modificare i blocchi nidificati direttamente dalla tavolozza, semplificando
il processo di modifica quando i blocchi contengono altri blocchi nidificati. Ad esempio,
un blocco finestra nidificato all'interno di un blocco parete.

•

• Copiare i blocchi da un'area del disegno e incollarli altrove, mantenendo la struttura
gerarchica. Ciò semplifica il processo di riutilizzo degli elementi di progettazione e
di mantenimento della coerenza nel disegno.

• Rinominare, raggruppare, organizzare o eliminare i blocchi all'interno della tavolozza.
• Inserire un blocco all'interno di un altro blocco nel disegno.

• Navigazione. In questo modo è più facile individuare e modificare elementi specifici
all'interno del progetto, risparmiando tempo e fatica.

• Navigare nel disegno selezionando i blocchi nella tavolozza.
• Individuare e focalizzare elementi specifici all'interno di strutture blocchi complesse.
• Ingrandire le istanze di singoli blocchi nell'area grafica.

Per aprire la tavolozza Struttura blocchi:

• Nella barra multifunzione, fare clic su Inserisci scheda > Sezione tavolozze >
Struttura blocchi.

• Nel menu, fare clic su Strumenti > Gestione set di fogli > Struttura blocchi.
• Immettere BLOCKSTRUCTURE nella finestra del comando.

Modifica dei riferimenti esterni e dei blocchi ritagliati

Quando si ritaglia un blocco o un disegno con riferimento esterno (xref), è possibile
ridimensionarne o modificarne i contorni con i quadratini di ridimensionamento. Nelle
versioni precedenti, era necessario ricreare il ritaglio ogni volta che si ridimensionavano
o modificavano i contorni.

In questo modo è più facile isolare un'entità o un'area specifica dal blocco o dal disegno
xref da visualizzare nell'area grafica.
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Per modificare i riferimenti esterni e i blocchi ritagliati:

Scegliere una delle seguenti opzioni:

• Nella barra multifunzione, fare clic su Inserisci > Riferimento > Ritaglia >
Riferimento.

• Nel menu, fare clic su Modifica > Ritaglia > Riferimento.
• Immettere CLIPREFERENCE (XCLIP) nella finestra del comando.

Ordine di disegno

Il comando Ordine di disegno ha opzioni personalizzate in base a tipi di entità specifici.
Le opzioni offrono un maggiore controllo sulla visibilità delle annotazioni, semplificando
ulteriormente il processo di progettazione.

Le opzioni offrono:

• Maggiore chiarezza. Garantisce che gli elementi di progettazione cruciali, quali quote
e annotazioni, siano visibili nella gerarchia visiva.

• Flusso di lavoro efficiente. Consente un controllo granulare sulla stratificazione per
gestire in modo efficiente la visibilità di diversi elementi, riducendo il tempo dedicato
alle regolazioni manuali.

• Precisione ottimizzata. Consente di ottenere una maggiore precisione nei progetti CAD,
portando elementi specifici in primo piano e inviandone altri alla parte posteriore.
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DescrizioneOpzione

Consente di portare tutte le entità di
annotazione, inclusi testo, quote e linee di
associazione, in primo piano nel progetto.
Consolidando le annotazioni in primo piano,
è possibile migliorare la comunicazione delle
informazioni critiche, migliorare la leggibilità
delle annotazioni progettuali, facilitare una
migliore comprensione delle misurazioni e
semplificare il processo di revisione e
presentazione.

È possibile creare disegni più precisi,
visivamente accattivanti e di impatto
promuovendo al contempo una
collaborazione e una comunicazione
efficienti.

Porta annotazioni in primo piano

Consente di portare i tratteggi sullo sfondo,
garantendo una visibilità senza ostacoli delle
entità sottostanti.
Ciò è utile quando le ripetizioni di tratteggio
interferiscono con la chiarezza e la
comprensibilità del progetto, fornendo viste
di disegno più chiare.

Porta i tratteggi sullo sfondo

Consente di portare i riferimenti sullo
sfondo, ottimizzando la visibilità degli
elementi di progettazione principali.
In questo modo è possibile concentrarsi sui
componenti chiave, migliorando l'efficienza
e la precisione durante il processo di
progettazione.

Porta riferimenti sullo sfondo

Considera che un utente abbia una planimetria dettagliata per un edificio commerciale.
Il progetto prevede diverse quote, annotazioni ed elementi grafici, rendendo i livelli e la
visibilità fondamentali per chiarezza e precisione.

Utilizzando le opzioni Porta in primo piano e Porta sullo sfondo, è possibile avere più
controllo sul livello. Le quote, le linee di associazione, il testo e le annotazioni possono
essere portati in primo piano, mentre si inviano tratteggi, disegni e immagini nei formati
DGN PDF sullo sfondo.

Per accedere ai comandi TEXTTOFRONT, HATCHTOBACK o REFERENCETOBACK:

Procedere nel modo seguente:
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MenuBarra multifunzione

Strumenti > Ordine di visualizzazione
> Porta annotazioni in primo piano >
Solo testo

Visualizza > Ordine > Porta testo in
primo piano

Strumenti > Ordine di visualizzazione
> Porta annotazioni in primo piano >
Solo quote

Visualizza > Ordine > Porta quote in
primo piano

Strumenti > Ordine di visualizzazione
> Porta annotazioni in primo piano >
Solo direttrici

Visualizza > Ordine > Porta direttrici in
primo piano

Strumenti > Ordine di visualizzazione
> Porta annotazioni in primo piano >
Tutte le entità di annotazione

Visualizza > Ordine > Porta tutte le
annotazioni in primo piano

Strumenti > Ordine di visualizzazione
> Porta i tratteggi sullo sfondo

Visualizza > Ordini > Porta i tratteggi
sullo sfondo

Strumenti > Ordine di visualizzazione
> Porta riferimenti sullo sfondo > Solo
disegni

Visualizza > Ordine > Porta disegni
sullo sfondo

Strumenti > Ordine di visualizzazione
> Porta riferimenti sullo sfondo > Solo
immagini

Visualizza > Ordine > Porta immagini
sullo sfondo

Strumenti > Ordine di visualizzazione
> Porta riferimenti sullo sfondo > Solo
PDF

Visualizza > Ordine > Porta PDF sullo
sfondo

Strumenti > Visualizza ordine > Invia
riferimenti > solo ai DGN posteriori

Visualizza > Ordine > Porta DGN sullo
sfondo

Strumenti > Ordine di visualizzazione
> Porta riferimenti sullo sfondo > Tutte
le entità referenziate

Visualizza > Ordine > Porta tutti i
riferimenti sullo sfondo

O

Immettere TEXTTOFRONT, HATCHTOBACK o REFERENCETOBACK nella finestra del comando.
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Gestione della spaziatura tra le quote

È possibile utilizzare il comando DIMSPACE per gestire la spaziatura tra le quote nei file
DWG. Ciò garantisce precisione, chiarezza e coerenza di progettazione nei disegni.

Il comando DIMSPACE consente di ottenere una maggiore precisione e di dedicare meno
tempo alle regolazioni manuali. Il comando DIMSPACE è simile alla funzionalità AutoCAD
per le quote di disegno, quindi è facile capire se si ha familiarità con AutoCAD.

Per gestire la spaziatura tra le quote:

Scegliere una delle seguenti opzioni:

• Nella barra multifunzione, fare clic su Annota > Quote > Regola spazio.
• Nel menu, fare clic su Quota > Regola spazio.
• Immettere DIMSPACE nella finestra del comando.
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Visibilità della barra dei menu

È possibile utilizzare la barra multifunzione e la barra dei menu contemporaneamente
nell'interfaccia utente.

La funzionalità Personalizza la barra di accesso rapido consente di cambiare la visibilità
della barra dei menu.

Per specificare la visibilità MENUBAR, procedere in uno dei modi seguenti:

• Nella barra multifunzione, fare clic su Personalizza la barra di accesso rapido >
Mostra barra dei menu / Nascondi barra dei menu.

• Nel menu, fare clic su Personalizza la barra di accesso rapido > Mostra barra
dei menu / Nascondi barra dei menu.

• Nella finestra comandi, digitare MENUBAR.

Variabile di sistema 0 se è disattivata e 1 se è attivata.
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Vincoli di quotatura per blocchi personalizzati

Quando si modificano i blocchi personalizzati, è possibile utilizzare i Vincoli di quotatura.
Ciò consente di controllare la distanza, la lunghezza, l'angolo e il raggio delle entità. I
vincoli di quotatura possono inoltre vincolare le distanze e gli angoli tra entità geometriche
o punti sulle entità.

Ad esempio, se si progetta un layout per una scheda a circuito stampato, è necessario
posizionare i componenti elettronici in posizioni specifiche. È importante mantenere
distanze e proporzioni precise tra i componenti, garantendo al contempo flessibilità nelle
loro singole dimensioni. È possibile replicarlo in parti diverse del disegno utilizzando il
disegno all'interno di un blocco personalizzato.

È possibile modificare i blocchi dinamici creati in AutoCAD che utilizzano vincoli di
quotatura. In questo modo il blocco viene trasformato in un blocco personalizzato in
DraftSight. Il processo di conversione riconosce i vincoli di quotatura per una modifica
precisa all'interno dei blocchi di personalizzazione.

Per utilizzare i vincoli di quotatura per i blocchi personalizzati:

Procedere nel modo seguente:

• Nella barra multifunzione, fare clic su Inserisci > Blocco > Modifica blocco.
• Nel menu, fare clic su Modifica > Entità > Modifica blocco.
• Immettere EDITBLOCK nella finestra del comando.

Comando FLATTEN
Con il comando FLATTEN, è possibile specificare automaticamente l'elevazione (valore Z)
di determinati comandi come 0.

Con determinati comandi (come TRIM, FILLET e JOIN) e altri strumenti (snap, misura e
quota), è necessario specificare l'elevazione (valore Z) come 0. In caso contrario, i comandi
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e gli strumenti non funzionano come previsto. Il comando FLATTEN assicura che
l'elevazione sia 0.

Per accedere al comando FLATTEN:

Procedere nel modo seguente:

• Nella barra multifunzione, fare clic su XtraTools > Modifica > Appiattisci.
• Nel menu, fare clic su XtraTools > Modifica > Appiattisci.
• Immettere FLATTEN nella finestra del comando.

Stili visivi

I modelli 3D possono essere rappresentati con aspetti specifici. Ad esempio, se il modello
si trova nella fase di progettazione schematica, è possibile mostrare il modello a un team
di progettazione in un «aspetto di schizzo» e presentarlo ai clienti in un «aspetto
realistico.»

I diversi aspetti, detti stili visivi, dipendono dalle impostazioni che modificano la
visualizzazione di bordi, colori e ombreggiatura.

La seguente tabella elenca i vantaggi degli stili visivi:

Coerenza visiva tra le applicazioni garantita. Se si
creano stili visivi in AutoCAD, come trasparenza o
trame in legno, è possibile applicare gli stessi stili
ai modelli in DraftSight.

Compatibilità con AutoCAD

Utilizzare diverse opzioni di rendering per scegliere
lo stile più adatto per i progetti. Ciò migliora la
rappresentazione visiva dei progetti, migliorando
la comunicazione e la comprensione.

Visualizzazione migliorata
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Creare disegni più realistici e visivamente
accattivanti. Ciò consente di condividere i progetti
con clienti, parti interessate o membri del team
che potrebbero non avere familiarità con i disegni
tecnici.

Comunicazione migliorata

Analizzare i progetti in modo più efficiente. Ad
esempio, usare uno stile visivo della linea nascosta
per identificare gli elementi nascosti o sovrapposti
nei disegni complessi.

Analisi efficiente

Migliorare la qualità delle presentazioni e delle
proposte di progettazione. È possibile presentare
i progetti in modo elegante e professionale,
migliorando l'impatto complessivo.

Presentazioni di alta qualità

Personalizzare gli stili visivi in base alle esigenze
specifiche. È possibile personalizzare la
rappresentazione visiva dei progetti in base ai
requisiti del progetto o alle preferenze personali.

Opzioni di personalizzazione

Visualizzare e manipolare modelli 3D da prospettive
diverse. In questo modo è possibile comprendere
le relazioni spaziali all'interno del progetto.

Funzionalità di modellazione 3D

Per accedere al comando VISUALSTYLES:

Procedere nel modo seguente:

• Nella barra multifunzione, fare clic su Visualizza > Stili visivi Stili visivi > Gestione
stili visivi.

• Nel menu, fare clic su Visualizza > Stili visivi.
• Immettere VISUALSTYLES nella finestra del comando.

Preimpostare gli stili visivi

DraftSight fornisce stili visivi predefiniti che è possibile modificare per creare stili visivi
personalizzati.

È possibile regolare l'illuminazione per ottenere realismo, rifinire la visibilità dei bordi o
scegliere uno stile di faccia specifico per modellare l'ambiente di progettazione in base ai
requisiti del progetto.

DescrizioneStile visivo

Utilizza solo linee e curve senza ombreggiatura o
rendering.

Reticolo 2D

Adatto per la visualizzazione e la modifica di modelli
3D con linee e curve.

Struttura a reticolo
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DescrizioneStile visivo

Utilizza le linee nascoste rimosse per fornire una
visione chiara delle linee visibili.

Nascosto

Aggiunge luci e ombre realistiche al modello,
fornendo una rappresentazione realistica di materiali
e trame.

Realistico

Applica un rendering stilizzato al modello,
enfatizzando contorni e forme. Utile per la
progettazione concettuale e le presentazioni
artistiche.

Concettuale

Visualizza il modello con ombreggiatura piatta.Ombreggiato

Combina le superfici ombreggiate con i bordi visibili
per definire i contorni degli oggetti nel modello.

Ombreggiata con bordi

Visualizza il disegno in diverse sfumature di grigio
per differenziare oggetti diversi e le relative quote.
Ciò fornisce una rappresentazione monocromatica
ed efficace.

Sfumature di grigio

Rende tutti gli oggetti trasparenti in modo da poter
vedere attraverso il modello. Utile per analizzare
assiemi complessi.

Raggio X

Applica al modello un aspetto disegnato a mano,
simile a uno schizzo, per un aspetto più artistico e
informale.

Schizzo
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Stampa in MacOS

Se si esegue DraftSight su macOS®, la finestra di dialogo Stampa utilizza un'interfaccia
simile a quella di Windows®. La finestra di dialogo è più versatile e intuitiva.

A differenza della finestra di dialogo di sistema Stampa, questa finestra di dialogo fornisce
una gamma più ampia di opzioni, offrendo un maggiore controllo sulle preferenze di
stampa. La stampa è più semplice ed efficiente, garantendo che i disegni vengano stampati
nel modo desiderato.

Gli utenti possono anche passare da Windows a Mac senza modificare le loro abitudini,
poiché le versioni di Windows e Mac condividono la stessa interfaccia utente della barra
multifunzione.

Comando AMUSERHATCH (solo DraftSight Mechanical)
È possibile utilizzare il comando AMUSERHATCH per inserire tratteggi definiti dall'utente,
predefiniti e non associativi nelle aree degli oggetti. È possibile modificare le proprietà di
un tratteggio selezionato prima di inserirlo in un'area dell'oggetto.
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Modifiche della tabella

Durante la modifica delle tabelle, è possibile utilizzare funzioni avanzate.

Per rendere le tabelle più utili, è possibile:

• Inserire e gestire i blocchi nelle celle della tabella
• Abbinare le proprietà della cella
• Ripetizione delle funzioni

Funzionalità tabella migliorata:

• Opzioni Formula, ad esempio Somma automatica
• Aggiungi file e colonne
• Quadratini di ridimensionamento
• Menu di scelta rapida Cella e barra multifunzione contestuale Tabella
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Importazione dei file STEP

È possibile utilizzare il comando IMPORTSTEP per importare modelli 3D dai file STEP.

I modelli di file STEP possono essere incorporati nei disegni.

Comando DWGUNITS

Il comando DWGUNITS converte i disegni in altri sistemi di unità.
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Per le unità imperiali e metriche, il comando DWGUNITS consente di mantenere precisione
e coerenza in vari progetti. Questo comando migliora l'efficienza del flusso di lavoro e
garantisce che il disegno sia conforme ai requisiti di progetto e agli standard di settore.

Esportazione PDF e utilizzo della stampa in batch

È possibile conservare le impostazioni per l'esportazione PDF e la stampa in batch per la
sessione successiva.

È possibile esportare PDF e stampare i file batch con le stesse impostazioni. Per stampare
i file batch, è possibile mantenere lo stesso nome PDFs e la stessa posizione .dwg dei file
di origine, quindi aprire i file PDF dopo la stampa.
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Blocchi nella tavolozza Risorse di progettazione

La tavolozza Risorse di progettazione ha ottimizzato l'uso dei blocchi.

I nomi dei blocchi delle risorse di progettazione sono completamente visibili. Le miniature
dei blocchi sono più grandi per consentire una rapida identificazione.

Più elementi di visibilità

È possibile utilizzare CustomBlocks per collegare più elementi di visibilità a un singolo
blocco.
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È possibile controllare in modo efficiente la visibilità delle singole entità senza creare più
stati di visibilità. In precedenza, era possibile collegare solo un elemento di visibilità per
blocco.

Lazo

È possibile usare la selezione Lazo per migliorare l'efficienza e risparmiare tempo.

Con la selezione Lazo, è possibile spostare il puntatore attorno a un'area per specificare
e selezionare le entità in un contorno dalla forma irregolare. Questo metodo consente di
selezionare gruppi complessi di entità che non hanno contorni rettangolari standard.
Semplifica il flusso di lavoro e migliora la produttività.
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26
eDrawings

Questo capitolo comprende i seguenti argomenti:

• Visualizzazione dei riferimenti del componente
• Formato file HTML eDrawings ActiveX
• Inviluppi di assieme
• Tipi di file supportati

eDrawings® Professional è disponibile in SOLIDWORKS® Professional, SOLIDWORKS Premium
e SOLIDWORKS Ultimate.

Visualizzazione dei riferimenti del componente

Se un file di assieme SOLIDWORKS o eDrawings ha componenti con riferimenti ai
componenti, è possibile specificare un'opzione in eDrawings per visualizzare i riferimenti
dei componenti nel riquadro Componenti.

Per visualizzare i riferimenti del componente:

1. In eDrawings, aprire un file di assieme SOLIDWORKS o eDrawings con riferimenti al
componente.
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2. Nel riquadro Componenti, fare clic su Opzioni .
3. Nella finestra di dialogo, selezionare Mostra riferimento componente.

I riferimenti del componente appaiono nel riquadro Componenti.

Formato file HTML eDrawings ActiveX

Non è più possibile salvare i file HTML eDrawings ActiveX come file .htm.

Se si fa clic su File > Invia, la finestra di dialogo Invia con nome non viene visualizzata.
eDrawings genera invece un'e-mail con il file allegato come file .eprt, .easm o .edrw
per una funzionalità semplificata.
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Inviluppi di assieme

Se si apre un assieme o un disegno di assieme con inviluppi, eDrawings visualizza il
contenuto dell'inviluppo con lo stesso aspetto di SOLIDWORKS.

Il riquadro Componenti visualizza icone che indicano i componenti dell'inviluppo.

Tipi di file supportati
eDrawings ha aggiornato le versioni supportate per diversi tipi di file.

VersioneFormato

Fino alla versione 2023ACIS® (.sat, .sab)

Fino alla versione 2025Autodesk®Inventor® (.ipt, .iam)

Fino alla versione V5-6R2024CATIA® V5 (.CATPart, .CATProduct)

Fino alla versione V5-6R2024CATIA V6 / 3DEXPERIENCE®

Pro/Engineer da 19.0 a Creo 10.0Creo® - Pro/Engineer® (.ASM, .NEU, .PRT,
.XAS, .XPR)

Fino alla versione v10.9JT (.jt)

Da UG11 a UG18, UG NX, da NX5 a NX12,
da NX1847 a NX2312

NX™ (Unigraphics®) (.prt)
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VersioneFormato

Fino alla versione 36,1Parasolid™ (.x_b, .x_t, .xmt, .xmt_txt)

Da 1 a 20, ST1 - ST10, da 2019 a 2024Solid Edge® (.asm, .par, .pwd, .psm)
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27
SOLIDWORKS Plastics

Questo capitolo comprende i seguenti argomenti:

• Rilevamento stampata incompleta (2025 SP2)
• Analisi di riempimento
• Previsione degli avvallamenti migliorata
• Isolare la causa della deformazione
• Database dei materiali
• Mesh
• Prestazione
• Risultati dell'analisi Warp rinominati

SOLIDWORKS® Plastics Standard, SOLIDWORKS Plastics Professional e SOLIDWORKS Plastics
Premium sono prodotti acquistabili separatamente che possono essere usati con SOLIDWORKS
Standard, SOLIDWORKS Professional, SOLIDWORKS Premium e SOLIDWORKS Ultimate.

Rilevamento stampata incompleta (2025 SP2)

Diversi miglioramenti dell'interfaccia utente facilitano l'identificazione della presenza di
stampate incomplete per simulazioni di iniezioni plastiche.
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I seguenti miglioramenti dell'interfaccia utente consentono di rilevare la presenza di
stampate incomplete che potrebbero verificarsi durante il riempimento.

• È stata aggiunta la stringa Avviso: Stampata incompleta sotto il titolo del grafico
Tempo di riempimento.

• È stata aggiunta la stringa Stampata incompleta accanto al nodo Risultati Fill.

• È stata aggiunta la descrizione comando Si è verificata una stampata incompleta
durante la simulazione Fill sotto il nodo Risultati.

• È stato aggiunto un avviso relativo alle stampate incomplete nel PropertyManager
Riepilogo.
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Analisi di riempimento

Sono disponibili diversi miglioramenti per l'analisi di riempimento.

• L'analisi del riempimento è più veloce del 25% quando si utilizzano materiali riempiti
di fibre per parti in plastica.

• L'analisi di riempimento prevede le linee di saldatura e le bolle d'aria anche in caso di
stampate incomplete. Ad esempio, l'immagine precedente mostra un'iniezione breve
(a sinistra) e le bolle d'aria previste (a destra) per un'analisi di riempimento di una
parte.

• Il rendering delle animazioni del tempo di riempimento in modalità isosuperficie è stato
notevolmente accelerato (fino al 75%) per i modelli di grandi dimensioni con un elevato
numero di elementi. Anche la memoria necessaria per generare le animazioni sui tempi
di riempimento è aumentata, poiché SOLIDWORKS Plastics utilizza tutte le risorse di
memoria disponibili per la generazione delle animazioni.

• L'animazione dell'isosuperficie dei grafici del tempo di riempimento salvati in formato
AVI ha un aspetto più uniforme con un ritardo significativamente ridotto poiché il
tempo di ritardo tra i fotogrammi dei risultati successivi è diminuito.
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Previsione degli avvallamenti migliorata

Un nuovo risolutore prevede con maggiore precisione la posizione e la profondità di
avvallamenti.

Il nuovo risolutore di avvallamenti analizza le funzioni geometriche che probabilmente
inducono avvallamenti, ad esempio nervature, estrusioni, fazzoletti di rinforzo e raccordi
interni. Il solutore utilizza quindi queste informazioni geometriche per eseguire un'analisi
localizzata per prevedere la profondità degli avvallamenti. Ad esempio, l'immagine sopra
mostra una previsione migliorata degli avvallamenti sulla superficie di una parte del
controller di gioco con funzionalità interne di estrusioni e nervature.

I risultati degli avvallamenti sono aggiornati come segue:

302

SOLIDWORKS Plastics



• Il grafico Avvallamenti dai risultati Fill viene rinominato in Stima degli avvallamenti
superficiali alla fine dell'iniezione.

• Con i risultati Pack, è disponibile un nuovo grafico Avvallamenti superficiali al
momento dell'espulsione.

• Il grafico Profilo avvallamento dai risultati Warp viene rimosso, poiché la previsione
degli avvallamenti in base alle condizioni alla fine dell'iniezione non è precisa. È invece
possibile fare riferimento al grafico Avvallamenti superficiali al momento
dell'espulsione per esaminare la posizione e la profondità degli avvallamenti.

Il nuovo risolutore di avvallamenti è disponibile solo per le procedure di mesh ibrida 3D
ed esaedrica 3D. La procedura di mesh di shell continua a utilizzare il solutore di
avvallamento corrente.

Isolare la causa della deformazione

I nuovi grafici dei risultati per l'analisi della deformazione consentono di isolare la causa
della deformazione durante la progettazione di parti in plastica.

La deformazione delle parti stampate in plastica è dovuta a tre cause principali:
restringimento non uniforme, raffreddamento differenziale e orientamento molecolare o
delle fibre. L'immagine mostra i grafici dei risultati della deformazione totale e della
deformazione del componente a causa della deformazione. La comprensione della causa
principale della deformazione consente di apportare le modifiche appropriate al progetto,
al materiale e al processo di produzione della parte o dello stampo per ridurre al minimo
i difetti di progettazione.

L'analisi della deformazione in SOLIDWORKS Plastics 2025 isola la causa della deformazione
calcolando, in ciascun nodo, il componente della deformazione totale attribuito a ciascuna
origine. Sono disponibili i seguenti grafici dei risultati, insieme al grafico di Deformazione
totale, per facilitare l'identificazione della causa della deformazione.
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DescrizioneGrafico dei risultati -
Analisi della
deformazione

Mostra la deformazione che può essere attribuita a temperature
non uniformi dello stampo, velocità di raffreddamento

Deformazione -
Restringimento non
uniforme differenziali tra sezioni sottili e spesse di una parte e variazioni

di restringimento tra la direzione del flusso di colata e
trasversalmente alla direzione del flusso di colata.
(In generale, queste deformazioni si verificano a causa di
distribuzioni di pressione, temperatura e sollecitazione di taglio
non uniformi lungo l'area della superficie o lungo tutto il volume
di una parte stampata.)

Mostra la deformazione che può essere attribuita al
raffreddamento non uniforme derivante dalle variazioni di

Deformazione -
Raffreddamento
differenziale temperatura attraverso le superfici della matrice e della cavità

dello stampo a iniezione.
Il raffreddamento non uniforme delle parti in genere determina
un restringimento non uniforme e sollecitazioni all'interno dello
stampo, che contribuiscono a deformare.

Mostra la deformazione causata dall'anisotropia
dall'orientamento dei riempitivi nel materiale, come le fibre di
vetro corte o le fibre di carbonio.
Per i materiali senza riempitivi, questa deformazione è
trascurabile.

Deformazione - Effetti
di orientamento

Si potrebbero notare tempi di risoluzione dell'analisi Warp leggermente più lunghi a causa
del tempo di calcolo aggiuntivo necessario per calcolare i componenti delle deformazioni
totali. I grafici dei risultati che isolano la causa della deformazione sono disponibili solo
per la procedura Mesh 3D.

Database dei materiali
Il database dei materiali di Plastics viene aggiornato in base ai dati più recenti dei
produttori dei materiali.

Sono state aggiunte 365 nuove classi dei materiali, 142 classi sono state aggiornate e
370 classi obsolete sono state rimosse dal database.

Numero di nuove classi dei materialiFabbricante

123DOMO®

97Envalior™

77SABIC Specialties®
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Numero di nuove classi dei materialiFabbricante

42Covestro®

12MOCOM®

8EMS-GRIVORY®

2CHIMEI®

2Lehmann&Voss&Co.

1Trinseo®

1Solvay Specialty Polymers®

Numero di classi dei materiali
aggiornate

Fabbricante

37Covestro®

19LyondellBasell™

18EMS-GRIVORY®

14ARLANXEO®

13BASELL

10CWH, Chemwerk Huls

9MOCOM®

7SABIC Specialties®

6Victrex®

3Mueller Kunststoffe

1Autotech-Sirmax

1Teknor Apex®

1TOTAL®

1Asahi Kasei®

1MILES

1ENICHEM
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Numero di classi dei materiali rimosseFabbricante

151DSM Engineering Plastics

94Rhodia Engineering Plastics

68LNP Engineering Plastics®

26Covestro®

14Rhone-Poulenc

7SABIC Specialties®

5Monsanto Japan

2Lehmann and Voss

1Trinseo®

1Mitsubishi Chemical Japan®

1Mitsubishi Rayon

I seguenti aggiornamenti sono implementati per la versione 2025 FD01.

Gradi del materialeFabbricante

29 nuovi gradi aggiuntiSABIC Specialties®

10 gradi aggiornatiSABIC Specialties®

3 gradi rimossiICI

1 grado rimossoMitsubishi Chemical Japan®
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Mesh

I tempi di mesh per i modelli complessi sono stati notevolmente migliorati.

Per la mesh, la complessità di un modello è determinata dal numero di facce geometriche
e dalla sua curvatura. In genere, i modelli con un numero più elevato di facce e maggiore
curvatura richiedono tempi di mesh più lunghi.

Modalità estremamente complesse con oltre 100.000 facce geometriche hanno mostrato
le massime prestazioni di mesh con tempi di mesh fino a 9,6 volte più veloci. I modelli
di media complessità con oltre 10.000 facce geometriche hanno mostrato tempi di mesh
fino a 3 volte più veloci, mentre i modelli più semplici con meno di 1.000 facce non hanno
mostrato miglioramenti di mesh significativi.

307

SOLIDWORKS Plastics



Prestazione

La maggiore efficienza nella risoluzione dei sistemi di equazioni sottostanti migliora i
tempi di risoluzione delle simulazioni di materie plastiche senza compromettere robustezza
e precisione.

• Risoluzione fino a 1,3 volte più veloce per simulazioni Fill
• Risoluzione fino a 3,1 volte più veloce per simulazioni Pack
• Risoluzione fino a 2,1 volte più veloce per simulazioni Cool
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Risultati dell'analisi Warp rinominati

I risultati dell'analisi Warp vengono rinominati per garantire la coerenza terminologica.

L'immagine mostra i titoli precedenti e correnti dei risultati dell'analisi Warp.
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28
Routing

Questo capitolo comprende i seguenti argomenti:

• Accesso più rapido e ricerca più semplice negli attributi elettrici (2025 SP3)
• La voce della distinta materiali mostra la lunghezza totale del cavo nei sottoassiemi

(2025 SP3)
• Evidenziazione delle giunzioni per una migliore visualizzazione (2025_SP3)
• Descrizioni dei comandi riprogettate per gli strumenti Routing (2025 SP2)
• Supporto per assiemi e parti di morsetto nella procedura guidata di instradamento

dei componenti (2025 SP2)
• Miglioramento delle prestazioni nellemodifiche dell'assieme del cablaggio appiattito

(2025 SP1)
• Creare un disegno appiattito con output più pulito
• Personalizzazione delle percentuali di inclinazione nei PropertyManager Proprietà

del percorso e Segmento del percorso
• Miglioramento delle modifiche a condotti e tubi

Routing è disponibile in SOLIDWORKS® Premium e SOLIDWORKS Ultimate.

Accesso più rapido e ricerca più semplice negli attributi elettrici (2025 SP3)
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È possibile trovare e utilizzare Attributi elettrici in SOLIDWORKS Routing in modo più
efficiente. Un accesso migliorato e una barra di ricerca consentono di filtrare rapidamente
fili e cavi in base ai valori delle proprietà.

Vantaggi: questi miglioramenti rendono gli Attributi elettrici più facili da trovare, più
veloci da usare e più coerenti con il resto di SOLIDWORKS Routing.

I miglioramenti per gli attributi elettrici includono:

• Ricerca rapida all'interno del PropertyManager Attributi elettrici

È possibile filtrare l'elenco dei fili inserendo una nuova barra di ricerca. Durante la
digitazione, SOLIDWORKS Routing restringe l'elenco per soddisfare la ricerca in base
ai valori delle proprietà. Supporta le corrispondenze parziali e non è sensibile alle
maiuscole e alle minuscole. Se la ricerca non trova riscontri, viene visualizzato un
messaggio.

• Facile accesso dal CommandManager e dal menu

È possibile aprire gli Attributi elettrici direttamente dalla scheda Routing del
CommandManager o navigando in Strumenti > Routing > Electrical > Attributi
elettrici. È anche possibile fare clic con il pulsante destro del mouse su un segmento
di percorso o sulla funzione Percorso1 in un sottoassieme per avviarlo. Nei disegni,
fare clic con il pulsante destro del mouse su un segmento di percorso in una vista di
disegno e selezionare Attributi elettrici.

• Guida ai suggerimenti

Quando si passa il mouse sull'icona Attributi elettrici, un suggerimento spiega cosa si
sta visualizzando negli Attributi elettrici del segmento di percorso selezionato. Queste
informazioni aiutano gli utenti a comprendere lo strumento a colpo d'occhio.

• Migliore consapevolezza del contesto

Quando si lavora in un assieme di livello superiore con più sottoassiemi, SOLIDWORKS
Routing chiede di scegliere quale assieme di percorso visualizzare per gli Attributi
elettrici. Per avviare lo strumento, è anche possibile fare clic con il pulsante destro del
mouse su un segmento di percorso in un disegno o sulla funzione di percorso in un
sottoassieme.

• Risultati della ricerca di Smarter Cable

Quando si esegue una ricerca e il risultato corrisponde a un trefolo del cavo,
SOLIDWORKS Routing mostra solo il cavo e i trefoli corrispondenti, non l'intero elenco
dei trefoli.

• Pannello ridimensionabile

Il pannello Attributi elettrici può essere ridimensionato con un semplice comando di
trascinamento, per avere più spazio per visualizzare elenchi più lunghi o valori dettagliati
delle proprietà.
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La voce della distinta materiali mostra la lunghezza totale del cavo nei
sottoassiemi (2025 SP3)

È possibile visualizzare la lunghezza e la massa totale di cavi identici utilizzati in più
sottoassiemi di instradamento come un'unica riga in una distinta materiali (BOM).

Vantaggi: negli assiemi di grandi dimensioni con più sottoassiemi di cablaggio, i cavi
identici appaiono spesso separatamente, rendendo la distinta materiali più difficile da
leggere e analizzare. Con questo miglioramento, SOLIDWORKS Routing rileva
automaticamente i cavi identici nei sottoassiemi e combina la loro lunghezza e massa
totale in un'unica riga.

Questo comportamento si applica ai seguenti tipi di distinta materiali:

• Distinta materiali - Solo parti

I cavi precedentemente elencati separatamente appaiono come una voce combinata
con i valori totali.

• Distinta materiali - Con rientranza

È possibile selezionare l'opzione Combina componenti identici per unire le voci dei
cavi da altri sottoassiemi di percorso. La riga selezionata rimane e vengono visualizzate
la lunghezza e la massa totali.

• Distinta materiali appiattita

I cavi identici di più sottoassiemi confluiscono in un'unica riga con i valori totali.

Le distinte materiali di livello superiore non sono interessate da questa modifica.

Un esempio di flusso di lavoro è il seguente:

1. Creare un assieme con più sottoassiemi di cablaggio che utilizzano lo stesso cavo.
2. Inserire una tabella di distinta materiali e selezionare un tipo di distinta, ad esempio

Solo parti, Con rientro o Appiattita.
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Evidenziazione delle giunzioni per una migliore visualizzazione (2025_SP3)
SOLIDWORKS Routing aiuta a comprendere meglio le giunzioni nei percorsi elettrici
aggiungendo evidenziazioni visive automatiche per i connettori e i segmenti di percorso
correlati.

Vantaggi: è possibile trovare e comprendere le giunzioni senza dover cercare nel disegno.
È anche più facile seguire i percorsi dei fili e controllare le connessioni, contribuendo a
ridurre gli errori di progettazione.

I cambiamenti nei segnali visivi includono:

• Connettori terminali evidenziati

Quando si seleziona o si aggiunge una giunzione, i connettori collegati ai fili giuntati
si evidenziano automaticamente. Un colore univoco aiuta a distinguerli dagli altri
connettori del progetto.

• Segmenti di percorso evidenziati

Il segmento di percorso collegato alla giunzione viene visualizzato con un colore o uno
stile diverso. Questa distinzione aiuta a capire come la giunzione si inserisce nel percorso
complessivo del cablaggio.

Descrizioni dei comandi riprogettate per gli strumenti Routing (2025 SP2)

Le descrizioni dei comandi nell'interfaccia di SOLIDWORKS Routing sono state riprogettate
per migliorare la chiarezza e l'usabilità. Quando si passa il mouse su un filo, un cavo o
un cablaggio, le descrizioni dei comandi aggiornate visualizzano i dettagli chiave in ordine
logico.

Vantaggi: Questo aggiornamento facilita l'interpretazione rapida delle informazioni di
connessione.

Per fili, cavi e cablaggi vengono visualizzate le descrizioni comandi:
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• Contrassegno filo/cavo
• Dal terminale
• Al terminale
• Stile del filo o conduttore del cavo
• Contrassegno cablaggio (se applicabile)

Per fasci di cablaggio con più fili e cavi, la descrizione dei comandi fornisce un breve
riepilogo degli attributi chiave.

Supporto per assiemi e parti di morsetto nella procedura guidata di
instradamento dei componenti (2025 SP2)

La procedura guidata per i componenti di instradamento supporta sia gli assiemi sia le
parti di morsetto, consentendo di definire e configurare gli assiemi come componenti di
instradamento. I requisiti di base per entrambi i tipi sono gli stessi e i passaggi per crearli
in Routing Library Manager seguono lo stesso processo.

Vantaggi: Questo aggiornamento consente una maggiore flessibilità nella progettazione
e nell'integrazione di morsetti complessi nei flussi di lavoro di instradamento.

I miglioramenti apportati a Routing Library Manager sono:

• Assiemi di morsetti: Gli utenti possono selezionare e configurare un file di assieme
(.SLDASM) come morsetto di instradamento.

• Punti di instradamento: Gli utenti possono definire punti di instradamento per allineare
fili, cavi o tubi.

• Integrazione perfetta: Gli assiemi di morsetti funzionano con i flussi di lavoro di
instradamento esistenti e vengono memorizzati nella Libreria di instradamento.

Procedere come segue per definire un assieme di morsetto in Routing Library Manager:

1. Selezionare l'assieme del morsetto.

a. Aprire Routing Library Manager e passare alla procedura guidata del componente
di instradamento.
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b. Scegliere il Tipo di percorso e il Tipo di Componente, quindi fare clic su Avanti.

2. Aggiungere punti di percorso (PuntiAR) all'assieme di morsetto per definire
l'allineamento di fili, cavi o tubi.

Nota: I punti di connessione (PuntiC) sono disabilitati. Non sono necessari per i
morsetti.

3. Aggiungere la geometria di instradamento.

a. Definire l'Asse morsetto per specificare la direzione di instradamento.
b. Se l'assieme di morsetto richiede un posizionamento rotazionale, aggiungere un

Asse di rotazione.

4. Aggiungere Accoppiamento dei riferimenti per definire l'allineamento corretto
dell'assieme di morsetto.

5. Convalidare l'assieme di morsetto e verificare che sia conforme ai requisiti di
instradamento.

6. Configurare la Tabella dati.

a. Se l'assieme di morsetto ha più configurazioni, aprire la Tabella dati esistente per
effettuare le regolazioni.

b. Se non esiste, creare una nuova Tabella dati.
c. Convalidare le voci standard e personalizzate nella tabella utilizzando un foglio

di lavoro Excel incorporato.

7. Verificare gli Attributi del componente. Modificare gli attributi dei componenti come
richiesto.

8. Salvare l'assieme del morsetto.

a. Salvare l'assieme del morsetto configurato nella Libreria di instradamento.
b. Specificare la posizione della cartella della libreria e il nome del file.
c. Salvare il componente come file .XML.

Miglioramento delle prestazioni nelle modifiche dell'assieme del cablaggio
appiattito (2025 SP1)

Gli strumenti di modifica del PropertyManager Modifica percorso appiattito funzionano
più velocemente e migliorano l'esperienza di modifica delle configurazioni di cablaggio
appiattito.

È possibile apportare più modifiche e visualizzarle in anteprima come modifiche temporanee
prima di finalizzarle, ottenendo un maggiore controllo sul processo di progettazione.

Durante la modifica, SOLIDWORKS Routing sospende temporaneamente gli aggiornamenti
alle funzioni appiattite. Gli aggiornamenti vengono eseguiti solo quando si conferma o si
annulla l'operazione, garantendo un utilizzo efficiente delle risorse e un flusso di lavoro
più fluido.

Per esempio, dopo aver completato la modifica, SOLIDWORKS Routing invita a confermare
i cambiamenti apportati. Facendo clic su OK nel PropertyManager si applicano gli
aggiornamenti alle funzioni appiattite: in questo modo si evita la ripetizione degli
aggiornamenti a ogni modifica, con conseguente risparmio di risorse. Facendo clic su
Annulla vengono rimosse le modifiche temporanee.
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In precedenza, ogni modifica attivava un aggiornamento completo, rallentando il flusso
di lavoro. Con questo miglioramento, a ogni modifica viene visualizzata solo la grafica
temporanea, senza aggiornare le funzioni appiattite sottostanti.

Questa funzionalità non si applica alle modifiche nel percorso appiattito di un'annotazione,
ai percorsi appiattiti con fili discreti e ai percorsi appiattiti con segmenti Mantieni
orientamento 3D.

Creare un disegno appiattito con output più pulito
Gli aggiornamenti seguenti nei disegni appiattiti forniscono un output più pulito e un flusso
di lavoro migliorato:

• Mostra/Nascondi elementi di appiattimento percorso: un'opzione per
mostrare/nascondere le linee di associazione nelle tabelle dei connettori.

• Visualizza quantità nelle bollature: visualizza la quantità nelle bollature dei
connettori, simile alle bollature dei fili.

• Formattazione di colonne e righe: richiede agli utenti di applicare le modifiche di
formattazione per colonne e righe nelle altre tabelle.

• Aggiornamenti della tabella: invita gli utenti ad applicare gli aggiornamenti a tutte
le tabelle nel disegno.

• Visibilità delle cornici della forma: nel PropertyManager Elementi appiattiti,
un'opzione per mostrare/nascondere la cornice della forma.

Personalizzazione delle percentuali di inclinazione nei PropertyManager
Proprietà del percorso e Segmento del percorso

Nei PropertyManager Proprietà del percorso e Proprietà del segmento del percorso, è
possibile definire un valore personalizzato per la Percentuale di inclinazione per i
singoli segmenti del percorso. Questo valore sovrascrive la percentuale d'inclinazione
specificata in Strumenti > Opzioni > Opzioni di sistema > Instradamento.
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Miglioramento delle modifiche a condotti e tubi
Quando si modifica un assieme di instradamento contenente condotti e tubi, il software
SOLIDWORKS Routing modifica i componenti esistenti invece di creare nuovi componenti
virtuali.
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